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Return goods cannot be accepted without prior authorization and are subject to a 
restocking charge. The Seller certifies the articles specified herein were produced 
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Corrections and Improvements
To report errors or recommend improvements to this manual, please send an 
email to autodoc@mii.com. 

Use this page to record service bulletins and notices that you receive to keep your 
manual updated.
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SAFETY (ENGLISH)

Safety Indicator Signal Words
The following signal words and colors are used throughout this document to 
indicate safety hazards. Pay careful attention when you see them. The level of 
severity differs for each signal word and color.

Signal words are accompanied by graphics showing what personnel should or 
should not do. The graphics are called safety symbols and are defined starting on 
page 18, but more specific text is provided every time a graphic is used 
throughout the manual.

Failure to comply with the instructions accompanying each signal word may result 
in property damage, personal injury, or even death. Personnel must follow all 
safety procedures and practices to ensure the safest possible operation of this 
equipment. However, at no time is this document a substitute for common sense. 
Personnel must ensure that the work environment is safe and free of distractions.

Danger Indicates an imminently hazardous situation which, if not avoided, is 
likely to result in death or serious injury.

Warning Indicates a potentially hazardous situation, which, if not avoided, 
may result in death or serious injury.

Caution Indicates a potentially hazardous situation which, if not avoided, 
may result in minor or moderate injury.

Notice Calls attention to information that is significant to understanding the 
operation at hand or the potential for property damage.

Environmental Applies to conditions that may affect the environment but do not 
have an immediate, direct effect on personnel or equipment.

Signal words are used in conjunction with safety symbols 
to give hazard messages throughout this manual. 
Common safety symbols are defined starting on page 18.

Refiérase a la 
página 25 para 
español.
For safety 
information in 
Spanish,refer to 
page 25.



Original Instructions: 001080 rev. B 2

BLADE SAW: SAFETY

General Safety & Equipment Rules
Because it is impossible to anticipate every circumstance that might involve a 
hazard, the safety information provided in this equipment manual and on the 
machine is not all-inclusive. If this machine is operated or serviced using a 
procedure not specifically recommended by the manufacturer, the procedure shall 
be approved by a professional engineer to ensure it will not render the equipment 
unsafe. Use extreme caution and common sense at all times.

Know Your Equipment

• Read this manual completely before using or maintaining the equipment. Do 
not operate this machine unless you have a thorough knowledge of the 
controls, safety devices, emergency stops, and operating procedures 
outlined in this manual.

• Read and follow all safety notes. Failure to comply with these instructions 
may result in economic loss, property damage, and/or personal injury 
including death.

• Refer to the lockout/tagout guidelines on the following pages to safely 
perform maintenance and troubleshooting of this equipment.

• Observe and obey all safety labels. Replace worn labels immediately.
• Use this equipment solely for the purpose described in this manual.
• Only qualified personnel should attempt to operate or perform maintenance 

on this equipment. “Qualified personnel” is defined as:
 ...a person or persons who, by possession of a recognized degree or certificate of 
professional training, or who, by extensive knowledge, training, or experience, has 
successfully demonstrated the ability to solve problems relating to the subject matter 
and work—ANSI B30.2-1983
...one who has skills and knowledge related to the construction and operation of the 
electrical equipment and installations and has received safety training on the hazards 
involved—NEC 2002 Handbook

Personal Safety

• Always wear personal protective equipment (for example, safety glasses 
and hearing protection) in an industrial environment.

• Utilize a filtering face piece (dust mask) when working near sawdust.
• Wear proper clothing. Do not wear loose clothing or jewelry. Confine long 

hair by tying it back.
• Use caution when lifting heavy parts or material.

Installing the Equipment

• Follow installation instructions completely.
• Use proper lifting equipment rated for the proper weight.
• This equipment is not for use in a residential area.
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Keeping a Safe Environment

• Pay attention to your surroundings.
• Keep children away. All visitors should be kept a safe distance from the 

work area. Hazards may not be apparent to individuals unfamiliar with the 
machine.

• Keep work areas well lit.
• Keep the work area clean and free of any trip or slip hazards.
• Do not use the equipment in damp or wet locations, or expose it to rain or 

snow. 
• Minimize dust clouds and protect your equipment by cleaning dust in this 

manner:
a) Shut down electrical power and sources of ignition

b) Vacuum dust prior to blowing with air
c) Powered cleaning equipment such as vacuums must be consistent 

with local governmental codes for use in dusty conditions.

Operating and Maintaining the Equipment

• Ensure that all people, tools, and foreign objects are clear of the restricted 
zones before operating this equipment. The restricted zones are shown 
on page 17.

• Perform safety tests to ensure all E-stops are working properly before 
operating the equipment at the initial startup, after performing any 
maintenance, and in accordance with the maintenance schedule.

• Always push an E-stop button before approaching a machine for any 
reason. An E-stop may cause components to move without warning.

• Only use procedures described in this manual. Any other procedures should 
be discussed with MiTek to verify it is done safely. For topics not covered in 
this manual or online, contact MiTek for advice.

• In case of machine malfunction, stop the machine immediately using an E-
stop, lockout/tagout, and report the malfunction to a supervisor.

• Never leave the machine running unattended. Turn the power off! Do not 
leave the machine until all parts have come to a complete stop and all 
electrical power has been shut off. If an equipment manual specifies a 
machine is designed for automated use, ensure safety devices prevent 
unauthorized entry before moving away from the machine.

• Check for worn or damaged parts regularly. Repair or replace them 
immediately.

NOTICE
Never use compressed air inside an electrical enclosure. It 
may force contaminants into electrical connections.
Use a vacuum to remove dust from electrical enclosures. 
Canned air is acceptable after vacuuming.
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• Only use exact replacement parts specified. Using unapproved parts may 
void the warranty and can be a safety risk.

• Keep the hydraulic, pneumatic, and electrical systems in good working 
order at all times. Repair leaks and loose connections immediately. Never 
exceed the recommended pressure or electrical power.

• Check that all guards and safety devices are in place and in working order 
before each shift starts. All protective guards and safety devices must be in 
place before and during use of the machine. Never disconnect or bypass 
any safety device or electrical interlock.

• Torque bolts and fasteners to the specifications given by MiTek. If no torque 
specification is given, use industry standards.

• Only qualified maintenance personnel shall make adjustments or remove, 
repair, or install safety devices. Only qualified electricians should perform 
electrical work.

• Periodically inspect the quality of the finished product.
• Document all preventive and repair maintenance over the life of the 

machine to improve machine efficiency and reduce the risk of accidents.

Electrical Safety Notes

• Do not use any liquids in the interior of electrical cabinets.
• When using solvents on and around the machine, remove power to the 

machine to eliminate the chance of sparking, resulting in explosion or fire. 
Wear a respirator approved for use with solvents.

E-Stop Locations
See Emergency Stop on page 59 for E-stop locations.
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General Warnings

! WARNING
HIGH VOLTAGE ELECTRICITY!
May cause serious personal injury or death. Ensure only qualified 
electricians perform electrical service work.

! WARNING

Read the equipment manual, safety labels, and all safety information 
provided before operating or maintaining this equipment.

! WARNING
CRUSH OR CUT HAZARD
Guards must always be in place during operation to avoid serious 
injury and possibly death.
Always replace guards after completing maintenance and before 
removing the lockout/tagout device.

! WARNING
Many components are manufactured from high carbon, heat-treated 
steel. Do not attempt to straighten, bend, or weld these components, 
as they may fail under load causing serious personal injury or death.
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Lockout/Tagout

Lockout/Tagout Guidelines
Lockout/tagout all energized systems before performing maintenance on them.

All lockout/tagout guidelines must be met according to OSHA 29 CFR 
1910.147. A specific procedure should be included in your company’s energy 
control program. This manual is not intended to replace your company’s de-
energizing or lockout/tagout procedure required by OSHA, but merely to provide 
general guidance.

The term “lockout,” as used in this manual, means placing a lockout device, such 
as a keyed padlock, on any and all energy sources to ensure that the energy 
isolating device and the equipment being controlled cannot be re-energized or 
operated until the lockout device is removed. See Electrical Lockout/Tagout 
Procedures on page 7 and Hydraulic or Pneumatic System Lockout/Tagout 
Procedure on page 10 for more information about each type of lockout/tagout 
procedure.

• Energy sources include electrical, mechanical, hydraulic, pneumatic, 
chemical, thermal, or other energy.

• In the case of electrical energy sources, the main power and control power 
to the machinery must be turned off and physically locked in the Off position.

• Before performing maintenance on the pneumatic or hydraulic systems, 
bleed the lines prior to lockout/tagout to eliminate pressure.

If more than one person is working in a restricted zone, use a group lockout 
device that will allow each person to use a lock that can be removed only by the 
person performing the maintenance.

“Tagout” means that a prominent warning is securely fastened to an energy-
isolating device to indicate that the equipment shall not be operated.

Whenever you see this symbol in the margin, lockout/tagout!
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Electrical Lockout/Tagout Procedures

Working on a Machine Outside the Machine’s Main Electrical Enclosure

Before performing maintenance on any machine with electrical power, lockout/
tagout the machine properly. When working on a machine outside of the 
machine’s main electrical enclosure, not including work on the electrical 
transmission line to the machine, follow your company’s approved lockout/tagout 
procedures which should include, but are not limited to the steps here.

1. If applicable, close the machine software and shut down the PC using the 
Power > Shut down method in Windows.

2. Engage an E-stop on the machine.

3. Turn the disconnect switch handle to the Off position. See Figure 1-1.

Figure 1-1: Example of a Disconnect Switch in Off Position

If you are working on the electrical transmission line to the 
machine, follow the procedure on page 8.

! WARNING
ELECTROCUTION HAZARD.
When the disconnect switch is off, there is still live power within 
the disconnect switch’s enclosure. Always turn off the power at 
the building’s power source to the equipment before opening this 
electrical enclosure.
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4. Attach a lock and tag that meet OSHA requirements for lockout/tagout.

Figure 1-2: Example of a Lockout/Tagout Mechanism on an Electrical Enclosure

5. Restrain or de-energize all pneumatic components, hydraulic components, 
and other parts that could have live or stored power.

Working on a Machine Inside the Machine’s Main Electrical Enclosure or in 
the Electrical Transmission Line to the Machine

Before opening the main electrical enclosure, or attempting to repair or replace an 
electrical transmission line to the machine, lockout/tagout the machine properly. 
Follow your company’s approved lockout/tagout procedures which should include, 
but are not limited to the steps here.

1. If applicable, close the machine software and shut down the PC using the 
Power > Shut down method in Windows.
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2. Engage an E-stop on the 
machine.

3. Shut the power to the 
machine off at the 
machine’s power source 
which is usually an electrical 
service entry panel on the 
facility wall. One example of 
a locked-out power source 
panel is shown in Figure 1-
3.

4. Attach a lock and tag that 
meets OSHA requirements 
for lockout/tagout.

5. Open the door to the 
enclosure in which you need 
access, and using a 
multimeter, verify that the 
power is off.

Figure 1-3: Sample of a Lockout/
Tagout Mechanism on a Power 
Source Panel
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Hydraulic or Pneumatic System Lockout/Tagout Procedure
Before working on or near hydraulic or pneumatic components, bleed the lines of 
pressure.

When Lockout/Tagout Is Not Required

If working on components other than the hydraulic or pneumatic system that 
require you to be in the vicinity of movable hydraulic or pneumatic components, 
you must, at a minimum, physically restrain those components from moving. If this 
is not possible, lockout/tagout the entire hydraulic or pneumatic system.

When Lockout/Tagout Is Required

Before attempting repair or performing maintenance on a hydraulic or pneumatic 
line or component, lockout/tagout the machine properly. Follow your company’s 
approved lockout/tagout procedures.

Figure 1-4: How to Lockout/Tagout the Pneumatic System

Troubleshooting with an Energized Machine
Only a qualified electrician, using the personal protective equipment and following 
the procedures recommended in NFPA 70E should ever attempt service or repair 
of or near an energized area or component of the machine.

Whenever maintenance is performed while the equipment is electrically 
energized, there is a potential electric arc flash hazard. Refer to NFPA 70E for the 
personal protective equipment required when working with electrically energized 
components. Pneumatic and hydraulic components may move unexpectedly if not 
de-energized. Physically restrain any components capable of movement when 
working on or near those components.

Main Pneumatic Filter/Regulator
• Located on the outfeed end of saw.
• Yellow plate is shown in lockout posi-

tion. Place lock and tag through holes 
in yellow plate.

• Pneumatic lines will bleed naturally 
when yellow plate is in lockout position.

• Ensure gauge reads 0 before performing 
replacing a supply bottle for the printer 
or performing any maintenance!
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Treatment for Hazardous Substances

Table 1-1: Hazardous Substances Used in Normal Maintenance

! WARNING

PRINTER INK AND CLEANER IS HIGHLY FLAMMABLE!
Keep away from extreme heat, sparks, or open flame.
No smoking near these substances.

Printer Ink Printer Cleaner

Primary 
Hazards

Flammable Flammable

Method of 
extinguishing 
fire

Alcohol-resistant foam, 
carbon dioxide, dry 
powder, water fog--
NOT water

Alcohol-resistant foam, 
carbon dioxide, dry 
powder, water fog--
NOT water

Protective 
Equipment

Gloves
Goggles
Eyewash station

Gloves
Goggles
Eyewash station
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Table 1-2: How to Treat Contact With a Hazardous Substance

Safety Tests
These test procedures MUST be performed by qualified personnel at startup and 
after ANY maintenance, adjustment, or modification. Testing ensures that the 
safety system and machine control system work together to properly stop the 
machine.

General Inspection
1. Lockout/tagout the machine.

2. Make sure sharp objects are clear of all pneumatic and electrical system 
cables.

3. Check the BLADE saw for debris or tools that would block the path of 
parts. Remove any that you may find. The following locations are 
especially important:
• Infeed component (Auto Deck or Ranger)

If Substance 
Gets On...

Then Do This...

Printer Ink Printer Cleaner

Skin/Clothing Rinse, remove 
clothing, then wash 
skin w/soap

Rinse, remove 
clothing, then wash 
skin w/soap

Hair Wash with soap and 
water

Wash with soap and 
water

Eyes Flush with water Flush with water, 
remove contact lenses 
if possible, continue 
flushing

Ingested Do NOT induce 
vomiting; consult 
physician immediately

Do NOT induce 
vomiting; consult 
physician immediately.

Inhalation Move to fresh air Move to fresh air

! CAUTION

CRUSH AND CUT HAZARD.
Before turning on the equipment, make sure that all 
personnel and equipment are clear.
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• Infeed Rail
• LASM clamp
• Infeed and Outfeed clamps
• Outfeed component (Outfeed Table, Skewed Conveyor, or CDS)

4. Check saw blade condition (see When to Replace the Saw Blade on page 
113)

5. Remove lockout/tagout and return electrical power and pneumatic 
pressure to the machine.
• Power up the saw using the instructions on Powering Up or Down on 

page 70.

6. Press the illuminated blue Reset button. The Reset button light should turn 
off to indicate the machine is ready for normal operation.

7. The main filter / regulator and other sub-regulators should match the 
pressure ratings detailed in Overview of Pneumatic Components on page 
151.

8. Without pressing the open-door pushbutton, pull on the door handle for 
each door (3 total) to verify all doors are closed and locked.

Inspecting Indicators
1. While performing any of the following safety tests, check to ensure the red 

Blade In Motion light located on the operator interface panel lights up 
when the blade is running.

2. While performing any of the following safety tests, check to ensure the 
beacon on top of the main electrical enclosure lights up when cutting is 
taking place.

3. Verify that all safety labels are present and legible.

Interlock Door Test
Certain doors are interlocked with the E-stop system and should not open when 
certain parts are in motion.

! CAUTION

CRUSH AND CUT HAZARD.
Before turning on the equipment, make sure that all 
personnel and equipment are clear.
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Test that the SAW CHAMBER DOOR interlock is functioning by performing this 
procedure:

1. Turn the saw blade on (see Powering Up or Down on page 70.).

2. Attempt to open the saw chamber door while pressing the Request to 
Unlock button (see Interlocked Doors or Guards on page 64).
• The door should NOT open while the saw blade is running.

3. Press the STOP button.

4. Watch the lights on the operator interface panel.
• A red Blade In Motion light should be illuminated when blade is moving.
• A green Blade Motion Stopped light should illuminate when blade 

stops.

5. Wait until the blade stops spinning, then attempt to open the saw chamber 
door again as described in step 2.
• The door should open now.

6. With the door open, attempt to start the blade by pressing the green 
START button on the saw’s operator interface panel.
• The blade should NOT move.

7. Resolve any inconsistencies:
a) If the door opens while the blade is still moving OR the blade spins with 

the door open, lockout/tagout the saw and arrange for a qualified 
service technician to repair the equipment.

b) If the indicator lights are not behaving as expected, replace the bulb or 
repair the light. 

! CAUTION
CUT AND CRUSH HAZARD.
Never attempt to stop the saw blade with your hand or a hand-
held object.

There may be instances when access is given to the saw chamber 
while the saw blade is coasting at a speed less than 5 RPM. This is 
normal and not a cause for alarm. Do not force the blade to stop.

SAW CHAMBER 
DOOR should not 
open if the blade 
is moving.
STROKE/
ELEVATION 
CHAMBER door 
should not open if 
any axes are in 
motion.
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Test that the STROKE/ELEVATION CHAMBER DOOR interlock is functioning by 
performing this procedure:

1. Open the stroke/elevation chamber door (see Interlocked Doors or Guards 
on page 64). 

2. Ensure that the E-stop circuit is not engaged (no E-stops active).

3. Attempt to manually move either the angle, elevation, or stroke axis using 
the touch screen.
• The axis should NOT move while a door is open.

4. If an axis moves while the door is open, lockout/tagout the saw and 
arrange for a qualified service technician to repair the equipment.

E-Stop Test

1. Start running the saw and all integrated components:
a) Power up the saw using the instructions on Powering Up or Down on 

page 70.
b) Place the machine in MANUAL mode using the switch on the operator 

interface.
c) Start the saw motor by pressing the Saw Motor START button on the 

operator interface.
d) Wait approximately 5 seconds until the blade is up to full speed.

2. Prepare a stopwatch to time how long it takes for the saw blade to stop. 

! CAUTION

CRUSH AND CUT HAZARD.
Before turning on the equipment, make sure that all personnel 
and equipment are clear.

! CAUTION

CRUSH AND CUT HAZARD.
Before turning on the equipment, make sure that all 
personnel and equipment are clear.
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3. Activate any one of the E-stops listed here and measure the time between 
pressing the E-stop and when the blade comes to a complete stop.
• Operator interface E-stop
• Electrical enclosure E-stop
• Infeed Rail E-stop
• Infeed Rail Pull-Cord (only present in older models)
• Other Infeed or Outfeed Component E-stops (will vary depending on 

setup)

4. Ensure that the blade and integrated components stop motion in a timely 
manner:
• If the saw blade does not stop within 5-10 seconds, contact Automation 

Support immediately for resolution.
• If all integrated components do not stop in a timely manner, lockout/

tagout the entire wood processing system and arrange for a qualified 
service technician to troubleshoot and repair the equipment.

• If the saw blade and integrated components stop as expected, repeat 
the procedure to test all E-stops listed in step 3.

Testing Movement While E-Stop is Active

1. With an E-stop activated, use the touch screen to attempt to manually 
move an axis.

2. Watch the axis that was chosen to see if it moves. Because an E-stop is 
activated, no movement should occur.

3. If movement does occur, Lockout/Tagout immediately and contact 
Automation Support.

! CAUTION

CRUSH AND CUT HAZARD.
Before turning on the equipment, make sure that all 
personnel and equipment are clear.
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Restricted Zone

Figure 1-5: Know the Restricted Zone

Marking the Restricted Zone
The restricted zone must be marked so everyone near the equipment can clearly 
see the area where danger may exist. See page 57 for more details.

! DANGER
Stay out of the restricted zone when equipment is in use. Serious 
injury or death may result if personnel are in the restricted zone.
Always look for personnel in the restricted zone before operating 
equipment. 
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Safety Symbol Definitions
The safety symbols shown in this section are found throughout the manual to 
indicate hazards related to this machine. All personnel expected to operate or 
maintain this machine should be familiar with these safety symbols and their 
meanings.

User caution. It indicates a condition where equipment damage 
resulting in injury could occur if operational procedures are not 
followed. To reduce risk of damage or injury, refer to accompanying 
documents, and follow all steps or procedures as instructed.

Electrical hazard. It indicates dangerous high voltages inside of an 
enclosure and/or the presence of a power source. To reduce the risk 
of fire or electric shock, do not attempt to open the enclosure or gain 
access to areas where you are not instructed to do so. Refer 
servicing to qualified service personnel only.
This equipment should be operated only from the type of source 
indicated on the manufacturer’s identification label. Installation 
should be in compliance with applicable sections of the national 
electric code. Consult your local building code before installing.

 
Crush hazard. Keep hands and other body parts clear.

Noise hazard. Equipment produces loud noise in excess of 100 DBA 
during operation. Use appropriate PPE to protect hearing when in 
the vicinity of this equipment.
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Slip hazard. Use of appropriate footwear is required.

Trip hazard. Pay attention when walking in this area.

Kickback hazard.

   
Keep hands clear of cutting parts.
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Keep hands and body clear.

Hot surface. Surface temperature can exceed 158°F (70°C) during 
normal operation. Do not touch.

Ventilate. Slots and openings in the cabinet are provided for 
ventilation to ensure reliable operating of the equipment. To protect 
the equipment from overheating, those openings must not be 
blocked or covered. This equipment should not be placed in a built-
in installation, such as a wall cutout, unless proper ventilation is 
provided because hot temperatures result.

Operation of this equipment may result in flying debris and 
excessive noise. To reduce the risk of eye injury, wear only approved 
PPE.

Keep hands away from moving parts.
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High pressure hose. Use appropriate PPE when working on 
equipment. Maintain safe pressure level at all times.

Equipment has automatic restarting capability. Lockout/tagout on the 
upstream disconnect before servicing.

      
The operation of this equipment requires the use of PPE. 
Do not operate without wearing the required protective clothing.
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Refer to manual. After installation, read the user’s guide carefully 
before operating. Follow all operating and other instructions 
carefully.

 
Circuits are live. Lockout/tagout on the upstream disconnect prior to 
servicing.

 
Lockout in a de-energized state.

   
Lift point. In order to decrease the likelihood of damage to the 
equipment, use only the lift points indicated in the manual.

 
Open switch before adjusting equipment.
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To reduce the risk of equipment damage or injury to personnel, 
maintain pressure at safe levels.

Consult material safety data sheet.

Unplug equipment before servicing.

No smoking in this area.

Hazardous moving parts are located behind this access panel. Do 
not operate this equipment without all guards and covers in place.

 
Do not place containers with liquids such as coffee, water, soda, etc. 
on this equipment.
Do not operate this equipment in a wet environment.
Do not expose to water.

No lift point. Do not lift this device with a hook/crane assembly. 
Equipment damage occurs. Refer to the installation instructions.
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Declaration of Safety Conformity

 
Do not step or stand upon this equipment. Stepping or standing on 
this equipment may result in serious injury.
Not a step. Do not step or stand at this location.

Do not use unapproved lubricants in this equipment.

Unauthorized personnel are not allowed beyond this point.

Do not operate without guards in place. 

Do not weld.

Do not discard into the municipal waste stream.

Indicates notes regarding lubrication.
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SEGURIDAD (ESPAÑOL)

Indicadores de seguridad: Palabras de aviso
Las siguientes palabras y colores de aviso se utilizan a lo largo de este 
documento para indicar riesgos de seguridad. Preste suma atención cuando los 
vea. El nivel de gravedad es diferente por cada palabra o color de aviso.

Las palabras de aviso van acompañadas por gráficos que muestran al personal lo 
que deben y no deben hacer. Los gráficos se llaman símbolos de seguridad y se 
definen en la page 42, pero se proporciona un texto más específico cada vez que 
se utiliza un gráfico por todo el manual. Todas las personas que estén cerca de 
una máquina tienen que ser capacitadas en cómo leer estos indicadores de 
seguridad.

No cumplir las instrucciones que acompañan cada palabra de aviso puede 
producir daños a la propiedad, lesiones personales e incluso la muerte. El 
personal debe seguir todos los procedimientos y prácticas de seguridad 
establecidos para asegurar el uso más seguro posible de este equipo. No 
obstante, en ningún caso este documento reemplaza el sentido común. El 
personal debe asegurarse de que el entorno de trabajo sea seguro y esté libre de 
distracciones.

Peligro Indica una situación de peligro inminente que, si no se evita, 
ocasionará la muerte o graves lesiones.

Advertencia Indica una situación potencialmente peligrosa que, si no se evita, 
podría producir la muerte o lesiones graves.

Precaución Indica una situación potencialmente peligrosa que, si no se evita, 
puede producir lesiones menores o moderadas.

Aviso Llama la atención a información importante para entender la 
operación que se desea realizar o daños a la propiedad probables.

Ambiental Se aplica a condiciones que pueden afectar el entorno pero que no 
tienen un efecto inmediato o directo sobre el personal o el equipo.
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Reglas de seguridad para el equipo de general
Debido a la imposibilidad de anticipar todas las circunstancias que podrían 
constituir un riesgo, la información de seguridad suministrada en este manual del 
equipo y sobre la máquina no es exhaustiva. Si se utiliza o realiza el 
mantenimiento de esta máquina utilizando un procedimiento no recomendado 
específicamente por el fabricante, el procedimiento deberá ser aprobado por un 
ingeniero profesional para asegurarse de que no afecte la seguridad del equipo. 
¡Manéjese siempre con suma precaución y sentido común!

Conozca su equipo

• Lea este manual en su totalidad antes de utilizar o mantener el equipo. No 
utilice esta máquina a menos que esté perfectamente familiarizado con los 
controles, los dispositivos de seguridad, los paros de emergencia y los 
procedimientos operativos que se describen en este manual.

• Lea y siga todas las notas de seguridad. El no cumplimiento de estas 
instrucciones podría producir pérdidas económicas, daños a la propiedad y/
o lesiones personales, incluida la muerte.

• Refiérase a las pautas de bloqueo/etiquetado proporcionadas en las 
siguientes páginas para realizar el mantenimiento y solucionar problemas 
de este equipo en forma segura.

• Observe y cumpla con todas las etiquetas de seguridad. Cambie las 
etiquetas gastadas inmediatamente.

• Utilice este equipo únicamente para el propósito que se describe en este 
manual.

• Sólo personal calificado debe intentar utilizar o realizar el mantenimiento de 
este equipo. Por "personal calificado" se entiende:

 ...una persona o personas que, por el hecho de poseer un título o certificado de 
capacitación profesional reconocido o que, por sus amplios conocimientos o 
experiencia, han demostrado con éxito estar capacitados para resolver problemas 
relacionados con el tema y el trabajo en cuestión—ANSI B30.2-1983
...una persona que posee habilidades y conocimientos relacionados con la 
construcción y uso de equipos e instalaciones eléctricas y que ha recibido 
capacitación en seguridad sobre los riesgos posibles—NEC 2002 Handbook

Seguridad personal

• Use siempre un equipo de protección personal (por ejemplo, lentes de 
seguridad y protección auditiva) en un entorno industrial.

• Utilice una máscara protectora cuando trabaje cerca de aserrín.
• Use ropa adecuada. No use ropa suelta ni joyas. Si tiene el cabello largo, 

áteselo para atrás.
• Proceda con precaución cuando levante piezas o materiales pesados.

Instalació del equipo

• Siga las instrucciones de instalación al pie de la letra.
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• Use el equipo de elevación adecuado para el peso adecuado.
• No utilizar este equipo en zonas residenciales.

Cómo manterner un entorno seguro

• Preste atención a su entorno.
• Mantenga alejados a los niños. Todos los visitantes deben mantenerse a 

una distancia segura del área de trabajo. Los riesgos pueden no ser 
evidentes a las personas no familiarizadas con la máquina.

• Mantenga las áreas de trabajo bien iluminadas.
• Mantenga el área de trabajo limpia y libre de cualquier riesgo de tropiezo o 

resbalamiento.
• No utilice el equipo en lugares húmedos o mojados y no lo exponga a la 

lluvia o a la nieve.
• Minimice las nubes de polvo y proteja su equipo quitando el polvo de la 

siguiente manera:
a) Apague la alimentación eléctrica y todas las fuentes de ignición   

b) Aspire el polvo antes de soplarlo con aire   
c) El equipo eléctrico de limpieza como las aspiradoras debe cumplir con 

los códigos del gobierno local para uso en condiciones  polvorientas.

Uso y mantenimiento del equipo

• Asegúrese de que no haya personas, herramientas y objetos extraños en 
las zonas restringidas antes de utilizar este equipo. Las zonas 
restringidas se indican en la página 17.

• Realice pruebas de seguridad para verificar que todos los paro de 
emergencia funcionen adecuadamente antes de utilizar el equipo al 
principio de la puesta en marcha y después de realizar cualquier tarea de 
mantenimiento.

• Presione siempre el pulsador de un paro de emergencia antes de acercarse 
a una máquina por cualquier motivo. Un paro de emergencia puede causar 
que los componentes se muevan sin previo aviso.

• Use solamente los procedimientos descritos en este manual. Cualquier otro 
procedimiento debe analizarse con MiTek para verificar que sea seguro. 
Para los temas que no se traten en este manual o en línea, póngase en 
contacto con MiTek para recibir asesoramiento.

NOTICE
¡No utilice nunca aire comprimido dentro de una caja eléctrica! 
Puede forzar sustancias contaminantes hacia el interior de las 
conexiones eléctricas.
Utilice un aspirador para eliminar polvo de las cajas eléctricas. Es 
aceptable utilizar aire comprimido después de aspirar.
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• En caso de que la máquina no funcione correctamente, deténgala 
inmediatamente utilizando un freno de emergencia e informe el problema a 
un supervisor.

• No deje nunca la máquina encendida si no está junto a ella. ¡Apáguela! No 
la abandone hasta que todas las piezas se detengan completamente y 
hasta que se haya apagado la alimentación eléctrica.

• Verifique periódicamente que no haya piezas gastadas o dañadas. 
Repárelas o cámbielas inmediatamente.

• Use solamente las piezas de repuesto exactas que se especifican. El uso 
de piezas no aprobadas puede anular la garantía y plantear un riesgo de 
seguridad.

• Mantenga los sistemas neumáticos y eléctricos en buen funcionamiento en 
todo momento. Repare las fugas y las conexiones sueltas inmediatamente. 
No exceda nunca la presión ni potencia eléctrica recomendadas.

• Verifique que todos los dispositivos de seguridad estén en buen 
funcionamiento antes de comenzar cada turno. Todos los dispositivos 
protectores y de seguridad deben estar en su lugar antes y durante el uso 
de la máquina. No desconecte ni evite nunca ningún dispositivo de 
seguridad ni interbloqueo eléctrico.

• Apriete los pernos y tornillos al par de apriete especificado por MiTek. Si no 
se especifica el par de apriete, use los estándares de la industria.

• Solo el personal de mantenimiento calificado puede quitar o instalar los 
dispositivos de seguridad. Solo electricistas calificados deben realizar 
trabajos eléctricos.

• Inspeccione periódicamente la calidad del producto terminado.
• Documente todas las tareas de mantenimiento preventivo y de reparación 

durante la vida útil de la máquina para mejorar su eficiencia y reducir el 
riesgo de accidentes.

Seguridad eléctrica

• No utilice líquidos en el interior de los gabinetes eléctricos.
• Cuando utilice disolventes sobre o alrededor de la máquina, desconecte la 

alimentación para eliminar las probabilidades de chispas, que pueden 
producir una explosión o incendio. Use un respirador aprobado para el uso 
con disolventes. Use ropa protectora, guantes y lentes de seguridad.

Ubicación de un paro de emergencia
Refiérase a la página 59 para ubicación de un paro de emergencia.
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Advertencias generales

! WARNING
¡ELECTRICIDAD DE ALTO VOLTAJE!
Puede causar lesiones personales graves o la muerte. Asegúrese de 
que solo electricistas calificados realicen trabajos de servicio 
eléctrico.

! WARNING
Lea el manual del equipo, las etiquetas de seguridad y toda la 
información de seguridad suministrada antes de operar o hacerle 
mantenimiento a este equipo.

! WARNING
RIESGO DE APLASTAMIENTO O CORTE
Los protectores siempre deben estar colocados durante la operación 
para evitar lesiones graves y posiblemente la muerte.
Reemplace siempre los protectores después de terminar las tareas de 
mantenimiento y antes de quitar el dispositivo de bloqueo/etiquetado.

! WARNING
Muchos componentes se fabrican en acero duro tratado 
térmicamente. No intente enderezar, doblar ni soldar estos 
componentes, ya que pueden fallar al someterse a cargas y causar 
lesiones personales o la muerte.
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Bloqueo/Etiquetado

Pautas de bloqueo/etiquetado
Deben cumplir con todas las pautas de bloqueo/etiquetado conforme a la 
norma OSHA 29 CFR 1910.147. El programa de control de energía de la 
compañía debe incluir un procedimiento específico. El objetivo de este manual no 
es reemplazar el procedimiento de desenergización o bloqueo/etiquetado 
requerido por la OSHA, sino proporcionar pautas orientativas generales.

El término "bloqueo", según se utiliza en este manual, se refiere a la colocación 
de un dispositivo de bloqueo en las fuentes de energía para asegurar que el 
dispositivo aislador de energía y el equipo controlado por éste no puedan 
reenergizarse o utilizarse hasta que se retire dicho dispositivo. Consulte los 
Procedimientos de bloqueo/etiquetado eléctricos en la página 31 y el 
Procedimiento de bloqueo/etiquetado del sistema hidráulico o neumático en la 
página 34 para obtener más información sobre cada tipo de procedimiento de 
bloqueo/etiquetado

• Las fuentes de energía incluyen energía eléctrica, mecánica, hidráulica, 
neumática, química, térmica y otras.

• En el caso de fuentes de energía eléctrica, la alimentación principal y la 
alimentación de control a la maquinaria deben apagarse y bloquearse 
físicamente en la posición "off" (apagado).

• Por lo general, como dispositivo de bloqueo se utiliza un candado con llave.

Si hay más de una persona trabajando en una zona restringida, utilice un 
dispositivo de bloqueo grupal que permita a cada persona utilizar un candado que 
sólo pueda ser retirado por la persona que realiza el mantenimiento.

Siempre que vea este símbolo, ¡Bloquee/Etiquete!
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Procedimientos de bloqueo/etiquetado eléctricos

Cuando trabaja en una máquina fuera del gabinete eléctrico principal de la 
máquina

Antes de realizar el mantenimiento de cualquier máquina con alimentación 
eléctrica, bloquee y etiquete la máquina de forma adecuada. Cuando trabaje en 
una máquina fuera del gabinete eléctrico principal de la máquina, salvo en el caso 
de trabajos en la línea de transmisión eléctrica a la máquina, siga los 
procedimientos de bloqueo/etiquetado aprobados por la compañía, los cuales 
deberían incluir, entre otros, los pasos aquí indicados.

1. Coloque un paro de emergencia sobre la máquina.

2. Coloque el mango del interruptor con fusibles en la posición "apagado". 
Vea la Figura 2-1.

Figura 2-1: El gabinete eléctrico principal

Si trabaja en la línea de transmisión eléctrica a la máquina, siga 
el procedimiento de la page 33.

! WARNING
RIESGO DE ELECTROCUCIÓN.
Cuando el interruptor con fusibles está apagado, sigue habiendo 
energía dentro del gabinete del interruptor. ¡Apague siempre la 
alimentación en la fuente de alimentación del edificio antes de 
abrir este gabinete eléctrico!
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3. Coloque un candado y una etiqueta que cumplan con los requisitos de 
bloqueo/etiquetado de la OSHA.

Figura 2-2: Mecanismo de bloqueo/etiquetado en un gabinete eléctrico principal

4. Trabe o desenergice todos los componentes neumáticos y otras piezas 
que tengan alimentación directa o almacenada.
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Cuando trabaje en una máquina dentro del gabinete eléctrico principal 
de la máquina o en la línea de transmisión eléctrica a la máquina

Antes de abrir el gabinete eléctrico principal o intentar reparar o reemplazar 
una línea de transmisión eléctrica a la máquina, bloquee y etiquete la 
máquina en forma adecuada. Siga los procedimientos de bloqueo/etiquetado 
aprobados por la compañía, los cuales deberían incluir, entre otros, los pasos 
aquí indicados.

1. Coloque un paro de 
emergencia sobre la 
máquina.

2. Apague la alimentación a la 
máquina en la fuente de 
alimentación, que, por lo 
general, es un panel de 
entrada de suministro 
eléctrico que se encuentra 
en una pared de las 
instalaciones. En la 
Figura 2-3 se muestra un 
ejemplo de panel de fuente 
de alimentación bloqueado.

3. Coloque un candado y una 
etiqueta que cumplan con 
los requisitos de bloqueo/
etiquetado de la OSHA.

4. Abra la puerta del gabinete 
al que necesita acceder y 
usando un multímetro 
verifique que la 
alimentación esté apagada.

Figura 2-3: Ejemplo de un 
mecanismo de Bloqueo/Etiquetado 
en un panel de entrada de 
suministro eléctrico
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Procedimiento de bloqueo/etiquetado del sistema 
hidráulico o neumático
Antes de realizar el mantenimiento de los sistemas neumáticos, purgue las líneas 
para eliminar la presión.

Cuando no se requiere bloqueo/etiquetado

Si trabaja con componentes que no son del sistema neumático pero que 
requieren su presencia en la proximidad de componentes neumáticos móviles, 
debe, como mínimo, trabar físicamente estos componentes para que no se 
muevan. Si no es posible, bloquee/etiquete todo el sistema neumático.

Cuando se requiere bloqueo/etiquetado

Antes de intentar reparar o realizar el mantenimiento de una línea o componente 
neumático, bloquee/etiquete la máquina en forma apropiada. Siga los 
procedimientos de bloqueo/etiquetado aprobados por la compañía.

Figura 2-4: Cómo bloquear y etiquetar el sistema neumátic

Solución de problemas con una máquina 
energizada
Sólo un electricista calificado que utilice el equipo de protección personal y siga 
los procedimientos recomendados en la norma NFPA 70E debe intentar realizar 
tareas de reparación o mantenimiento en un área o componente energizados de 
la máquina o en su proximidad.

Filtro/regulador neumático principal
(ubicado del lado derecho de la sierra)
• Se encuentra del lado derecho de la sierra.
• La placa amarilla se muestra en posición 

bloqueada. Coloque el bloqueo y la etiqueta 
a través de los orificios en la placa amarilla.

• Las mangueras neumáticas sangrarán de 
manera natural 
cuando la placa amarilla se encuentre en 
posición de bloqueo.

• Verifique que la lectura del indicador sea 0 
antes de 
reemplazar un frasco de suministro para la 
impresora 
o de realizar cualquier tipo de mantenimien-
to.
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Cada vez que se realizan tareas de mantenimiento mientras el equipo está 
eléctricamente energizado, existe un riesgo potencial de formación de un arco 
eléctrico. Consulte en la norma NFPA 70E el equipo de protección personal 
requerido para trabajar con componentes eléctricamente energizados. Los 
componentes neumáticos e hidráulicos pueden moverse de manera imprevista si 
no se desenergizan. Trabe físicamente cualquier componente que pueda 
moverse cuando deba trabajar en ellos o en su proximidad.

Tratamiento en caso de contacto con 
sustancias peligrosas

Table 2-1: Sustancias peligrosas que se utilizan en el mantenimiento normal

Table 2-2: Cómo tratar el contacto con una sustancia peligrosa

! WARNING

LA TINTA Y EL LIMPIADOR DE LA IMPRESORA SON 
ALTAMENTE INFLAMABLES.
Manténgalos alejados del calor extremo, las chispas o las 
llamas expuestas.
No se debe fumar cerca de estas sustancias.

Tinta de impresora Limpiador de 
impresora

Peligros 
principales

Inflamable Inflamable

Método de 
extinción

Espuma resistente al 
alcohol, dióxido de 
carbono, polvo seco, 
agua nebulizada; NO 
agua

Espuma resistente al 
alcohol, dióxido de 
carbono, polvo seco, 
agua nebulizada; NO 
agua

Equipo de 
protección

Guantes
Gafas protectoras
Estación de lavado de 
ojos

Guantes
Gafas protectoras
Estación de lavado de 
ojos

Si una 
sustancia entra 
en contacto 
con...

Haga esto...

Tinta de impresora Limpiador de 
impresora

La piel/ropa Enjuague, quítese la 
ropa y lave la piel con 
jabón

Enjuague, quítese la 
ropa y lave la piel con 
jabón

El cabello Lave con agua y jabón Lave con agua y jabón
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Pruebas de seguridad
Este procedimiento de prueba DEBE ser realizado por personal calificado durante 
la puesta en marcha y después de CUALQUIER tarea de mantenimiento, ajuste o 
modificación. La prueba permite comprobar si el sistema de seguridad y el 
sistema de control de la máquina funcionan juntos y detienen la máquina de 
manera adecuada. 

Inspección general
1. Realice el procedimiento de bloqueo/etiquetado de la máquina.

2. Asegúrese de que los objetos afilados estén alejados de todos los cables 
del sistema neumático y eléctrico.

3. Verifique que la sierra BLADE no tenga desechos ni herramientas que 
pudieran obstruir sus piezas. Retire todo lo que encuentre. Los siguientes 
lugares son especialmente importantes:
• Componente de alimentación (Auto Deck o Ranger)
• Riel de alimentación
• Prensa del LASM
• Prensas de alimentación y de salida

Los ojos Enjuague con agua Enjuague con agua, 
quítese los lentes de 
contacto si es posible 
y continúe enjuagando

Ingestión NO provoque el 
vómito; consulte 
inmediatamente a un 
médico

NO provoque el 
vómito; consulte 
inmediatamente a un 
médico

Inhalación Salga al aire libre Salga al aire libre

! CAUTION

PELIGRO DE APLASTAMIENTO Y CORTE.
Antes de encender el equipo, asegúrese de que todo el 
personal y los equipos estén alejados.

Si una 
sustancia entra 
en contacto 
con...

Haga esto...

Tinta de impresora Limpiador de 
impresora
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• Componente de salida (mesa de salida, banda transportadora inclinada, 
o CDS)

4. Verifique el estado de la cuchilla de la sierra (consulte Cuándo reemplazar 
la cuchilla de la sierra en la página 113)

5. Quite el bloqueo y etiquetado y restablezca la energía eléctrica y la 
presión neumática a la máquina.
• Encienda la sierra según las instrucciones de Encendido o apagado en 

la página 70.

6. Presione el botón azul iluminado “Reset” (restablecer). La luz del botón 
“Reset” debe apagarse para indicar que la máquina está lista para el 
funcionamiento normal.

7. El filtro/regulador principal y otros subreguladores deben coincidir con los 
valores nominales de presión detallados en Descripción general de los 
componentes neumáticos en la página 151.

8. Sin presionar el pulsador de apertura de la puerta, jale de la manija de 
cada puerta (3 en total) para verificar que todas las puertas están cerradas 
y bloqueadas.

Indicadores de inspección
1. Mientras realiza cualquiera de las siguientes pruebas de seguridad, 

compruebe que la luz roja “Blade In Motion” (cuchilla en movimiento) en el 
panel de la interfaz del operador se encienda cuando la cuchilla esté 
funcionando.

2. Mientras realiza cualquiera de las siguientes pruebas de seguridad, 
compruebe que la luz en la parte superior de la caja eléctrica principal se 
encienda cuando se realicen los cortes.

3. Verifique que todas las etiquetas de seguridad estén presentes y sean 
legibles.
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Prueba de las puertas interbloqueadas
Ciertas puertas están interbloqueadas con el sistema de botón pulsador de freno 
de emergencia y no deben abrirse cuando ciertas piezas se estén moviendo.

Pruebe que el interbloqueo de la PUERTA DE LA CÁMARA DE LA SIERRA 
funcione realizando este procedimiento:

1. Encienda la sierra según las instrucciones de Encendido o apagado en la 
página 70.

2. Trate de abrir la puerta de la cámara de la sierra mientras presiona el 
botón Request to Unlock en la página 64.
• La puerta NO debe abrirse mientras esté funcionando la cuchilla de la 

sierra.

3. Presione el botón STOP (alto).

4. Observe las luces por la interfaz del operador.
• Una luz roja (Blade In Motion) debe estar encendida cuando la cuchilla 

se esté moviendo.
• Una luz verde (Blade Motion Stopped) debe encenderse cuando se 

detenga la cuchilla.

5. Espere hasta que la cuchilla deje de dar vueltas y luego trate de nuevo de 
abrir la puerta de la cámara de la cuchilla, como se describió en el paso 2.
• La puerta debe abrirse ahora.

6. Con la puerta abierta, trate de arrancar la cuchilla presionando el botón 
START (Iniciar) verde en la interfaz del operador de la sierra.
• La cuchilla NO debe moverse.

7. Resuelva cualquier incongruencia:
a) Si se abre la puerta mientras la cuchilla todavía está en movimiento O 

la cuchilla gira con la puerta abierta, realice los procedimientos de 
bloqueo/etiquetado en la sierra y pida a un técnico de servicio 
calificado que repare el equipo. 

! CAUTION

RIESGO DE APLASTAMIENTO Y CORTE.
Antes de encender el equipo, asegúrese de que todo el 
personal y el equipo estén alejados.

La PUERTA DE 
LA CÁMARA DE 
LA SIERRA no 
debe abrirse si la 
cuchilla está en 
movimiento.
La puerta de la 
CÁMARA DE LA 
CARRERA/
ELEVACIÓN no 
debe abrirse si 
algún eje está en 
movimiento.
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b) Si las luces indicadoras no se comportan como se esperaba, 
reemplace la bombilla o repare la luz.

Pruebe que el interbloqueo de la PUERTA DE LA CÁMARA DE LA CARRERA/
ELEVACIÓN funcione realizando este procedimiento:

1. Abra la puerta de la cámara de carrera/elevación (vea las páginas 64).

2. Asegúrese de que el circuito del botón pulsador del freno de emergencia 
no esté acoplado (no hay botones pulsadores del freno de emergencia 
activos).

3. Use la pantalla táctil para mover un eje manualmente
• El eje NO debe moverse mientras una puerta esté abierta.

4. Si se mueve un eje mientras la puerta está abierta, realice los 
procedimientos de bloque/etiquetado en la sierra y pida a un técnico de 
servicio calificado que repare el equipo.

! CAUTION
RIESGO DE APLASTAMIENTO Y CORTE.
Nunca trate de detener la cuchilla de la sierra con la mano o 
con un objeto que sostenga con la mano.

Podría haber casos en que se permita el acceso a la cámara de la sierra 
mientras la cuchilla de la sierra se desacelera a una velocidad menor de 5 
RPM. Esto es normal y no es causa de alarma. No fuerce la cuchilla para 
que se detenga.

! CAUTION

RIESGO DE APLASTAMIENTO Y CORTE.
Antes de encender el equipo, asegúrese de que todo el 
personal y el equipo estén alejados.
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Prueba de los paros de emergencia

1. Comience haciendo funcionar la sierra y todos los componentes 
integrados:
a) Encienda la sierra según las instrucciones de Encendido o apagado 

en la página 70.
b) Coloque la máquina en modo MANUAL con el interruptor en la interfaz 

del operador.
c) Arranque el motor de la sierra presionando el botón START (arrancar) 

en la interfaz del operador.
d) Espere aproximadamente 5 segundos hasta que la cuchilla avance a 

toda velocidad.

2. Prepare un cronómetro para medir el tiempo que tarda en detenerse la 
cuchilla de la sierra. 

3. Active cualquiera de los paros de emergencia indicados aquí y mida el 
tiempo transcurrido entre que presiona el paro de emergencia y el 
momento en que la cuchilla se detiene completamente.
• Paro de emergencia de la interfaz del operador
• Paro de emergencia de la caja eléctrica
• Paro de emergencia del riel de alimentación
• Las cuerdas de parada de emergencia del riel de alimentación (sólo 

presente en modelos más antiguos)
• Otros paros de emergencia de los componentes de alimentación o 

salida (variará en función de la configuración)

4. Asegúrese de que la cuchilla y los componentes integrados detengan el 
movimiento sin demoras:
• Si la cuchilla de la sierra no se detiene en un intervalo de 5 a 10 

segundos, póngase en contacto de inmediato con el Soporte técnico de 
automatización para que lo solucionen.

• Si todos los componentes integrados no se detienen a tiempo, realice 
procedimientos de bloqueo/etiquetado en todo el sistema de 
procesamiento de madera y pida a un técnico de servicio calificado que 
diagnostique y repare el equipo.

! CAUTION

PELIGRO DE APLASTAMIENTO Y CORTE.
Antes de encender el equipo, asegúrese de que todo el 
personal y los equipos estén alejados.
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• Si la cuchilla de la sierra y los componentes integrados se detienen 
según lo esperado, repita el procedimiento para probar todos los paros 
de emergencia indicados en step 3.

Prueba de movimiento mientras el paro de emergencia está 
activo

1. Con el paro de emergencia activado, use la pantalla táctil para intentar 
mover manualmente un eje.

2. Observe si el eje que eligió se mueve. Como el paro de emergencia está 
activado, no debería moverse.

3. Si se mueve, realice de inmediato los procedimientos de bloqueo/
etiquetado y póngase en contacto con el Soporte técnico de 
automatización.

! CAUTION

PELIGRO DE APLASTAMIENTO Y CORTE.
Antes de encender el equipo, asegúrese de que todo el 
personal y los equipos estén alejados.
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Zona Restringida

Figura 2-5: Conocer la zona restringida

Marcar la zona restringida
La zona restringida deberá marcarse de tal manera que todas las personas que 
se encuentren cerca del equipo puedan ver claramente el área donde pueda 
haber peligro. Refiérase a la página 57.

! DANGER
Manténgase afuera de la zona restringida cuando el equipo esté 
en uso. Pueden producirse lesiones graves o incluso la muerte si 
el personal está en la zona restringida.
Asegúrese que no haya personal en la zona restringida antes de 
operar el equipo.
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INTRODUCTION

Introduction to the Manual

In order for this manual to be useful, the appropriate sections must be easily 
accessible by operators and maintenance personnel.

This manual addresses the most recent version of the equipment as of the date 
listed on the title page. For earlier revisions, contact MiTek as described on 
page 46.

! WARNING
Read this manual completely before using this equipment. 
Do not operate this equipment until you have a thorough 
understanding of all controls, safety devices, emergency stops, 
and operating procedures outlined in this manual.
All hazard instructions must be read and observed. Failure to do 
so may result in economic loss, property damage, and/or 
personal injury.
This manual must always be available to personnel.
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Understanding the Manual

Hyperlinks

All text references colored blue (in form of page numbers, headings, etc.) can 
be selected to immediately take you to the relevant section.

The Drawing Set

A list of drawings can be found in the back of this equipment manual or in a 
separate 11x17 binder.

Navigational Aids

The graphics used in Table 3-1 are used throughout the manual to 
communicate a specific type of information quickly.
Table 3-1: Navigational Aids
Graphic Definition

This icon is an important safety note.
It indicates that you must lockout/tagout at the disconnect switch 
located on the equipment using approved methods described in 
OSHA CFR 1910.147 before continuing with the procedure.

This icon specifies that certain tools are needed before a procedure 
begins.

This icon provides additional information to supplement the main 
text.

This icon indicates how to locate additional relevant information or 
resources.
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Operator Training Outline

Subject Training and Related Links

Using the Manual • Show the operator how to access the manual on the 
MiTek website.

Safety • Review the lockout/tagout procedures for all machine 
systems: Lockout/Tagout on page 6.

• Walk the operator through all procedures in the Safety 
Tests section: Safety Tests on page 12.

• Instruct the operator to read the entire Safety chapter 
before operating the machine for the first time: Safety 
(English) on page 1.

Operation • Walk the operator through all procedures in the Safety-
Related Operating Procedures section and make note 
of the location of all E-stops: Safety-Related Operating 
Procedures on page 59.

• Walk the operator through the Operating Procedure 
section: Operating Procedure on page 84.

Maintenance • Walk the operator through the process of replacing a 
saw blade: Saw Blade on page 113.

• Instruct the operator to review the Maintenance chapter 
to learn more about the necessary maintenance to 
keep their machine running optimally: Maintenance on 
page 93. 

• Walk through the Maintenance Checklist with the 
operator. Make note of the daily, weekly, and monthly/
annual task structure and demonstrate how selecting 
the page numbers will take you to the related section: 
Maintenance Checklist on page 211.

https://www.mitek-us.com/resources/machinery/equipment-manuals/
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Additional Resources

Website
Visit the MiTek website for up-to-date information on all MiTek equipment. You 
may also find the following information there:

• The latest revisions of this manual
• Service bulletins pertaining to your equipment
• Support, safety, and training information
• Part numbers for ordering parts

Contact Us
MiTek Automation Support
301 Fountain Lakes Industrial Drive
St. Charles, MO 63301

Parts Orders (with part number)
Email: mitekparts@mii.com

Technical Assistance
Phone: 800-523-3380
Fax: 636-328-9218
machinerysupport@mii.com

Website
mitek-us.com

Videos
Search for “MiTek Inc” to find us on YouTube®.

https://www.mitek-us.com/
https://www.mitek-us.com/
https://www.youtube.com/channel/UCndCqEmeDDlnnoQhWymuGQg
https://www.youtube.com/channel/UCndCqEmeDDlnnoQhWymuGQg
https://www.youtube.com/channel/UCndCqEmeDDlnnoQhWymuGQg
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GENERAL INFORMATION

Introduction to the Equipment

Purpose of the Equipment
The BLADE wood processing system is a fast, accurate, and economical method 
of cutting a wide array of components for wood truss manufacturing. It is capable 
of cutting lumber for virtually all of your roof truss, floor truss, and wall panel 
needs.

Description of the Equipment
The BLADE saw includes the following components:

• The Infeed component takes the lumber, in the correct order, to the infeed 
rail of the saw for cutting. 

• The Saw component contains the board printer, the saw blade itself, and the 
waste conveyor.

• The Outfeed component receives and manages cut parts. 

Aspects of these components can be further customized according to customer 
need. See the following pages for a more detailed overview of the entire system 
and the options available.

Safety Compliance of the Equipment
Equipment shipped to a U.S. destination is compliant NFPA 79, NEC 2009, and 
applicable OSHA regulations.
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Main Components

Graphical Overview

Figure 4-1: Main Components of the BLADE saw

See Optional Components on page 49 for other components not shown here.

Descriptions
Table 4-1 lists the components that are included with the different configurations 
of this equipment 
Table 4-1: Machine Components
Name Description

Infeed Component Your machine will include one of two options determined during 
the ordering process:
• An Auto Deck that transports the lumber (placed there by 

operator) and advances 1 piece at a time for automatic 
loading onto the Infeed Rail (16' and 20' options available).

• An automated Ranger lumber retrieval system that picks the 
correct lumber (without an operator) and delivers it, in order, 
to the Infeed Rail.

Infeed Rail Receives 1 piece of lumber and feeds it into the saw chamber. 
(16' and 20' options available)

Saw Saw component where the printing and cutting occurs. 

Outfeed Component Your machine will include one of the following options 
determined during the ordering process:
• Outfeed table (unpowered) for manual board removal 
• A powered skewed conveyor that arranges boards for 

operator removal (16' and 20' options available).
• A Component Delivery System (CDS) that moves members 

from the saw to the tables without the need for manual 
sorting. The CDS is only offered as part of the DirectDrive 
system. See the Mitek website for more information.

Waste Conveyor Moves waste from the saw to the point of removal. A standard 
and extended size are available.

Skewed
Conveyor

Infeed
Rail

Saw
Operator
Interface

Waste
Conveyor

https://www.mitek-us.com/machinery/matchpoint-directdrive/
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Optional Components
Graphical Overview

Figure 4-2: Auto Deck (Infeed Component)

Figure 4-3: Ranger (Infeed Component)



Original Instructions: 001080 rev. B 50

BLADE SAW: GENERAL INFORMATION

Figure 4-4: Component Delivery System (Outfeed Component)

Descriptions
Table 4-2 lists the optional components that may be added at the point of sale or 
added later as a paid upgrade. Contact MiTek for more information (see Contact 
Us on page 46).
Table 4-2: Optional Saw Components

Additional Printer Options
The BLADE saw can be customized to use a number of different printer 
configurations. Note that the printer hardware in earlier machine models may 
need to be upgraded to support all options listed in Table 4-3.

Name Description

Additional print heads
(up to 3 total)

The standard saw comes with one front face printer. You may 
also purchase or upgrade to an additional rear face printer and 
edge printer. See for more information on printing options.

AGS+ Assembly Guide System; prints joint and component locations 
and plates. Requires printer option E or F.

Incline waste conveyor Works with the saw waste conveyor to move waste up an incline 
to reach the top of a dumpster.

Second monitor Allows a second monitor for displaying truss/part data and 
production metrics. See Second Display Support on page 
51.

Transformer for 
voltages other than 
230 volt.

If the site voltage is anything other than 230 volts, a transformer 
is necessary.
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Table 4-3: BLADE saw Print Head Configurations

Second Display Support
The BLADE saw supports outputting truss/part data and production metrics to a 
second display. When purchasing a monitor for this use, it is highly recommended 
to obtain the specifications listed here:

• Recommended screen size: 65"
• Supported screen resolution: 1920x1080
• Ports required: HDMI

Dust Extraction Methods
One port is provided for dust extraction from the saw chamber. We recommend 
working with a location dust extraction method to find a solution that meets the 
following criteria:

Airflow rate: 2100 scfm

Technical Specifications
Table 4-4: General Specifications 

Option Description Valve Configuruation

A Standard with every saw. 1 print head prints 
standard print fields (text) on front face.

16 Front

B Uses 2 print heads to print standard print fields, 
joint and plate information, and joint alignment 
marks all on the face-up side of boards.

16 Front / 7 Rear

C Same as A, plus a 2nd print head to print on the 
top edge of boards.

16 Front / 7 Edge

D Same as B, plus a 3rd print head to print on the 
top edge of boards.

16 Front / 7 Rear / 7 
Edge

E AGS+: Uses 2 print heads to print everything in 
B, plus plate outlines in correct location, and 
basic graphics all on the face-up side of boards.

32 Front / 32 Rear

F AGS+: Same as E, plus a 3rd print head to print 
on the edge of boards.

32 Front / 32 Rear / 7 
Edge

Specification Data

Saw Blade 432 mm diameter (17'')

Accuracy of each axis 1/32" and 0.1 degree

Printer 16 valves, front face (see Additional 
Printer Options on page 50)
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Table 4-5: Lumber and Cut Capacity

Table 4-6: Motor Specifications

Table 4-7: Pneumatic Specifications

Table 4-8: Electrical Specifications

Table 4-9: Dimensional Specifications

Specification Data

Edge of board 1-3/8"  to 1-5/8" 

Face of board 2-1/2" to 11-7/8"

Maximum length of board 16' ( 20' option available)

Shortest length to exit saw chamber 2"

Shortest length to enter saw via Auto Deck 6' (option available for shorter)

Min. or max. length of cut infinite

Number of angle cuts infinite

Specification Data

Saw blade 5 hp, 4200 rpm

Waste conveyor and lumber exit chain .5 hp

Skewed Conveyor 1 hp

Auto Deck 1 hp

Specification Data

Air source tank (if needed) 60 gallons minimum

Volume 73 scfm at 110 psi

Specification Data

Voltage (VAC) 230 VAC (other voltages require 
transformer)

FLA plus controls (amps) 67

Disconnect switch fuses (amps) 100

Cycles (Hz) 60

Phases 3

Specification Data

Saw 6' 10" L x 8' W x 6' 5 1/2" 

System: Saw, 16' Infeed Rail, 10' deep Auto 
Deck, 20' Skewed Conveyor

42' 10" L x 18' 5" W x 6' 5 1/2"

System: Saw, 20' Infeed Rail, 10' deep Auto 
Deck, 20' Skewed Conveyor

51' 10" L x 18' 5" W x 6' 5 1/2"
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Table 4-10: Weight Specifications

Table 4-11: Environmental Requirements

Specification Data

Saw 8,000 lbs

Infeed rail - 16' 1360 lbs

Infeed rail - 20' 1600 lbs

Skewed Conveyor - 16' 900 lbs

Skewed Conveyor - 20' 1100 lbs

Operating temperature 40 to 122 degrees Fahrenheit 
(4 to 50 degrees Celsius).

Relative humidity 45 to 85 percent humidity

Transportation and storage -13 to 158 degrees Fahrenheit 
(-25 to 70 degrees Celsius). 

It has been packaged to prevent damage 
from the effects of normal humidity, 
vibration, and shock

Environment for scanners must be: Free of rain, fog, mist, sand, and bright 
sunlight
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INSTALLATION & STARTUP

Requirements to Meet for Installation
Refer to your original Pre-Installation document for all requirements that must be 
met before or during installation.

Refer to the General chapter for machine specifications and requirements.

Moving the Equipment Into Place
Follow these guidelines to safely move this equipment with a forklift or crane.

Transportation Equipment Requirements
The forklift, crane, chains, clevises, and all moving equipment must be rated for 
150% of the weights listed on Technical Specifications on page 51 to abide by 
general safety rules.

Lift Points for Forklift

Infeed Rail

Figure 5-1: Infeed Rail Lift Points

Covers in Place

Covers Removed
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Saw Chamber

Figure 5-2: Saw Chamber Lift Points

Skewed Conveyor

The skewed conveyor does not include dedicated lift points. MiTek recommends 
using two forklifts to lift the skewed conveyor at the points shown in Figure 5-3. 
Lifting the skewed conveyor with a single fork lift may result in damage to the 
conveyor.

Figure 5-3: Skewed Conveyor Lift Points

Lift Point 1 Lift Point 2
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Auto Deck

Depending on length, an Auto Deck is shipped in 2 to 3 sections. To lift a section, 
place forklift forks under the bottom, flat surface. Ensure the forks cover as much 
of a section as possible.

Figure 5-4: Auto Deck Lift Points

Your Responsibilities

During Installation
MiTek supervises the installation to ensure that the system is installed properly 
and operates correctly. MiTek will also provide operating and maintenance training 
at the time the equipment is installed. The customer is responsible for providing all 
labor and equipment needed to complete the installation.

Before Selling or Re-Installing
If you determine that you want to move your equipment to another location or you 
want to sell your system to another company, refer to the Pre-Installation 
document received when you first purchased this equipment. If you need another 
copy of that document, request it from MiTek.

! WARNING

Moving the system without proper planning may result in 
equipment damage or serious injury.
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Startup Procedures
Before operating your new equipment for the first time, perform these procedures.

Marking Restricted Zone
The restricted zone must be marked and maintained so everyone near the 
equipment can clearly see the area where danger may exist. The customer is 
responsible for marking the restricted zone prior to startup, and maintaining the 
markings so it is clearly visible throughout the life of the machine.

Your equipment arrived with Service Bulletin SB181, which includes restricted 
zone tape and instructions for installing it. Additional restricted zone kits can be 
ordered as needed using the contact information found on Ordering Parts on page 
216.

Safety Tests
Perform all tests listed in Safety Tests on page 12.

! WARNING
Do NOT attempt to start the system for the first time without a 
MiTek representative present. 
Starting the system without a MiTek representative present may 
result in equipment damage, serious injury, and/or death.



CHAPTER 6

Original Instructions: 001080 rev. B 58

OPERATION

Safety Operating Notes

! WARNING
ELECTROCUTION, HIGH PRESSURE, CRUSH, CUT, AND 
CHEMICAL HAZARDS.
Read this section AND the safety section in the preliminary pages 
before operating or maintaining this machine.
Do not operate this machine until you have a thorough 
understanding of all controls, safety devices, E-stops, and 
operating procedures outlined in this manual.
Read and observe all warnings. Failure to do so may result in 
economic loss, property damage, and/or personal injury.
This manual must always be available to personnel operating and 
maintaining this machine.

! WARNING
CRUSH AND CUT HAZARD.
Before turning on the machine, make sure that all personnel and 
other machines are out of the restricted zone (see Marking the 
Restricted Zone on page 17).

! WARNING
Do not operate this machine unless all guards and safety devices 
are in place.
Only qualified maintenance personnel shall repair, remove, or 
replace guards and safety devices.
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Safety-Related Operating Procedures

Stopping Methods
This BLADE saw may be stopped by using a cycle stop or an emergency stop (E-
stop). Engaging an E-stop will stop all movement on the Auto Deck, infeed rail, 
saw component, and skewed conveyor. It does NOT include other material 
handling systems, even those supplied by MiTek.

A cycle stop may be slower than an E-stop, but a cycle stop is the preferred 
stopping method unless there is a safety emergency. Using an E-stop to stop the 
machine regularly causes excessive wear on components.

Cycle Stop

To initiate a cycle stop on this machine, select STOP CUTTING from the software 
tool bar (see Figure 6-12). This will stop the auto cutting sequence and turn off the 
saw blade motor after the last cut on the active board is complete.

Emergency Stop

There are 5-6 E-stops (depending on equipment configuration) located on the 
main components of the BLADE saw.

! CAUTION
CRUSH HAZARD.
When an E-stop is released, the load arms on the Infeed Rail 
may automatically raise with high force.
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Figure 6-1: E-Stops on Saw, Infeed Rail, and Auto Deck

Optional equipment may have an E-stop that is or is not integrated with the system.
Each site must post signage to inform operators if this condition exists.

Infeed Rail
Pull-Cord

Auto Deck
Control Station

(may not be present in 
optional lumber feed system)

Pushbutton

Pushbutton Pushbutton
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Figure 6-2: Typical E-Stop Locations on Optional Skewed Conveyor

How to Operate an E-Stop Pushbutton

How to Operate a Pull-Cord E-Stop (Perimeter Safety Cable)

A pull-cord is an E-stop that has a cord that can be pulled anywhere along its 
length.

Once a pull-cord is pulled, the red light on the pull-cord switch illuminates. Reset 
the E-stop by turning the blue Reset button, located on the pull-cord switch, in the 
direction of the arrow (see Figure 6-3).

See Adjusting the Pull-Cord Tension on page 175 for instructions to adjust the 
tension of the pull-cord cable.

Location of the E-stops on the 
Powered Skewed Conveyor may vary
depending on system configuration.

To activate a 
pushbutton, push the 
button in. The machine 
no longer operates. 

To release a 
pushbutton, twist the 
pushbutton (left) or pull 
the pushbutton to 
release (right).



Original Instructions: 001080 rev. B 62

BLADE SAW: OPERATION

Figure 6-3: Pull-Cord Switch With Reset Button

Restart After E-Stop Procedure

1. Release all activated E-stops.
• A list of which E-stops need to be released is shown by selecting the 

Doors/E-Stops indicator on the home screen.

2. Press the blue RESET button on the operator interface panel (see 
Figure 6-9).

3. Resume normal operation. See Operating Procedure Overview (Auto 
Mode) on page 84.

Reset
Button

Illuminates
When Reset

is Needed
(if equipped)

E-Stop Pushbutton
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Disconnect Switch
There are disconnect switches located on the main components of the BLADE 
saw.

Figure 6-4: Everything You Need to Know About Disconnect Switches

! WARNING
Always turn off power at the main power source before opening the 
electrical enclosure.
Even when the disconnect switch is turned to the Off position, there is 
still live power to the enclosure where the disconnect switch is 
mounted. This live power may cause severe electric shock.

Electrical Enclosure 
Disconnect Switch

Skewed Conveyor 
Disconnect Switch

Auto Deck 
Disconnect Switch

Turning the disconnect handle to 
the On position supplies electrical 
power to the entire machine. To 
remove power to the machine, turn 
the disconnect handle to the Off 
position. The disconnect handle 
should be turned off when the 
machine is not in use
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Interlocked Doors or Guards

The saw chamber and stroke/elevation chamber both have door switches that are 
interlocked with the electrical system to stop the appropriate movement before the 
door is opened.

Saw Chamber Door Switch

The saw chamber door is on the front of the machine and encloses the saw blade. 
Lights on the saw’s operator interface panel indicate if the blade is moving or 
stopped. When the blade stops, the Blade Stopped light illuminates, and the door 
can be opened. Refer to Figure 6-5 on page 65 and this procedure to open the 
door.

1. Stop the saw blade motion by pressing the STOP button. 

2. Wait for the Blade Motion Stopped light to illuminate.

3. Press the request-to-unlock button and hold it in while pulling open the 
door.

Stroke/Elevation Chamber Door Switch

The stroke/elevation chamber door is located on the left side of the saw. The door 
can only be opened when all axes are without movement. The release of the 
stroke/elevation chamber door switch shuts down the stroke and elevation servo 
motors. There are no indicator lights. Refer to Figure 6-5 on page 65 and the 
following procedure to open the door.

1. Unlatch the mechanical latches.

2. Press the request-to-unlock button and hold it in while pulling open the 
door.

! CAUTION
NEVER TOUCH A MOVING SAW BLADE!
The saw blade may still have slight coasting motion when the 
interlocked doors are allowed to open.

The RESET button must be pressed after 
using an E-stop pushbutton or pull-cord.

None of the servo 
axes can move 
when either door 
is open.

DOOR 
OPENING TIP!
You may need to 
push the door in 
to relieve 
pressure before 
pulling the door 
open, all while 
simultaneously 
pressing the 
Request to 
Unlock button.
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Figure 6-5: Interlocked Door Switch Locations

The keyholes in the stroke/elevation door lock and the saw chamber door lock are 
intended for maintenance personnel to override the door interlock for emergency or 
troubleshooting purposes only. Using the key allows the door to open without electrical 
power. The maintenance office should store the key in a safe and secure location. Two 
keys for each door (total of 4 keys) were delivered during installation or startup.

Interlocked
Door Switch

Mechanical
Latch

Request-to-unlock Button

Saw
Chamber
Door

Stroke/Elevation
Chamber Door

Request-to-unlock Button
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Maintenance Doors

There are a variety of maintenance doors located on this equipment. These doors 
are NOT tied into the electrical system. Live power is still present to allow the 
following components to be moved when needed:

Safety-Related Indicators on the Machine
This section covers visual and audio indicators that communicate important 
information about the status of the machine.

Light and Horn Beacon

The beacon and horn is located on top of the 
machine’s main electrical enclosure. It indicates 
the following:

Red: A fault exists. The machine software 
will communicate what the fault is and what 
the next step should be. Some faults allow 
the system to continue cutting, other shut 
down all movement.

Yellow (flashing): The system is waiting for 
one of the following actions to occur:

• The Auto Deck to place a board on the 
Infeed Rail.

• The printer trigger to be turned on.
• The CLS to complete its reading

Green: System is operable and is in Auto Mode with no active faults.

The horn notifies the operator of errors and faults when in Auto Mode. The sound 
continues until the operator does one of the following:

• Acknowledge the error/fault on the HMI screen
• Turns the saw to Manual Mode
• Activates an E-stop

Figure 6-7: Horn and Light Beacon on Top of the Saw

• Gripper clamp • LASM clamp • Top clamp
• Side clamp • Outfeed clamp •

Figure 6-6: Light and Horn 
Beacon on Main Enclosure

Horn Beacon
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Operator Interface Indicator Lights

The lights located on the 
operator interface indicate the 
following:

BLADE IN MOTION: Red 
light turns on when the 
blade is spinning. Certain 
doors can not be opened 
while this light is on.

BLADE STOPPED: Green 
light turns on when the 
blade is not spinning. This 
light must be on for certain 
doors to be opened

E-STOP: Red light turns 
on when an E-stop is 
activated. This light must 
be off before the machine 
can operate.

RESET: Blue light turns on 
after the machine is first 
powered on, an E-stop is 
active, or a door is open.

The layout and number of indicator lights on the operator interface may vary on earlier 
machine models.

Figure 6-8: Operator Interface Indicator Lights
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Hardware Overview

Operator Hardware Controls
This section describes the hardware controls available to an operator in a 
complete system.

Operator Interface 

Figure 6-9: Operator Interface Controls

Table 6-1: Description of Operator Interface Controls
Name Function

E-stop Stops all movement on the entire BLADE.

Start Starts the blade motor

Stop Stops the blade motor (Manual Mode)

Pause

StopStart

Reset

Manual Auto

E-stop
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Skewed Conveyor

To turn the Skewed Conveyor on or off, turn the selector switch to either the STOP 
or START position and release the switch. It is a spring-return switch, so it will 
always return to center when released.

Figure 6-10: Skewed Conveyor Controls 

Reset Restores the safety controller and re-enables main power to the 
system.

Pause Pause the cutting process after completing the current cut.

Mode Switches between Auto and Manual Modes using a 2-position 
switch

USB Ports Can be used to connect a mouse or keyboard or other USB 
devices

If a BLADE saw has been modified with SB259 (Skewed Conveyor Automatic Startup 
Conversion), the Skewed Conveyor will automatically start running when a cutting job 
has been initiated.

Name Function
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Auto Deck

The Auto Deck operation is integrated within the machine software in Auto Mode, 
but manual operation occurs at the control station pedestal shown in Figure 6-11.

Figure 6-11: Auto Deck Controls

Table 6-2: Description of Auto Deck Controls

Powering Up or Down

Daily Startup

1. Rotate the saw’s disconnect switch to the ON position.

2. Rotate the disconnect switch for the Auto Deck or other lumber feed or 
outfeed system to the ON position

Name Function

E-stop Stops all movement on the entire BLADE.

Forward/Reverse 
(Deck Direction)

Controls which direction the Auto Deck staging conveyor chains 
run.

Raise/Lower 
(Lumber Stops)

Controls the lumber stops.The lumber stops serve two 
purposes:

• To separate two different jobs that may be on the Auto 
Deck staging conveyor at the same time. 

• To create space within a job to reduce the amount of 
pressure or clutter near the load arms, especially when 
using a mixture of lumber lengths.

Foot Pedal Press down and hold down to cause chain to travel. Load arms 
must be up for forward travel. See Preparing the Auto Deck.



Original Instructions: 001080 rev. B 71

BLADE SAW: OPERATION

3. Start the skewed conveyor (see Skewed Conveyor on page 69).

4. Double-click the BLADE software icon and wait for it to launch.

5. Press the blue RESET button on the operator interface.
• The blue light goes out if all E-stops are cleared. If the RESET button 

light stays lit, determine which E-stop is activated and reset it (see 
Emergency Stop on page 59).

Daily Shutdown

1. Select the machine software Exit icon on the ribbon menu and select Yes 
to verify.

2. Shut down the computer using the Power > Shut down method in 
Windows.

3. After the computer powers down, rotate the saw’s disconnect switch to the 
OFF position.

4. Turn off the skewed conveyor (see Skewed Conveyor on page 69).

5. Rotate the disconnect switch for the Auto Deck or other lumber feed or 
outfeed system (if equipped) to the OFF position.
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Software Overview
This section covers the BLADE saw software that is accessible through the 
operator interface. This software controls all of the main components that form the 
complete wood processing system. Other software (such as Board Stretcher) that 
also impacts the production process may be operated remotely. 

The BLADE saw operator interface is designed as a touch first device but it can 
also be used with a mouse and keyboard. See below for a list of terms that will be 
used throughout the manual and their mouse equivalents:

Select: 
• 1 tap on the screen 
• 1 left mouse click

Double-tap: 
• 2 quick taps on the screen 
• 2 quick left mouse clicks

Long-press: 
• 1 long press on the screen
• 1 right mouse click

Overview of Home Screen
The home screen shows data for each part to be cut and provides access to all of 
the functionality required during normal production use. Figure 6-12 shows each 
section of the home screen.

Figure 6-12: Home Screen Sections

Main Menu

Ribbon

Cut List

Status Banner

Status Indicators

Toolbar

Login Name & Permission Level

Online Support
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Main Menu and Ribbon

The main menu refers to the selections at the top of the home screen. As shown 
in Figure 6-12, the functions within each main menu appear in the ribbon. See 
Main Menus in Detail on page 80 for a detailed description of each main menu 
and ribbon.

Online Support

This link will take you direct to the machine support page. Visit this site for links to 
the online version of this manual, video guides, and troubleshooting and trainer 
resources.

Status Indicators

The status indicators are shown in Figure 6-12. Table 6-3 gives a brief overview of 
each status indicator’s purpose. If any status indicator is red, that component is 
not ready. To determine why a status indicator is lit or a component is not ready, 
select the indicator to display a second menu or additional data. 
Table 6-3: Status Indicators on Home Screen
Name Description

Status Banner Status bar directly above the cut list window that displays one of 
the following, depending on the overall saw status: Not Ready, 
Ready, Clearing Saw, Active, Press Reset

Angle Servo axis; turns the blade for angle cuts

Bevel Servo axis; turns the blade for bevel cuts

Elevation Servo axis; raises and lowers the blade assembly

Gripper Servo axis; moves the gripper on the infeed rail

LASM Servo axis; moves the LASM assembly that carries the boards 
through the saw chamber

Stroke Servo axis; moves the blade forward/backward (in/out)

Clamps Side clamp and top clamp on infeed side of saw

Load Arms Load arms, located on Infeed Rail

Infeed Rail Infeed Rail, including gripper

Doors/E-Stops Indicates if saw chamber door and stroke/elevation door are 
closed and locked and all E-stops released

Auto Deck or Ranger 
RS

The lumber feed system

Blade Saw blade rotation

Printer The printer(s), located on infeed end of saw

Outfeed Outfeed clamp and lumber exit chain

CDS (if present) Provides diagnostic information about the Component Delivery 
System (CDS) if present

Waste The integrated waste conveyor
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Toolbar

The Toolbar stays active at all times on the Home Screen. Some buttons may 
change function or become unavailable (greyed out) due to the status of the saw.
Table 6-4: Toolbar Buttons

Lumber Yard
The Lumber Yard is where the operator can see the lumber required for the active 
job, and assign specific lumber to specific stations in the lumber feed system. See 
below for important terminology for understanding the functioning of this aspect of 
the machine software:

• lumber: a group of boards or a non-specific board

Machine Shows errors found in the Machine tab under Diagnostics > 
Detailed Diagnostics, including E-stops, and Auto/Manual 
Mode switch. Additional troubleshooting must be done using 
Diagnostics which requires administrative permissions.

Name Description

Start (Auto Mode)

START begins feeding lumber into the saw chamber and 
cutting. Saw motor must be turned on manually first. The button 
turns to STOP while saw is actively cutting.

STOP (appears when cutting) stops the auto cutting sequence 
AND turns off the saw blade motor after the last cut on the 
active board is complete.

Home System (Manual 
Mode)

Places all axes in their home positions.

Clear Cutlist & Import Imports a new job file and clears previous jobs out of the job 
queue. To import jobs without deleting previous jobs, go to 
File > Import Jobs.

Lumber Yard See Lumber Yard on page 74 for more details.

Manual Boards List Displays the boards required for this job.

Key In Part Allows parts to be added to the Cut List or remainders list. See 
Key In Part on page 75.

Clear Board Queue Erases the record of what the infeed system already has in 
queue (usually the next 1-4 boards to be cut).

Non-Productive Allows the operator to indicate what the saw is doing when it’s 
not running. See Recording Non-Productive Time on page 89.

Board Length Indicates the length of the board needed to make the planned 
cuts, and the actual length of the active board. The actual board 
must be equal to or longer than the board needed.

CLS Status Indicates the lumber crookedness measured by the CLS.

Clear Errors Clears all software errors and allows the saw to continue 
running (if safe).

Name Description

For additional 
details on how to 
use the Lumber 
Yard, refer to the 
Board Stretcher 
Training Manual.
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• board: a specific piece of lumber required by the saw to cut out specific 
parts; lumber becomes a board when the software decides exactly how to 
use it

• infeed component: any component that feeds lumber to the Infeed Rail; 
usually the Auto Deck staging conveyor or the Ranger

• station: a physical location on a lumber retrieval system

Figure 6-13: Lumber Yard Screen

The bottom half of the screen is the Lumber Inventory. It is a list of the previously 
used lumber used to be delivered by the lumber feed system for the active job. 

The top half of the screen is the Required Lumber. It shows lumber required for 
the job by the lumber feed system.

1. To assign a Required Lumber to a specific spot in the Lumber Inventory, 
just drag it down and drop it on the desired station.
• For a manually loaded lumber feed system, such as the Auto Deck, the 

software views all lumber as manual and it doesn’t matter what device 
ID each lumber type has. There is no need to make specific 
assignments.

• For automated feed systems, the virtual lumber must be assigned to the 
station where the actual lumber is located.

2. To change a lumber assignment, select the CLEAR button in the row of the 
assigned lumber inventory.

3. To choose the number of Lumber Inventory rows displayed, go to Tools > 
Options > Material Handling.

Key In Part
Selecting The Key In Parts buttons displays the part Key In dialog and allows 
parts to be added to the Cut List or remainders list.

To add 
remainders from 
parts in the Cut 
List, right-click on 
the part.
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The Key In Select screen shown in Figure 6-14 contains specific part types to 
choose from. Double-click the part type that looks most like the part that needs to 
be cut.

• The next window displays a list of possible places to get the lumber from. If 
using an Auto Deck, there will not be a choice of how to load the board.

Figure 6-14: Key In Part Select Screen

The Key-In screen, which opens after selecting a part, allows the operator to enter 
the details of the part (see Figure 6-15).

• If using a lumber feed system that allows stations to be chosen, the Grade, 
Stock Size, and Stock Length will be populated for boards being loaded from 
a station.

• If a manual board is selected, the operator populates the following fields: 
Lumber Grade, Stock Size, Overall Length, Stock Length, Chord, and 
Crown.
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Figure 6-15: Key In Part Screen

Most fields in the Key-In screen are populated according to the part you chose on 
the Key-In Select screen, but many of the fields can be modified, including adding 
a bevel.

If entering dimensions, one of the cuts must be calculated to ensure correct 
cutting of the part.

Other functions include:
• Validate and Draw Part updates the part based on the information entered.
• Add to add the part to the Remainder or Cut List.
• Rip Bevel allows the operator to set the short side to a specific dimension in 

order to create specifically-sized blocks or boards that are not in a Job file.

Cut List Screen

Cut List Column Headings

Table 6-5 gives a brief description of each column’s purpose. More detail is given in 
subsequent pages.

Figure 6-16: Cut List Column Headings

Table 6-5: Cut List Column Heading Descriptions
Name Description

Board The index of the board (the identity or order of the board in that 
job).
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Long-Press Menu From Cut List

When a board is first selected and then long-pressed in the Cut List, most of the 
choices in Table 6-6 are available. When a part is long-pressed, fewer choices are 
available.

Table 6-6: Cut List Long-Press Menu Descriptions

File For boards, it is the name of the file that the boards were 
imported from. For parts, it is the order that the part will be cut 
in.

Graphic Displays an image of the cut part.

RB/EB Signifies that there is a rip bevel (RB) or end bevel (EB) on the 
board.

Status • Complete: The board or part has been cut.
• In Process: The part is being cut.
• Queue: The part is loaded onto the load arms located 

on the Infeed Rail.
• Rejected: The part will not be cut.
• Infeed: A board in the job that has not been processed.

Source/
Job-Truss-Desc.

For boards, it is where the board will be loaded from. For parts, 
it shows the job name, truss description, and part description

Grade Grade of board

Size Board dimensions. For example: 2x4 (for Imperial units), or 
width of the board in millimeters (for metric)

Length Length of board and overall length of the parts.

Select Board Arrow Select the arrow to choose Current Board, Top of List, or Bottom 
of List.

Name Description

Start Cutting Here Skips previous boards in the Cut List and begins cutting with the 
selected board.

Cut (Auto Mode) Use to cut a single board. Procedure is on Cutting 1 Board on 
page 86.

Redo Cuts the selected board or part again. The stock length is 
chosen in the Redo window but must be adequate length.

Reject Rejects the current board so it will not be cut. A rejected line is 
highlighted in red and moved toward the top of the Cut List.

Reject Series Rejects a series of boards listed consecutively in the Cut List as 
chosen by the operator. See Rejecting or Resetting Jobs and 
Boards for selecting a series.

Name Description
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Reset Resets the current board so it can be re-cut.

Reset Series Resets a series of boards listed consecutively in the Cut List as 
chosen by the operator. See Rejecting or Resetting Jobs and 
Boards for selecting a series.

Add To Queue Adds the current board to the material handling queue.

Remove From Queue Removes the current board from the material handling queue.

Add to Remainders Only available when a part is selected (not a board).
Add the selected part to the Remainders list. See Adding 
Remainders to view the Remainders list.

Name Description
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Main Menus in Detail

File Menu

Diagnostics

• Import Jobs: Allows files to be imported to Cut List. The different 
network options are customizable default folders for 
common job file directories (see Figure 6-17). Use 
Get Files to browse to a specific location if needed.

Figure 6-17: Import Jobs Screen

The address to the default folders can be changed in 
Tools >Options > File Import with Administrator or 
Technician permission levels.

• Jobs Stats/Delete: Allows parts to be deleted from Cut List.

• Log In: Only required if site management sets it up in Tools > 
Options or if needing technical or administrative 
permissions.

• Log Out: Can alternate between operator, technical, or 
administrator level permissions by logging out the 
current user. Log back in using the Log In button.

• Exit: Exits the program.

Abort Cutting 
Sequence:

Cancels current cutting sequence. After cancellation, 
the software asks how to handle the board that was 
just active. Use if the saw becomes unresponsive due 
to PLC miscommunication.
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Visualize: Displays an image of the saw components and active 
board at any point in time. The image changes as the 
position of the components move.

Logs: Allows detailed information of each part or board to be 
displayed, including print information.

Detailed 
Diagnostics:

Brings up a set of tabbed menus for specific 
components.

The data here can be viewed by anyone, but 
administrator or technician permissions is needed to 
change some fields.

Air Cut: For troubleshooting purposes; tells the system to 
function even though the sensors are not detecting 
boards to cut. Automated feed systems are not 
included in the operation during Air Cut.

Click on the checkbox to turn on or off. Places a 
yellow Air Cut band across the START button when 
the feature is on.
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Material Handling

Tools

Help

View Remainders: Shows the remainder list and allows the operator to 
manage the list and the options for each part. To add 
a new remainder part, see Managing Remainders.

Reset Unprocessed 
Boards:

Reset all boards in the active job so the job can be 
started over or skipped.

An operator may reset specific boards (using long-
press menu) after resetting or rejecting all boards

Reject Unprocessed 
Boards

Rejects all boards in the active job so the job can be 
started over or skipped.

An operator may reject specific boards (using long-
press menu) after resetting or rejecting all boards.

Pick List Displays a list of boards necessary to process the 
current job. It is grouped by grade and size.

To view the boards in the order they will be cut, use 
the Manual Boards List button on the Toolbar.

Pre-Calibration 
Boards:

Use specific boards and cuts to aid in calibration.

Calibrate: Allows the servos, printer, and CLS to be auto-
calibrated.

Options: Contains option sub-menus for various aspects of the 
machine.

Configuration: Advanced function to change configuration items. 
Should not be used under normal circumstances

Plant: Allows the company information to be entered which 
auto-fills some fields when contacting technical 
support through the Help Menu

Current Shift 
Reports:

Provides production data, board usage, and non-
productive time data per shift.

View Help: Opens the help procedure tool. Start a procedure a 
follow the on-screen instructions.
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Quick Software Troubleshooting
Additional information can be found in Troubleshooting on page 185 and on the 
MiTek website, but the most common operator interface problems can be solved 
by following the instructions here. Specifically, if a button or field is grayed out or 
not available, try these steps first.

1. Read the software status banner for information about the status of the 
saw. If the solution is not clear from the status banner text, continue this 
procedure. The most common status clues that will quickly solve the 
problem are:
• Emergency Stop: Locate and disengage the active E-stop.
• Press E-Stop Reset: Press the blue RESET button on the operator 

interface.

2. Check that saw is in the correct mode using the selector switch on the 
operator interface.

3. Press CLEAR ERRORS on the Toolbar.

4. Press HOME SYSTEM on the Toolbar.

5. Determine if Admin or Tech permissions are required and log in as such.

6. Check for active E-stops and release them. Then press RESET.

7. Check that AIR CUT is not active (yellow banner across START CUTTING 
button).

Board Stretcher Software
For instructions on using our optimization software, see the Board Stretcher 
manual on the MiTek website.

Remote Support: Links to a web site where MiTek can remotely 
troubleshoot. MiTek must provide login information 
before using this site.

Contact Us: Opens the send error tool.

Email Troubleshooting 
Data:

Opens the Email Troubleshooting Data tool. Fill in all 
fields to ensure useful troubleshooting reports.

About: Displays the BLADE software version number and 
backup and renew functionality.

https://www.mitek-us.com/resources/machinery/equipment-manuals/
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Operating Procedure
This section instructs operators how to effectively use the BLADE saw. This 
machine offers two operating modes (AUTO and MANUAL) but it is designed be 
used in AUTO mode for standard production. MANUAL mode may be required for 
troubleshooting, performing maintenance, or changing software settings.

Operating Procedure Overview (Auto Mode)
Table 6-7: Operating Procedure Summary
Step # Summary Steps See Section

1 Power on all system components (saw, infeed, and 
outfeed systems).

Daily Startup on 
page 70

2 Press the blue RESET button on the operator interface. Operator Interface 
on page 68 

3 Setup the lumber feed system with the correct lumber. Preparing the Auto 
Deck on page 85 

4 Select Home System on toolbar to home system. Toolbar on page 
74

5 Import the correct job files. Importing Job Files 
on page 86

6 Verify the saw is in Auto Mode and press Start to start 
the saw blade motor.

Operator Interface 
on page 68

7 Select Start on the toolbar to begin cutting a job. Toolbar on page 
74

9 Depending on the scenario, use one of the following 
methods to stop the saw:

• Select Stop in the software toolbar to stop after 
the current board is finished (same button used 
to start cutting).

• Select Diagnostics > Abort Cutting Sequence 
in the software main menu

• Press the hardware Pause button on the saw’s 
operator interface panel to pause the saw after 
the current cut is complete.

• In Manual Mode, press the hardware Stop button 
on the saw’s operator interface panel.

• For emergency situations, activate any E-stop 
that is integrated with the system.

Stopping Methods 
on page 59
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Specialized Operating Procedures

Preparing the Auto Deck

1. Ensure all E-stops have been released and the RESET button on the 
saw’s operator interface panel was pressed.

2. Raise either the load arms or the lumber stops:
• If the Auto Deck conveyor is empty of lumber and no job is currently 

running, place the load arms in the Up position by selecting Load Arms 
on the toolbar.

• If there is still lumber on the Auto Deck conveyor to be used in the 
previous job, raise the pneumatic lumber stops to keep the two jobs 
separate from each other. Do so by turning the selector switch on the 
Auto Deck controls to RAISE.

3. Place the lumber on the Auto Deck in a single layer with the end of each 
board against the Auto Deck fence (on the infeed side). 

4. Boards must be placed on their face (4x dimension of a 2x4) in the order 
they will be cut. See Figure 6-18 for a diagram of board configuration and 
proper alignment.

5. The lumber will automatically be forwarded and loaded onto the saw’s 
Infeed Rail after selecting Start on the touch screen.

Figure 6-18: How to Place Boards on the Auto Deck

! CAUTION
CRUSH HAZARD.
When an E-stop is released, the load arms on the Infeed Rail 
may automatically raise with high force.

Board 
Stretcher 
optimization 
software is 
used to 
manage the 
order of the 
cuts.

Auto Deck (front side)

Saw

Warp

Crown

Lumber view shown from front side of Auto Deck.

Wane

curves up

curves toward front side

wane toward saw



Original Instructions: 001080 rev. B 86

BLADE SAW: OPERATION

Dealing with Imperfections

• Crown: a curve of the edge of a board (1-1/2” edge on a 2x4); the crown 
points up on floor studs or out for wall studs in constructed homes; place 
board so crown points up as it enters saw

• Wane: a defect in a board where a portion of the wood is missing from 
the board edge or face; place toward saw-end of conveyor

• Warp/Twist: a curve where the face of a board (3-1/2” side on a 2x4) is 
higher or lower in one spot than on the rest of the board; place board so 
warp points up when sitting on Auto Deck

• Replace Poor Quality Boards: if a board diplays excessive defects in 
the above areas, it should be discarded and replaced with a different 
board

Importing Job Files

After jobs are processed through Board Stretcher, the optimization software, they 
are stored in the input location (see Board Stretcher Software) until the saw 
operator is ready for them.

1. Import the job using one of these methods:
a) To import a job and clear the previous Cut Lists, select the Clear Cutlist 

& Import button on the toolbar.
b) To import a job without clearing the Cut List, select File (in tabbed 

menus at top of Home Screen) and select the Import Jobs button.

2. Review the lumber assignments and make sure boards are assigned to 
the correct locations:
a) Select the Lumber Yard button shown in the toolbar (you may also 

have the opportunity to go to the Lumber Yard directly from the Import 
Jobs screen).

The lumber the saw needs is listed in the top section. The lumber 
existing in inventory (in the machine software) is listed in the bottom 
section.

b) Select on the lumber in the top section and drag it to the appropriate 
inventory in the bottom section.

c) Select OK.

Cutting 1 Board

1. Place the Mode selector switch in Auto Mode.

2. Start the blade motor.

3. Select the board in the Cut List.

4. Long-press and select Cut. 
• A message appears asking the user to drop the selected board into the 

Infeed Rail.
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5. Select the Continue button and the board feeds into the saw chamber for 
cutting.

Operating the Printer

The Printer(s) print identification on each board as it enters the saw chamber. 
Each saw has at least 1 printer.

• To turn the Printer off, or back on, go to Tools > Options > Printer and 
check or uncheck Available for use in the BLADE software.

• To choose or change the fields to print, use the Board Stretcher 
software.

• To adjust the location of the image on the board, among other settings, 
calibrate the printer using Tools > Calibrate from the machine software.

• Operators should not modify any values in the Values field (ex: Dot Size 
and Time of Flight) unless instructed by Automation Support.

• For required printer maintenance, see Maintaining the Printer on page 
121.

Figure 6-19: Tools > Options > Printers Menu
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Other Printing Options (Board Stretcher)

The printing features controlled by the BLADE saw software are minimal. Most 
printing control is located in the Board Stretcher software. The following topics are 
discussed further in the Board Stretcher manual. The manual can be accessed on 
the MiTek website.

• Print the PartHighSide arrow to show which end points toward the top of the 
truss.

• Where printing occurs
• What fields print
• How to use the Multi-saw feature
• Much, much more!

Managing Remainders

The saw program can maintain a list of default components or remainders, 
selected by the user, which may be processed from any waste remaining after the 
cutting list has been run through the normal optimizing routine. The remainder 
components are entered and assigned a priority by the saw operator, based on 
the required demand and existing supply of such items.

Adding Remainders

Pre-programmed remainders can be added to the remainders list or to the Cut 
List using the Key In Part button on the toolbar (see Key In Part).

Parts from the Cut List can be added to the remainders list by long-pressing 
the part in the Cut List and selecting Add To Remainders.

Viewing Remainders

After a part is added to the remainders list, it can be viewed and managed 
using the following tasks on the View Remainders screen on the Material 
Handling menu:

• Make each part active or inactive.
• Change the priority of each part in relationship to each other.
• Delete parts from the list (this does not affect the job they came from).
• Indicate if remainders should be cut from leading or trailing end of 

board.

Note that adding remainders may impact overall production due to the added 
cutting time!

https://www.mitek-us.com/resources/machinery/equipment-manuals/
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Figure 6-20: Material Handling > View Remainders Screen

Rejecting or Resetting Jobs and Boards

Individual parts can not be rejected.
• To reject/reset one board, right-click on the board in the Cut List and select 

Reject or Reset.
• To reject/reset a series of boards in the Cut List, select one row, then 

immediately select a lower row. Long-press on the lower row and select 
Reject Series or Reset Series. Everything between and including the two 
rows selected is now either:

• Highlighted and moved to the top of the list if Reject Series was chosen.
• Not highlighted and moved back to their numerical place in the list if 

Reset Series was chosen.
• To reject/reset all the boards in a job, use the buttons in the Material 

Handling ribbon.

Recording Non-Productive Time

The Non-Productive Time section allows the operator to indicate what the saw is 
doing when it’s not running. 

• Break: Indicates operator break
• Error: If an error is received on-screen that 

requires attention, activate this button while 
finding the solution. The error automatically 
populates the window. 

• Maintenance: Indicate time spent on any 
maintenance using this button. Select the most 
accurate category from the drop-down menu.

• Other Delays: For any non-productive time 
that doesn’t fit one of the categories above, 
select this button and type a description of the 
delay.

Figure 6-21: 
Non-Productive Widget 
on Home Screen
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Determining Board Recovery Solutions

Understanding Board 
Recovery

The screen shown in Figure 6-
22 will appear when a board 
has a status of In Process and 
the START CUTTING button is 
selected. It is the result of the 
saw having been stopped in the 
middle of a job. The partially cut 
board will be cleared out of the 
saw chamber automatically 
when the START button is 
pressed. This screen gives the 
operator a chance to tell the 
saw the status of that board. 
Select one of the options shown 
in Figure 6-22 and select OK. 
Each option is defined later in 
this section.

Figure 6-23: Cut List Sample, Shown While Cutting Board 18, Part 1

In Figure 6-23, note the following things while reading the description of each 
board recovery option discussed on subsequent pages.

• Board 2 is in process (already in the saw cutting chamber). When the 
cutting was stopped, Board 2 was not complete, and therefore, will have 
to be cleared out of the saw chamber before the saw can continue 
cutting.

• Board 3 is Queue #1 (already processed by software and sitting on load 
arms to be placed onto the Infeed Rail).

Figure 6-22: Board Recovery Options
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Infeed

Place the new board on the Auto Deck, just behind the load arms, so it is the 
next board to be placed on the Infeed Rail after Queue #1 board (Board 3 in 
Figure 6-23).

Queue 1

Place the new board on the Auto Deck, above the load arms, so it is the next 
board to be placed on the Infeed Rail.

Complete

No more parts are needed from the interrupted board (in the software), so 
don’t manually load anything. The software marks it as complete and moves 
on.

Reject

The board does not need to be cut further, so don’t manually load anything. 
The software marks it as rejected.

Reject and Add as Redo

The board is being marked as rejected, but also added back into the job. With 
this option, all parts on the board are recut. Where the board falls in the job 
depends on the default chosen in Tools > Options > Cut List > Redo Parts.

If Cut First is selected, a new board must be placed on the Auto Deck just 
behind the load arms, so it is the next board to be placed on the Infeed Rail 
after Queue #1 (Board 3 in Figure 6-23). If Cut Last is selected, it will be the 
last board cut in this job.

Reject and Redo Selected Parts

The board is being marked as rejected, but certain parts can be added back 
into the job. With this option, only the parts selected in the lower portion of the 
screen shown in Figure 6-22 are recut. Where the parts fall in the job depends 
on the default chosen in Tools > Options > Cut List > Redo Parts.

If Cut First is selected, a new board must be placed on the Auto Deck just 
behind the load arms, so it is the next board to be placed on the Infeed Rail 
after Queue #1 (Board 3 in Figure 6-23). If Cut Last is selected, it will be the 
last board cut in this job.

Resetting a Stalled Saw

See Abort Sequence under Diagnostics.
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Calibration
See the Calibration section on the MiTek website.

https://www.mitek-us.com/resources/troubleshooting/blade/
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MAINTENANCE

Introduction to Maintaining Your Machine
This manual contains information for common repair maintenance and all 
preventive maintenance. The recommended intervals for the maintenance items 
addressed in this section are listed in the Maintenance Checklist chapter. 
Additional maintenance instruction and videos can be found on our web site or 
video site.

Read the safety section starting on page 12. The safety test procedures in the 
safety section MUST be performed by qualified personnel after ANY 
maintenance, adjustment, or modification. Note these safety reminders:

Certain parts should be kept in stock at your facility. These parts are listed in the 
Ordering Parts appendix.

Overview Graphics
See General Information on page 47 for an overview on the main and optional 
components of the BLADE saw.

! WARNING
ELECTROCUTION, HIGH PRESSURE, CRUSH, CUT, AND 
CHEMICAL HAZARDS
Read this section AND the safety section in the preliminary pages 
before operating or maintaining this equipment.
Do not operate this machine until you have a thorough 
understanding of all controls, safety devices, E-stops, and 
operating procedures outlined in this manual.
Read and observe all hazard instructions. Failure to do so may 
result in economic loss, property damage, and/or personal injury. 
This manual must always be available to personnel operating and 
maintaining this equipment.

! CAUTION
This icon is an important safety note.
It indicates that you must lockout/tagout at the appropriate 
disconnect switch using approved methods described in OSHA 
CFR 1910.147 before continuing with the procedure.
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Maintenance Terminology

The orientation terminology in Figure 7-1 will be utilized throughout the 
maintenance section when referring to different sides of the BLADE saw.

Figure 7-1: Orientation Terminology for Saw Component

Infeed End Outfeed End

Front Side (Operator Side)

Rear Side
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Major Components

The following graphics call out major components that will be referenced 
throughout the maintenance chapter.

Figure 7-2: Major Components Visible from Infeed End of Saw

Guard removed from this section.

Elevation Assy
(shown in down position)

Raises and lowers saw head.

Stroke Assy
(shown in extended position)

Moves saw head toward 
front and back of saw.

Saw
Chamber

Printer
& Side Clamp
Assemblies

Saw Head

Elevation assembly shown
in up position and

Stroke assembly shown in
retracted position.

Left side of saw is cut off for better visibility.
Front side doors are open.

Waste
Conveyor

Top
Clamp
Assy
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Figure 7-3: Major Components Visible from the Front Side of Saw

Saw Head

Printer
Supplies

Saw Chamber Door
(shown open)

Outfeed Assy
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Figure 7-4: Major Components Visible from the Outfeed End of Saw

Axes and Home Positions

There are 6 major axes referred to on this equipment. Their definitions and home 
positions are shown in the following graphics. The axis number shown in Table 7-
1 may be needed when troubleshooting.
Table 7-1: Axes List and Description
Axis # Axis Name Description

1 Gripper Holds and pushes board along Infeed Rail.

2 LASM Lumber Advance Short Move; holds and moves 
board while inside saw chamber.

3 Elevation Raises and lowers saw blade.

4 Stroke Moves saw blade in and out.

5 Angle Turns saw blade for angle cuts.

6 Bevel Turns the saw blade for bevel cuts.

Saw
Chamber

Door

Main
Electrical
Enclosure

Top
Half

Bottom
Half

Waste
Conveyor

(may be on opposite end)

Main Pneumatic
Filter/Regulator

Outfeed
Assy
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Figure 7-5: Gripper Axis

Figure 7-6: LASM Axis

Gripper
in Home
Position

Infeed Rail 
Attaches to Saw

LASM at “0” LASM at Home

LASM is at “0”
when groove in
LASM clamp
aligns with blade.

LASM “0” and Home Positions
align with sensors
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Figure 7-7: Elevation and Stroke Axes (Infeed End View)

E
le

v
a
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o

n
Blade
Orientation 
Home = Edge 
Faces Operator
(shown)

Stroke

Home = Retracted
(shown)Home = At Bottom 

(shown at top)
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Figure 7-8: Bevel and Angle Axis

Board
Direction

BEVEL CUT

Board
Direction

Blade

ANGLE CUT

Home = 90° 
(0° is shown)

Home = 90° (shown)

Top View

Front View
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Cleaning

Cleaning Saw Dust and Debris
It is important to blow off and vacuum the equipment daily. Saw dust acts as an 
insulator and will prevent electrical components from working properly, and debris 
causes mechanical jams. 

NOTICE
Never use compressed air inside of electrical enclosures. It may 
force contaminants into electrical connections.
Use a vacuum to remove dust from electrical enclosures. Canned 
air is acceptable after vacuuming.

! CAUTION
CRUSH AND CUT HAZARD
Always replace guards after completing maintenance and before 
removing the lockout/tagout device.
Operating a machine with guards removed may result in serious 
injury or death.

BLOW OFF... VACUUM...
• Top and sides of saw frame
• Auto Deck chains
• Infeed rail where board travels 
• Gripper assembly, behind gripper 

assembly, and board slip sensor
• Sensors on Infeed Rail near saw 

end
• Inside top/side clamp assembly
• Outfeed clamp, lumber channel, 

behind outfeed clamp at cylinder
• Inside stroke/elev chamber; all 

axes
• Remove lumber scraps and 

anything that doesn’t belong on 
equipment surfaces & belts, and 
blow off surfaces

• Inside electrical enclosures: 
NEVER USE COMPRESSED 
AIR!

• Floor of stroke/elev chamber
• Floor of saw chamber
• Saw chamber, especially 

around blade and LASM 
(cover the Crooked Lumber 
Sensor under LASM to protect 
from saw dust)

• Inside the printer and side 
clamp assembly (infeed side)

• Floor under and around 
system
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Cleaning Surfaces

If it should become necessary to clean the surfaces of this machine, disconnect it 
from its power source first. Do not use liquid cleaners, aerosols, abrasive pads, 
scouring powders or solvents, such as benzene or alcohol. Use a soft cloth lightly 
moistened with a mild detergent solution. Make sure the surface cleaned is fully 
dry before reconnecting power.

Calibrating
Refer to Calibration on page 92 in the Operation chapter.

Lubricating
Lubrication of various items is required to keep the machine operating properly 
and to prevent costly replacements. See the respective mechanical sections for 
further instructions on lubrication.

Using a Manual Grease Gun
This manual frequently makes reference to various items (such as bearings) that 
require the use of a manual grease gun for proper lubrication. The amount of 
lubrication that should be applied is typically measured in cm3. The amount of 
lubricant output by a manual grease gun per stroke can vary among models. We 
highly recommend customers familiarize themselves with the amount of grease 
output per stroke with any grease gun in order to avoid applying too much 
lubricant and potentially causing damage to the machine.
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Motors and Gearboxes

Motor Locations

Figure 7-9: Front and Rear View of Saw 

Waste
Conveyor

Infeed End of Saw

Elevation

Stroke

Angle

Front of Saw

Outfeed
Chain

LASM

Infeed
Rail

Infeed Rail

Saw Blade

Bevel
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Figure 7-10: Auto Deck and Skewed Conveyor

Motor Maintenance
Table 7-2 lists all motors in the system. Some hardware has changed over time 
and is designated as latest model or earlier models in the Motor column when 
applicable.
Table 7-2: Overview of Motor Maintenance

Checking and Changing Gearbox Oil

Check the oil in the all gearboxes once every 12 months (one shift) or every 6 
months (two shifts). When additional oil is needed, use the oil recommended for 

Motor Gearbox and Model 
(if present)

Requires Grease Requires Oil

Angle N/A No No

Elevation (with brake) N/A No No

Stroke N/A No No

Bevel (latest model) Yes (GAM) No No

Bevel (earlier models) Yes (Nabtesco) Yes No

Saw Blade N/A Yes No

LASM N/A No No

Infeed Rail N/A No No

Outfeed Chain Yes No Yes

Skewed Conveyor Yes No Yes

Waste Conveyor Yes No Yes

Auto Deck Yes No Yes

Auto Deck Skewed Conveyor
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each motor type listed in Table 7-3 or a comparable type that meets all 
specifications.
Table 7-3: Recommended Oil Specifications for Motor Gearboxes

Drain and refill the oil every 20,000 hours or 4 years. Each gear motor includes a 
level plug and drain plug (see Figure 7-11 for example). Note that the exact 
location of each plug will vary between motors.

Figure 7-11: Example of Oil Level Bolt and Oil Drain Bolt Location

The approximate amount of oil is listed in Table 7-4. Earlier machine models may 
include a different motor and gearbox that require a different amount of oil. For all 
gearboxes, the amount of oil should be enough to reach the oil level bolt.
Table 7-4: Approximate Oil Fill Level

Checking and Changing The Bevel Gearbox Grease (Nabtesco Only)

Lubrication for Nabtesco Gearbox

Recommended grease: VIGOGREASE RE0™
• Operating temperature range (ambient): 14°F to 104°F (-10 to 40°C)

Motor ISO Viscosity 
Grade

Oil Type Oil Supplied by 
Manufacturer

Outfeed Chain 680 Synthetic Polyglycol 
Oil

Klübersynth UH1 6-680

Waste Conveyor 680 Synthetic Polyglycol 
Oil

Klübersynth UH1 6-680

Auto Deck 680 Synthetic Polyglycol 
Oil

Klübersynth UH1 6-680

Skewed Conveyor 460 Synthetic Polyglycol 
Oil

Klübersynth UH1 6-460

Motor Quarts Liters

Outfeed Chain .106 .1

Skewed Conveyor .4 .378

Waste Conveyor .106 .1

 Auto Deck .1 .094

Level
Plug

Drain
Plug

Grease
Hex socket set
Grease nipples 
and grease 
gun
Torque wrench
Seal tape
Rags
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• Reservoir volume: Approximately 219 grams
• This is a synthetic EP lithium grease sold by Nabtesco. If substituting a 

different grease, work with your supplier to ensure it is equivalent.
• Replace every 20,000 working hours

Lubrication Procedure

Bevel motors that incorporate a Nabtesco gearbox require lubrication. Follow 
these instructions for lubricating the Nabtesco gearbox.

1. Rotate and position the output shaft of the reduction gear so that the 
tapped holes for injecting/draining grease are located diagonally as shown 
in Figure 7-12.

2. Lockout/tagout all power.

3. Drain and add grease following these steps:

Figure 7-12: Nabtesco Gearhead Hole Identification

a) Unscrew the hexagon socket head cap plugs and other parts from 
holes A and B shown in Figure 7-12.

b)  The exact location of the 2 holes will vary depending on where the 
shaft stopped rotating. Drain the lubricant from the lower hole.

c) Attach a grease nipple to the lower hole, leaving the upper hole open 
as a vent to protect the seals.

d) Add grease until it is visible at the edge of the top hole. The capacity of 
the reservoir is 219 grams.

4. Use the torque settings listed in Table 7-5 to install the plugs and other 
parts: 

! CAUTION
LET COOL BEFORE UNPLUGGING HOLE!
If a tapped hole for injecting/draining grease is unplugged 
while the reduction gear is still hot, hot lubricant sprays out, 
which could cause burns.

Hole A

Hole B
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Table 7-5: Torque Settings for Hole Plugs (for 020E Model)

a) Install new seal tape onto the plugs.
b) Re-install the plugs and other parts that were removed from the holes.
c) Wipe off the gearbox and surrounding area.

Lubricating Saw Blade Motor Bearings

There are two grease fittings on the saw blade motor for the drive end (DE) and 
opposite drive end (ODE) bearings. Each bearing should be lubricated every 12 
months (one shift) or every 6 months (two shifts).

Figure 7-13: Saw Blade Motor Grease Fitting Locations

Hole Parts to Install Torque (Nm)

A M6 cap screw & washer 12.1 +/-0.61 

B Plug GM-1/8 12.3 +/-2.45

Hole Parts to Install Torque (Nm)

Manual grease 
gun
No.2 lithium-
based grease Opposite Drive-End Fitting Drive-End Fitting
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Slippage Errors and Tightening Motor Couplings

Slippage Errors

Figure 7-14: Potential Causes of Gripper Slippage Error

4. Check timing belt tension moves 1/4” up an down.

Check pulley: teeth should not be worn and shaft

should not have movement.

3. Lubricate linear 

guide bearings.

1. Check for mechanical obstructions like 

wedges, damaged parts, etc. that may be 

inhibiting the axis from moving freely.

2. Check the home sensor, bracket, 

and target plate for damage.

Should be 1/32” gap (paper folded 

in half should slide easily under it).

6. Ensure gripper nor 

boards are hitting the

infeed side clamp rollers

or printer at the saw frame.

movement.

Output torque setting:

309 in-lb

2 places on same shaft

5. Tighten motor couplers at

input and output locations. 

Detailed procedure is on Servo 
Troubleshooting web page.

Input torque setting: 89 in-lb
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Figure 7-15: Potential Cause of LASM Slippage Error

1. Check for mechanical 
obstructions like wedges, 
damaged parts, etc. that 
may inhibit the axis 
from moving freely. 7. Check the quality 

of the saw blade and 
ensure it spins smoothly. 
Dull or wobbly blades 
can put the saw in a bind.

Input torque: 89 in-lbs
Output torque: 44 in-lbs

5. Tighten motor couplers at input
and output locations.

Detailed procedure is on Servo
Troubleshooting web page.

4. Check the home sensor, bracket, 
and target plate for damage.
Should be 1/32” gap (paper folded 
in half should slide easily under it).

2. Ensure LASM travels 
smoothly, does not hit 
any part of saw, and
does not show signs of 
recent blade collisions.

3. Lubricate linear 
guide bearings.

6. Check timing belt tension 
moves 1/4” up an down.
Check pulley: teeth should 
not be worn and shaft 
should not have movement.
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Figure 7-16: Potential Causes of Stroke Slippage

1. Check for mechanical obstructions like 
wedges, damaged parts, etc. that may be 
inhibiting the axis from moving freely.

7. Check the quality of
the saw blade and 
ensure it spins smoothly. 

5. Check timing belt tension 
moves 1/4” up an down.
Check pulley: teeth should not be worn 
and shaft should not have movement.

2. Check the home sensor, bracket, 
and target plate for damage.
Should be 1/32” gap (paper folded 
in half should slide easily under it).

6. Ensure stroke travels smoothly
and does not hit any part of saw.

8. Move to Min/Max positions 
and ensure bumpers do
not hit hard stops.

4. Lubricate
linear guide
bearings.

Input torque:

• Gearbox serial # G107255 

   and higher: 97 in-lb

 • Gearbox serial # lower than 

   G107255: 159 in-lb

3. Tighten motor couplers at

input and output locations.

Detailed procedure is on Servo
Troubleshooting web page.

Output torque: 106 in-lb
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Tightening Motor Coupler on Servo Motors

This section contains instructions for setting the correct torque values for various 
motor couplers.
Table 7-6: Torque Values for Input and Output Couplers

Figure 7-17: Motor Assembly Input / Output Example

Instructions for LASM, Stroke, Gripper, and Angle Servo Motors (Input)

1. Remove the plug labeled output in Figure 7-17 to access the hole.

2. Align the screw with the hole using one of the following methods:
a) For LASM, Stroke, and Gripper couplers only: with E-stop activated 

move axis by hand.

Motor Torque (in-lbs) Hex Size

INPUT

LASM 89 4 mm

Stroke (Gearbox serial # 
G107255 and higher)

97 5 mm

Stroke (Gearbox serial # 
lower than G107255)

159 5 mm

Bevel 50 3 mm

Angle 177 6 mm

Infeed Drive (Gripper) 89 4 mm

OUTPUT

LASM 44 4 mm

Stroke 106 10 mm (socket)

Bevel 138 7 mm

Angle 106 10 mm (socket)

Infeed Drive (Gripper) 309 4 mm

Output Access

Gripper motor shown here.
Other axes have similar assembly.

Input Access
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b) For other couplers: With power on, enter small position changes in 
Diagnostics > Detailed Diagnostics > Move To Position fields to 
move motor coupler in small increments.

3. Torque bolt to the appropriate setting (see Table 7-6) using a torque 
wrench and hex key.

For Bevel Servo Motors (Input and Output)

Use the same steps in Instructions for LASM, Stroke, Gripper, and Angle 
Servo Motors (Input) on page 111, but refer to Figure 7-18 below.

Figure 7-18: Bevel Coupling Bolt Locations

Input Shaft
Coupling Bolt

Output Shaft and 
Input Shaft 

Coupling Bolt
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Elevation Jack Screw
The elevation jack screw raises and lowers the saw head.

Apply grease to the 2 fittings on the jack screw housing every 3 months.

Figure 7-19: Elevation Jack Screw Grease Fittings Location

Saw Blade

When to Replace the Saw Blade

Every shift the operator should perform the following tasks to check the saw blade 
for signs of wear and replace or repair accordingly:

• Check blade diameter. If it’s less than 16-5/8" (425 mm), the saw blade must 
be removed and discarded.

• Check for cracks, warping, missing or dull teeth, etc.
• Observe the blade during operation for wobble or vibration

The saw blade replacement instructions in this manual revision 
are only applicable to the 5-bolt pattern saw blades. If your 
machine uses a 6-bolt pattern saw blade, contact Automation 
Support for SB202.

Manual grease 
gun
No.2 lithium-
based grease

Grease Fittings
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• Check that the bolts holding the blade to the hub are secure.

The frequency of blade changes and repairs depend on the species and grade of 
lumber, as well as the number of hours the saw is being run. Your plant may need 
to change the blade often for optimal saw operation.

Specs for New or Used Saw Blade
Saw blades can be sharpened to significantly extend their life. They must be 
sharpened by a reputable blade sharpener that is familiar with carbide tips. It is 
important to meet the specifications etched into each saw blade. If any 
specification is not met, it can cause the saw blade to cut inefficiently, inaccurately, 
and/or rotate out of balance. The specifications are further defined in Table 7-7.

! WARNING
Keep saw blades sharp and in good condition. Have the saw 
blade re-tipped if carbide tips become chipped or come off. 
Dull blades cause high kickback forces which can cause 
injury.

Table 7-7: Saw Blade Specifications

Spec Description Dimension
Tip-to-tip diameter 425 mm min.

432 mm max.
(16-5/8" min.)
(17" max.)

Kerf (blade thickness) 4.8 mm (.189”)
Z= qty of teeth 40
Ø = diameter of center hole 75 mm
SK =  keyways 0
Hook 10º
Face angle 0º
Top angle 15º
Angle left-to-right 
(or right-to-left) of ATB*

10º

RPM max 4500 rpm
Model # of saw blade as shown on saw blade
ATB indicates an alternating top bevel
Serial # of saw blade as shown on saw blade

* ATB = Alternating Top Bevel
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Replacing a Saw Blade

1. Gather the following supplies:
• Socket Wrench
• Torque wrench with capacity up to 220 in-lbs
• T40 Torx™ bit compatible with wrench 

2. Use the machine software to position the saw head to prepare for saw 
blade removal:
a) Rotate the angle of the saw blade so it is in a horizontal position (flat 

surface on top).
b) Adjust the elevation and stroke to a comfortable position for removing 

the blade.

Figure 7-20: Saw Head Position for Saw Blade Removal

3. Activate an E-stop on the machine.

4. Press the Request to Unlock button next to the saw chamber door and 
open the door.

! WARNING
MOVING PARTS CAN CRUSH AND CUT.
Always verify that power to the machine has been turned off and 
follow approved lockout/tagout procedures.

Saw Blade Removal/Installation Position
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5. Turn the disconnect switch handle on the main electrical enclosure to the 
OFF position and lockout/tagout the machine. See Lockout/Tagout on 
page 6.

6. Use a socket wrench and T40 bit to loosen and remove the 5 bolts 
securing the saw blade (shown in red in Figure 7-21). Discard the bolts.

Figure 7-21: Bolts Securing Saw Blade

7. Remove the saw blade and follow the below instructions to determine 
whether it should be discard or kept for resharpening: 
a) Measure the diameter of the blade from outside edge of tooth to 

outside edge of tooth. If the diameter is less than 16-5/8", discard it.
b) If the diameter is greater than 16-5/8", place the saw blade in a safe 

location for sharpening.

! CAUTION
                            CUT HAZARD.

Saw blades are sharp. Wear gloves and eye protection when 
handling blade.

Hub Bushing Bolts Reminder
It is not necessary to re-torque the hub bushing bolts unless the hub itself feels 
loose. If you feel it’s necessary to check the torque on the hub bolts, only set the 
torque wrench to 156 in-lbs. If the bolts turn at 156 in-lbs, refer to SB252 to 
properly re-torque the hub bushing bolts. If the bolts do not turn at 156 in-lbs, no 
further action is needed.

Bevel Motor

Blade
Rotation

F
ro

n
t 

o
f 

S
a

w
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8. Prepare the surfaces:

a) Blow off dust from the hub and the bolt threads. Remove all pitch and 
debris from threads.

b) Wipe down the mounting surface on the new saw blade and the hub. 
Use a 320-grit emery cloth, if necessary, to remove pitch.

c) Ensure all parts are clean, dry, and free of lubricants.
d) If using a used saw blade, measure its diameter from outside edge of 

tooth to outside edge of tooth. If the diameter is less than 16-5/8", 
discard it.

9. Place the supplied new or sharpened saw blade so the holes align with the 
holes in the hub and the teeth hook points downward when cutting a 
straight cut. See Figure 7-23 for the correct orientation.

10. Using new bolts supplied in this kit, 
install all 5 bolts.
• Use the torque wrench and T40 bit 

and bolts referenced in Step 1.
• Do NOT use thread adhesive.
• Hand tighten all 5 bolts in the order 

shown in Figure 7-22.
• Using a torque wrench, tighten the 

bolts in the order shown in Figure 7-
22 until they all reach the 
recommended torque shown in 
Figure 7-23.

• Once properly torqued, all bolts 
should sit flush with the surface of the blade. If the bolts are protruding 
or skewed, repeat step 10 with new bolts.

! WARNING
Mounting surfaces and hardware must be clean and dry when 
installing saw blade.
Dust, dirt, and lubrication may cause the blade to come loose, 
causing injury or death.

Use ONLY the bolts included in the SBKIT.
Use NEW bolts every time the blade is replaced.
Do NOT use thread adhesive.
TORQUE to specifications given in Figure 7-23!
Ensure the bolts are fully embedded and flush against the 
saw blade surface.

! WARNING

1

3 2

4

5

Figure 7-22: Tighten 
Saw Blade Bolts in This 

A torque wrench 
should be 
calibrated on a 
yearly basis to 
ensure accuracy.
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11. By hand, carefully rotate the blade to observe its motion. It should not have 
any significant wobble or vibration when rotating.

Figure 7-23: Torque Specs for Saw Blade (view from side of saw, with blade 
at 90 degrees)

12. Close the saw chamber door.

13. Power on machine:
a) Remove lockout/tagout and switch the disconnect switch to the ON 

position.
b) Release E-stop and press Reset switch on the HMI. 

14. Use the machine software to start the saw blade rotation and observe its 
motion. It should not have any wobble or vibration when rotating.

15. Calibrate the stroke and LASM axes per Calibration on page 92

Bevel Motor

Blade
Rotation

Teeth Direction

F
ro

n
t 

o
f 

S
a

w

5 bolts holding 
blade to hub:

Torque to 220 in-lb
(24.8 Nm)

6 bolt shown in yellow ring
(holds hub to shaft)
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Printer

Ordering Printer Supplies
To order supplies for the BLADE printer, contact Matthews directly. MiTek does not 
sell the ink or cleaning solution.

Once the account is set up, future orders can be placed by providing a PO any of 
the three ways listed here. To place your very first order with Matthews Marking 
Systems™, see Placing Your First Supplies Order Through Matthews on page 
119.

• E-mail to mms-insidesales@matw.com
• Fax 412-665-2594
• Call 800-775-7775

Table 7-8: Printer Supplies

How Much Ink Will I Use?

The amount of ink you will use depends greatly on which Printer(s) you have, type 
of parts you cut, and quantity of parts each day. Basic guidelines are listed below 
to help you determine how much ink to purchase at one time. These guidelines 
are based on a 5-day work week, 1 shift/day. Adjust these numbers to reflect 
your work week.

•  For Truss Use, with an AGS option:
On average, the Printer uses approximately 1 liter of ink every 1-2 weeks.

• For Wall Panel use, with an AGS option:
On average, the Printer uses approximately 2-3 liters per week.

Placing Your First Supplies Order Through Matthews
Consumable supplies (ink and cleaner) must be purchased from either Matthews 
or a local distributor. MiTek does not sell the ink and cleaner solutions. The most 
efficient way to place your first order is as follows.*

Description Unit Quantity per 
Case

Matthews Part # MiTek Part #

Cleaner: SCP-900C Case 6 bottles (1 
liter ea.)

71002860 N/A

Black Ink: SCP-901A Case 6 bottles (1 
liter ea.)

71002863 N/A

Cap w/ Filter 1 Unit N/A 41206373 005-00135

Print Head Brush 1 Brush N/A 41001415 N/A

Only use the specified ink in this printer! 
Ink specified for other MiTek inkers and printers will damage this unit. 
The ink must be stored between 32ºF and 90ºF and has a 2-month shelf life.

mms-insidesales@matw.com
mms-insidesales@matw.com


Original Instructions: 001080 rev. B 120

BLADE SAW: MAINTENANCE

1. Print and fill out the Matthews credit form that is included in the Inker/
Printer Agreement.

2. Send an e-mail to Matthews at mms-insidesales@matw.com with the 
following information:
a) Notation that you are a MiTek customer
b) Ship To address
c) Bill To address
d) Attach the following files:

• Matthews Credit Form
• PO stating this purchase items, Matthews part numbers, and 

quantities (listed in Inker/Printer Agreement)

3. A customer service representative will assign the account internally, and 
your Matthews account is created.

4. Call to place your first order and verify that all credit information has been 
received. Orders should be placed at least 3 weeks prior to the saw 
installation date to ensure the supplies will be there during installation.

* Failure to supply a purchase order will delay the shipment of supplies. If you do 
not have the credit form, contact Matthews to obtain a credit application. These 
supplies may also be purchased from an approved local distributor. Contact 
Matthews to obtain your local distributor’s contact information.

Printer Components Overview

Print Controller and V-Links

The machine software communicates with the print controller to determine what to 
print and when. The print controller sends messages to a V-Link that is connected 
to a specific print head. Depending on the configuration of your machine, it may 
contain 1 to 3 V-Links.

Print Head(s)

The print heads use ink from the ink bottles to mark a print target according to the 
signals received from the control unit. Depending on the configuration of your 
machine, it may contain 1-3 print heads.
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Ink and Cleaner Bottles

Figure 7-24: Printer Components

Maintaining the Printer

General Maintenance Reminders

• Always wear safety glasses and rubber gloves when handling ink.
• If ink or cleaner makes contact with a person’s skin, hair, eyes, or clothes, 

refer to Treatment for Hazardous Substances on page 11.
• Check regularly for kinks or other stoppages in the lines.
• Never clean the print heads with pressurized air.
• Do not allow the ink or cleaner level to fall below the bottom of the pick-up 

tube. The air will negatively effect print quality and cause damage to the 
print head.

• Always store extra bottles of ink and cleaner in a temperature-controlled 
area. The temperature must stay above 32 degrees Fahrenheit to prevent 
ice crystals from forming and clogging the printer.

• Never pressurize a bottle while it is positioned outside the bottle holder.
• Never exceed the recommended pressure setting of 15 psi.

Print Heads

May only have 1 ink 
bottle, depending on 

ink head configuration.

Ink Bottles Cleaner
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Cleaning the Print Heads

Clean the printer head face (nozzles) at least twice a day using this procedure. 
See Using the Brush to Clean and Practices That May Damage the Print Heads 
following these instructions for important information related to this procedure.

1. Lockout/tagout the pneumatic system’s main regulator.
• Note that the top clamp (infeed side) will lower when air pressure is 

removed. 

2. To ease access to the print heads, follow the instructions in Raising the 
Top Clamp on page 159 to secure the top clamp in place.

3. Pour some of the cleaning solution from a Matthews bottle (for flushing 
print heads) into a small cup or bottle.

4. Place a rag underneath the print heads to catch drips and protect the paint 
and fluid lines from damage.

5. Dip the provided brush into the cleaning solution.

6. Lightly move the brush back and forth across each nozzle, ensuring that 
all visible traces of ink are gone each time.

7. Immediately rinse the brush in the cleaning solution to remove any ink 
before it dries.

8. Place the brush in a sealable plastic bottle or container.

Using the Brush to Clean

• Only use the cleaning solution supplied by Matthews. Do not use water or 
any other chemical for cleaning. Failure to do so will damage the unit and 
void the warranty.

• Never dip the brush into a cleaner bottle that will be used with the saw.
• After cleaning, place the brush in a sealable plastic bottle or container (a 

wide mouth bottle works well). Dirt must be kept out.
• Do not use a plastic bag because the cleaner may eat through it.
• It is acceptable to leave cleaner in the brush bottle to keep the brush 

flexible.
• Do not rinse the brush with water. Replace the brush when it is damaged or 

too dirty to clean properly.

! CAUTION

Wear goggles and gloves when handling ink/cleaner.

Small brush
Cleaner fluid
Washing 
station
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Practices That May Damage the Print Heads

• Do not use a spray bottle to apply the cleaner directly to the nozzles. The 
spray may push debris into the nozzles and damage the hoses or other 
components it contacts.

• Do not use rags or paper towels on a print head. Using anything other than 
the brush to clean a print head can push debris into the print head nozzles 
and create a clog or damage the nozzle.

Flushing the Printer

The printer should be flushed to clean ink out of all print heads every month OR if 
the printer will go unused for more than 48 hours.

Identifying Your Printer

The flushing instructions refer to 7, 16, and 32 valve printers. Use Table 7-9 to 
determine which printer setup your system uses. Note that the printer 
hardware in earlier machine models may need to be upgraded to support all 
options listed.

Table 7-9: BLADE saw Print Head Configurations

The Flushing Procedure

To flush the print system with cleaner fluid, follow these steps for each print 
head:

1. Lockout/tagout the pneumatic system’s main regulator.
• Note that the top clamp (infeed side) will lower when air pressure is 

removed. 

# of Valves 16 or 32 7 or 32 7

System ID and 
Printing Location

Ink Bottle 1 Ink Bottle 2

Front Rear Edge

Option A 16 N/A N/A

Option B 16 7 N/A

Option C 16 N/A 7

Option D 16 7 7

AGS+ option E 32 32 N/A

AGS+ option F 32 32 7

! CAUTION
FLUID WILL EXIT NOZZLES DURING FLUSH!
When a Flush cycle is initiated, be sure to have something in 
front of the print head nozzle plate(s) to capture the 
discharged fluid!
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2. To ease access to print heads, follow the instructions in Raising the Top 
Clamp on page 159 to secure the top clamp in place.

3. Remove the lockout/tagout of the pneumatic system’s main regulator.

4. In the machine software, go to Diagnostics > Detailed Diagnostics > 
Printer and select the desired print head from the dropdown, then select 
Cleaner.

Figure 7-25: Printer Flush Settings in Software

5. Locate the manual purge valve for the print head you are flushing and 
point it toward a waste container. An example valve is shown in Figure 7-
26 and the valves themselves can be accessed via one of the 
maintenance doors near printer assembly.
• If you are flushing a 7-valve print head (rear and/or edge print heads in 

certain configurations), turn the manual hand valve to switch the fluid 
from the ink to the cleaner bottle. See Figure 7-27.

Figure 7-26: Example of Manual Purge Valve

6. Pull back on the valve until no ink is coming out, only clear cleaner.

Print head Dropdown
Selector

Select Ink or Cleaner

Select to Flush
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Figure 7-27: Manual Valve for 7-Valve Print Heads

7. Place a rag under the print heads to capture the cleaner liquid.

8. On the printer screen, select the Flush button a few times until you see 
clear cleaner come through the nozzles on the selected print head.

9. Repeat this process for all other print heads. See Identifying Your Printer 
on page 123 for the number of print heads in your configuration.

10. The print system has now been flushed with cleaner. MiTek recommends 
flushing the print system if the printer will go 48 hours or longer 
without use.

11. To return the printer to use, see Preparing the Print for Use After Flushing 
on page 125.

Preparing the Print for Use After Flushing

To return the printer to operation, follow these steps for each print head:

1. In the machine software, go to Diagnostics > Detailed Diagnostics > 
Printer, select the print head from the dropdown, then select Ink (see 
Figure 7-25).

! CAUTION
FLUID WILL EXIT NOZZLES DURING FLUSH!
When a Flush cycle is initiated be sure to have something in 
front of the print head nozzle plate(s) to capture the 
discharged fluid!

7-Valve
Print Head

Valve Handle

Handle is shown pointing
up for ink transfer.

Cleaner

Ink
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2. Locate the manual purge valve for the print head you are flushing, and 
point it toward a waste container. Pull back on the valve until only ink is 
coming out.
• If you are flushing the 7-valve print head (edge), turn the manual hand 

valve to switch the fluid from the cleaner to the ink bottle.

3. Place a rag under the print heads to capture the cleaner liquid.

4. On the printer screen, select the Flush button a few times until you see ink 
come through the nozzles on the selected print head.

Replacing an Ink or Cleaner Fluid Bottle

1. Open the Stroke / Elevation (Outfeed) door.

2. Switch the power switch on the printer pump to the OFF position (see 
Figure 7-29 on page 128).

3. Pull the ring on the pressure release valve to release all air pressure in the 
print system (see Figure 7-29 on page 128). There must not be any air 
pressure in the system when replacing fluid bottles.

4. Shake the new ink bottle vigorously.
• Refer to Ordering Printer Supplies on page 119 for help with ordering ink 

or cleaner fluid.

5. Remove the cap from the new bottle, but not the foil seal.

6. Remove filter assembly from the empty bottle. 
• See Replacing the Bottle Filter and Lid Assembly on page 126 to 

determine if the filter assembly may need to be replaced.

7. Cut a X shape in the foil seal on the new bottle.

8. Insert the existing filter assembly into the new bottle and screw the cap 
back on to secure.

9. Place the new bottle back in the ink bottle holder. See Figure 7-24 for the 
location of the ink bottle holder.

10. Switch the power switch on the printer pump to the ON position and close 
the door.

11. Ensure the manual valve for 7-valve print heads is in the ink position for 
printing.

12. Purge the line so all air is pushed out. See Preparing the Print for Use 
After Flushing on page 125.

Replacing the Bottle Filter and Lid Assembly

The filter and lid assembly on each fluid bottle should be replaced when print 
quality begins to show that ink or cleaner is not getting through the lines. 

1. Unscrew the filter and lid assembly (a single part) and remove it from the 
bottle.
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Figure 7-28: Bottle Filter and Lid Assembly

2. Screw the new filter and lid assembly into place.

Extending Filter Life

To lengthen the time between replacements for the filter and lid assembly, 
follow these instructions: 

1. Follow the steps for releasing the pressure from the ink and cleaner bottles 
(see Replacing an Ink or Cleaner Fluid Bottle on page 126).

2. Place the ink filter and lid assembly onto a cleaner bottle and flush the 
system. This allows cleaner to run through the filter and remove some of 
the old ink.

Setting the Printer Air Pressure

The regulator that affects the printer system’s pressure can be access via the front 
of the saw via a maintenance door (see Figure 7-29). Adjust the pressure by 
turning the knob. It must be set to no higher than 15 psi. Exceeding this 
recommended setting will damage the print heads.

The printer’s pneumatic system has a non-adjustable relief valve set at 15 psi next 
to the regulator.
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Figure 7-29: Printer Relief Valve and Pneumatic Regulator

Printer Tab in Software Option Menu

• The Dot Size must stay between 15-27, but the recommended setting is 27.
• Time of Flight is the time it takes for an ink dot to get from the print head to 

the board. It is calculated during the calibration of the printer. Must stay 
between 0-200.

• If marks are not in the correct location (most important when marking 
component location on wall panels), increase the time of fight to print on the 
board earlier. Decrease the time of flight to print on the board later.

Figure 7-30: Tools > Options > Printers Menu

Pressure Relief Valve

Pneumatic Regulator
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Printer Sensors States

To see the printer sensor states, go to Diagnostics > Detailed Diagnostics > 
Printer.

Bearings (Lubrication)

Lubricating the Linear Bearings
Check the quality of the lubrication on the guide rails every week to determine 
when more grease is needed. The frequency of greasing depends on many 
factors including amount of use and dust. After enough time has passed to 
determine a pattern, document how often the bearings should be greased, but 
continue to inspect the rails every week.

Because the linear bearings require frequent lubrication and can be damaged by 
overgreasing, MiTek recommends the following grease and grease gun be used.

Grease Recommended

Mobilux™ EP 2

This is a general purpose, lithium-based Grade 2 grease that provides excellent 
protection against rust and corrosion and resists water wash-out, corrosion 
protection, low temperature pumpability, and high temperature service life.

Grease Gun Recommended

It is recommended to use the following grease gun to ensure the proper amount of 
grease is applied. If you do not have this grease gun available, it is recommended 
that you purchase one for future use. Understanding the number of pumps to use 
(the output of grease) will extend the life of the bearings and the accuracy of the 
saw.

Hiwin GN-80M
Output: 0.5-0.6 cm3 per stroke

If you choose to use a different grease gun, document which gun is to be used for 
this procedure and ensure employees know the output per stroke. The output per 
stroke should be equal to or less than 0.5 cm3 per stroke.

NOTICE
Overgreasing will cause premature failure of bearing seals 
and excessive saw dust and dirt to stick to the guide rails, 
negating the benefits of the grease. Undergreasing may 
cause damage to components and affect the accuracy of 
the saw. A thin film of grease should be visible on the guide 
rails at all times

Prior to 2015, oil 
cartridges were 
used on the 
bearings instead 
of grease fittings. 
The bearings 
described here 
are a direct 
replacement for 
those models.
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Lubrication Amount

Use a grease gun to apply the volume of grease listed in Table 7-10 to the 
matching bearing size.
Table 7-10: Grease Volume Per Bearing Size

Location and Number

Table 7-11: Assemblies Lubricated by Linear Guide Bearings

Figure 7-31: Infeed Rail Gripper Bearing Location

Linear Bearing Size Amount

Stroke, & Elevation (size 25) 0.8 cm3

Gripper, Infeed Top Clamp, Infeed Side Clamp, and Outfeed Clamp 
(size 20)

0.5 cm3

Lubricated Assembly Qty. Graphic

Infeed Rail Gripper 2 Figure 7-31
Top Clamp 4 Figure 7-32
Infeed Side Clamp 4 Figure 7-32
Stroke 4 Figure 7-33
Elevation 4 Figure 7-33
Outfeed Clamp 4 Figure 7-34

Manual grease 
gun
No.2 lithium-
based grease

InnInInnII fefefeededed EEEEndndndnd
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Figure 7-32: Infeed Side and Top Clamp Bearing Location

Figure 7-33: Stroke and Elevation Bearing Locations

Infeed End

Side Clamp Top Clamp

Stroke / Elevation Door (Infeed End)
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Figure 7-34: Outfeed Clamp Bearing Locations

LASM Linear Module
The LASM linear module should be lubricated every 24 months (one shift) or 
every 12 months (two shifts). Use a grease gun to apply 2.8 cm3 of grease to the 
fitting shown in Figure 7-35.

Figure 7-35: LASM Linear Module Location

Manual grease 
gun
No.2 lithium-
based grease

Saw Chamber Door



Original Instructions: 001080 rev. B 133

BLADE SAW: MAINTENANCE

Cam Followers (Outfeed Assembly)
As a board exits the saw chamber, a set of cam followers make contact with the 
board’s back surface to guide it and ease its travel to the outfeed. Apply a #2 
lithium-based grease to each of these cam followers once every year. Remove the 
top guard to access the cam followers.

Figure 7-36: Outfeed Cam Followers Location

Lumber Exit Chain Bearings
Apply a #2 lithium-based grease to the idle-end bearings once every 12 months (1 
shift) or every 6 months (2 shifts). 

Figure 7-37: Lumber Exit Chain Bearings Location

Manual grease 
gun
No.2 lithium-
based grease

Nut
Washer

Grease
Fitting

Cam
Follower

Lumber Exit Chain

Lumber
Exit Chain

Drive Motor

Bearings
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Waste Conveyor Drive Shaft
Lubricate the waste conveyor bearings with #2 Lithium-based grease once a year. 
There is 1 grease fitting on each end of the drive shaft.

Figure 7-38: Waste Conveyor Drive Shaft Grease Fitting Location



Original Instructions: 001080 rev. B 135

BLADE SAW: MAINTENANCE

Auto Deck Drive Shaft (Infeed Component)
Apply #2 lithium-based grease to the grease fittings on the Auto Deck shaft 
bearings every 12 months (1 shift) or 6 months (2 shifts). There is 1 fitting for each 
Auto Deck strand and there are 5-6 strands total depending on Auto Deck length.

Figure 7-39: Auto Deck Drive Shaft Grease Fitting Location
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Wheels

Lubricating Wheels

Skewed Conveyor Wheels

There are 2 drive wheels that drive the belts. Each of the drive wheels have 2 
bearings with grease fittings on the front and rear side of the conveyor. Use a #2 
lithium-based grease every 6 months (1 shift) or every 3 months (2 shifts). The 
non-powered wheels that guide the belt require no lubrication. The conveyor 
rollers and skatewheels on the Skewed Conveyor require no lubrication.

Figure 7-40: Drive Wheel Grease Fitting Locations

Chains
The chains utilized in this machine may require cleaning, lubrication, or 
tensioning. This section details which types of maintenance are necessary for 
specific chains.

Lubricating Chains
These chains should be lubricated with a high-grade, non-detergent, petroleum-
base oil. Anti-foam, anti-rust, and film-strength improving additives are often 
beneficial. SAE 30 grade is recommended.

Apply oil to the edges of the link plates of the chain near where the chain makes 
contact with a sprocket and to the inside of the chain generally.

2  More Grease 
Fittings on Other Side
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Auto Deck Chain

Remove yellow guard to access chain and sprocket. Lightly lubricate each chain 
every 12 months.

Figure 7-41: Auto Deck Chain Lubrication Point

Skewed Conveyor Chain

Remove yellow guard to access chain and sprocket. Lightly lubricate the chain 
every 2 months.

Figure 7-42: Skewed Conveyor Chain Lubrication Point

Adjusting Chain Tension / Positioning
For most applications, a chain should be installed with a sag depth between 2%-
4% of the distance between sprockets holding the chain. Follow this formula 
unless measurements are provided for a specific chain. 

Yellow Guard

Rear Side of
Skewed Conveyor



Original Instructions: 001080 rev. B 138

BLADE SAW: MAINTENANCE

Lumber Exit Chain Tension

1. Loosen 4 bolts labeled B in Figure 7-43, on the back side of the motor 
plate.

2. Loosen the jam nut and adjust tension bolt labeled C to slightly move the 
motor.

3. Tighten the jam nut and bolts B.

Figure 7-43: Lumber Exit Chain Tensioner Mechanism

Lumber Exit Chain Positioning

The lumber exit chain must be perfectly parallel with the LASM fixed jaw. All other 
alignments are measured off of the lumber exit chain (see Table 7-12), so it must 
be straight and in a location as described here.

Table 7-12: Outfeed Components Alignment Guide

Follow these instructions to adjust the location of the entire lumber exit chain 
assembly:

1. Ensure the lumber exit chain is parallel with the travel rail for the LASM 
and the chain teeth protrude 1/16" in front of the fixed jaw.

2. Check this measurement with LASM at left end of the lumber exit chain, 
and again with the LASM all the way to the right. Both ends must be 
identical indicating the lumber exit chain and LASM rail are parallel.

3. Ensure the channel for the lumber is approximately 2-1/2” wide from tip of 
chain teeth to surface of cam followers when fully unclamped.

4. If it is necessary to adjust the lumber exit chain, follow these steps:

This... Must Be This...

Lumber exit chain parallel to LASM fixed jaw

Lumber exit chain in straight line with sprockets

Outfeed clamp cam followers parallel to lumber exit chain

A AA

EE

BCD D
(not shown)

D
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a) Loosen the 3 bolts labeled A in Figure 7-43.
b) Push or pull on the lumber exit chain assembly to align as described 

previously.
c) Tighten the 3 bolts labeled A in Figure 7-43.

Lumber Exit Chain Guide Bracket

The chain guide bracket shown in yellow in Figure 7-44 holds the lumber exit 
chain so that it does not sag and stays in line with the sprockets. To adjust the 
location of the chain guide bracket, follow these instructions.

Figure 7-44: Bottom View of Chain, Lumber Exit Chain Guide Highlighted

1. Loosen the 3 bolts labeled D in Figure 7-43 (previous page).

2. Using the 2 jack screws labeled E in Figure 7-44 and Figure 7-43, loosen 
the jam nuts and adjust the jack screws to slightly move each end of the 
chain in or out. The chain must be in this position:
• Lumber exit chain must be tangent with the sprockets.
• If the lumber exit chain is a straight line between the sprockets, it will 

also be parallel to the LASM fixed jaw as described on page 138.
• There must not be any sag or wave in the lumber exit chain.

3. Tighten the jam nuts on bolts E and tighten bolts D.

Auto Deck Chain Tension

To tension the chain, loosen the locknut 
shown in the middle of the take-up in 
Figure . Manually pry the take-up, one 
notch at a time, until the chain is the 
desired tension, then re-tighten the 
locknut.

Do not over-tension the Auto Deck chain. 
An excessive load will cause the VFD to 
show a fault.

EE

Figure 7-45: Auto Deck Tension Take-Up
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Belts

Gripper

Adjusting Gripper Belt Tension

1. Loosen the 4 bolts clamping the belt tensioner bracket to the frame.

Figure 7-46: Gripper Belt Tensioner Bracket

Motor may be oriented differently in other models

2. Back off the jam nut and turn the tension bolt to wedge bracket out until the 
belt is tight.

3. On rear side of the machine, test the tension of the belt at the mid point of 
the infeed rail. The top section of the belt should lift approximately 3/16 in. 
with little effort. 

4. Re-tighten the bolts clamping the bracket to the frame.

5. Move the gripper assembly back and forth (from the touch screen) to test 
the belt tracking. Adjust if necessary.

Adjusting the Gripper Belt Tracking

If the gripper belt is not tracking on the shaft evenly, follow this procedure: 

1. Loosen the tension (see Gripper Belt Tensioner Bracket) and manually 
move the belt over to the center of the shaft. 

Infeed
Drive
Motor

Tension
Bolt

Bolts
Clamping
Bracket

to Frame
(2 on bottom also)

End of Infeed Rail
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2. Tighten the tension, ensuring that the motor assembly is straight and 
square. 

3. Manually move the gripper to the opposite end of the Infeed Rail to test the 
tracking. 

4. Repeat this process until the belt stays where it was placed on the shaft.

Stroke Axis

Adjusting Stroke Belt Tension

The stroke assembly is attached to a cogged belt called a timing belt. To adjust 
the tension of stroke timing belt, follow this procedure:

1. Locate the threaded rod used as a tension bolt that puts tension on the 
timing belt attached to the assembly (see Figure 7-47).

Figure 7-47: Stroke Timing Belt Tension Bolt

2. Back off the jam nuts and adjust the bolts to tighten or loosen the tension 
on the cogged, white belt.

3. Tighten the jam nuts.

4. From the machine software Home Screen, select Stroke and choose one 
of the Jog options to move the assembly back and forth to test the belt 
tracking.

5. Adjust if necessary.

Tension Bolt for Timing Belt
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Waste Conveyor

Adjusting Waste Conveyor Belt Tension

1. Remove the dust extraction cover to access then tension bolt shown in 
Figure 7-48.

Figure 7-48: Waste Conveyor Belt Tension Bolt

2. Start with the tension bolt at approximately 2-1/2”. 

3. Adjust as needed so the belt runs smoothly.

Adjusting Waste Conveyor Belt Tracking

With extended use or belt replacement, the belt tracking may need adjustment. 
The key to perfect tracking is to make each adjustment very small and to remain 
patient as it may require more than one roller to be adjusted. Expect several 
adjustment cycles before the belt tracks perfectly.

1. After tensioning the belt, test the tracking:
a) Remove lockout/tagout devices and power up the saw.
b) Run the conveyor and watch how the belt tracks.

2. If the belt walks toward one side, adjust it as described here.
a) Determine which way the belt needs to move toward, and address that 

end of the belt.
b) Adjust the angle of the roller (see Figure 7-49 for location of tracking 

adjustment bolts)

! CAUTION
Use your company’s approved lockout/tagout guidelines 
while adjusting the belt. Ensure that no one can power on the 
conveyor without notifying all personnel in the restricted 
zone.

2-1/2"
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Figure 7-49: Waste Conveyor Tracking Adjustment Bolts

3. Test the belt by returning power the saw. The belt should stay 
approximately centered on the conveyor bed. Some minor back and forth 
motion is normal, but it should never rub the side of the conveyor frame

Figure 7-50: Tracking and Tensioning for Waste Conveyors (2015 and Earlier)

Skewed Conveyor

Adjusting Skewed Conveyor Belt Tension

The Skewed Conveyor belt is driven by 2 drive wheels, both powered by the same 
motor. The belt should be tensioned so it moves easily and smoothly without 
much slack. To adjust the tension, follow this procedure:

Loosen screws to slightly 
angle roller to adjust tracking

 (also located on opposite side)

To move this way,

 move this end back.

To move this way,

 move this end back.

Up/Down
Tensioner

Side-to-Side
Tracking

Ensure Drive Roller
at this end is in-line
(straight) with the 
gear reducer axis

Belt
Routing

Idle
Roller

NON-DRIVE SIDE

DRIVE SIDE

To move this way,

 move this end back.
To move this way,

 move this end back.

If the Side-to-Side adjustment is not 
enough or you need to fine tune, 
adjust the Up/Down Tensioner shown 
in Figure 2-46. Move the non-drive side 
down slightly. Do not adjust this roller 
too much or it will be in a bind and 
damage the roller. If more adjustment 
is needed, you can slightly adjust the 
drive side up.

Locking

Nut

Adjusting
Nut

Attachment
Bolt

Adjustment
Bolt
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1. Loosen the 2 bolts securing a bearing on each side of the conveyor (4 
bolts total). See Figure 7-51.

2. Adjust the drive wheel in or out using the lag nuts on the tensioning bolt on 
each side of the conveyor.

3. Re-tighten the 4 bolts.

Figure 7-51: Skewed Conveyor Tensioner Bracket (mirrored on other side)

Adjusting Skewed Conveyor Belt Sheaves

If the belt tension seems correct, but the belt is not making consistent and smooth 
contact with the rollers, adjust the sheaves that support the belt (located under the 
rollers) using this procedure. 

1. Determine which sheaves need to be raised or lowered.

2. Loosen the bolt in the middle of each sheave needing adjustment.

3. Adjust the location of each sheave in its slotted hole, then tighten each 
bolt. 

4. Inspect the belt. It should make just enough contact to drive the rollers, but 
not be too tight.

Wear Items

Bumpers
Bumpers are used on the following axes to reduce stress on mechanical parts 
when stopping at the end of their range:

• Stroke / Elevation
• Gripper

Bearing
Bolts Tension 

Bolt
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• LASM

Bumpers should be replaced if they appear cracked or significantly worn.

To replace a bumper, remove the screw(s) securing the existing bumper and 
install the replacement. Discard the damaged bumper.

Figure 7-52: Stroke / Elevation Bumpers

Figure 7-53: LASM Bumpers

Brushes
Brushes exist at some openings and rails to keep scrap and other debris from 
accidentally entering the saw chamber or sitting on a rail causing an axis 

Not all bumpers are the same size. Refer to the Ordering Parts 
appendix for instructions on ordering parts.

Stroke / Elevation Door

Saw (Front Side) 
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obstruction. The brushes should be inspected periodically and replaced when 
necessary.

Figure 7-54: Brush Examples (Saw Chamber)

Replacing Brushes

1. Remove bolts securing existing brush. Retain for re-installation.

2. Remove and discard existing brush.

3. Use bolts removed in step 1 to install the new brush.

LASM Brush Orientation

As of June 2015, the LASM brushes are designed to be installed as shown in 
Figure 7-55. For previous designs, this design is a direct replacement for the 
previous version.

Figure 7-55: LASM Brush Orientation

Bottom Brush: 6” under top brush

Bottom Brush: Fixed

Top Brush: Slotted, overlap 6”
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LASM 

Fixed Jaw

Measure the fixed jaw of the LASM periodically to ensure it is not worn. It must be 
at least 1 1/2" thick. If worn to less than that, replace it as soon as possible.

Figure 7-56: LASM Fixed Jaw Minimum Thickness

LASM Spikes

Spikes (socket-head cap screws) are 
assembled into the carriage side of the LASM 
jaw to hold the board in place. 

When spikes become dull or damaged, 
unscrew each spike and replace each with a 
new spike, ensuring the spike extends 1/8" 
past the LASM jaw surface. Use red thread 
adhesive.

Felt Strips
Felt strips provide friction resistance for the 
yellow plate that slides up and down with the elevation axis located inside the 
stroke/elevation chamber. The felt strips are attached to the blue wall behind the 
yellow plate. When the plate is showing signs of metal rubbing metal or an uneven 
plate, replace the felt strips immediately to preserve the accuracy of the cuts and 
prolong the life of the saw.

Trimming the Felt

If no metal wear is shown, but the felt has expanded outside of the yellow plate, 
just trim the excess felt and periodically inspect the plate and frame for wear.

1-1/2"

Fixed Jaw

1/8"

Use red
thread
adhesive
on spikes.

Figure 7-57: LASM Spike Depth
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Replacing the Felt Strips

It is recommended to replace all 4 felt strips at the same time to keep the plate 
even.

1. Loosen or remove the white strips securing the yellow plate.

2. Pull the yellow plate away from the wall and scrape off the old glue.

3. Remove the adhesive backing from the new felt strip and apply it in the 
same locations.

Figure 7-58: Location of the Felt Strips

Shock Absorbers
The following shock absorbers keep the clamps from slamming at the end of their 
cycle.

• Top clamp: located on extend and retract positions.
• Infeed side clamp: located on retract position only.
• Outfeed side clamp: located on retract position only and controls clamp 

opening.

Replacing a Shock Absorber
1. Preparing the Saw:

a) Move the component requiring the shock absorber to make accessible:
• For the infeed side clamp, move the gripper to Home position.

Yellow plate
slides up 
and down

with elevation.

White strip clamps 
yellow plate against 

blue wall.

Felt strip is located between
blue wall and yellow plate.

Adheres to the blue wall, 
positioned along all 

4 edges of yellow plate.
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• No positioning is required when replacing the infeed side clamp or 
outfeed clamp shock absorber.

b) Lockout/tagout the machine.

2. Unscrew the locknut and damaged shock absorber and discard all pieces.

3. Install the new shock absorber into the bracket:
a) Remove the lock nut from the new shock absorber.
b) Place the collapsible end through the bracket pointing the correct 

direction, and screw it in as indicated in Table 7-13.
c) Slide the lock nut over the collapsible end and tighten against the 

bracket.

4. Check that the sensors on the cylinder that control fully-open and fully-
closed status are set correctly. Their location may need to be slightly 
adjusted.

Table 7-13: Shock Absorber Overview

Adjusting a Shock Absorber

Figure 7-59: Shock Absorbers for Top Clamp Retract Stroke

Location Qty Graphic Distance Piston 
points...

Top Clamp: Top 
(retract) 2 Figure 7-59 1/2” from bottom surface of bracket 

to end of shock absorber body. Down

Top Clamp: Bot-
tom (extend) 2 Figure 7-59 1/2” from top surface of bracket to 

end of shock absorber body. Up

Infeed Side 
Clamp 1 Figure 7-60 See Figure 7-60. Toward 

saw front 

Outfeed Clamp 1 Figure 7-61
Adjust to 2-1/2” between lumber 
exit chain teeth and camfollower. 
See 

Toward 
saw front

1-1/2"

Lock Nut

Both shock absorbers must 
be level with each other.
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Figure 7-60: Top View of Infeed Side Clamp Rollers

Figure 7-61: Adjusting Outfeed Clamp Shock Absorber

3-1/8”
unclamped

B
o

a
rd

 T
ra

v
e

l

2. Screw body in or out

3. Tighten jam nut

1.  Loosen jam nut
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Pneumatic System

The pneumatic system controls all of the components listed in Table 7-14.

There are multiple pneumatic regulators on this system. The main filter/regulator 
manages incoming air from the air source, keeping it at the pressure needed for 
the most demanding pneumatic components in the system. It is the only regulator 
than needs to be connected to an air source. Some components have their own 
regulator to further reduce the pressure. See Table 7-14 for the optimum pressure 
settings for each.
Table 7-14: Overview of Pneumatic Components

! CAUTION
HIGH PRESSURE HAZARD.
Bleed all pressure from pneumatic lines before performing 
maintenance on pneumatic components.
Pressurized components may move suddenly or vent air to 
atmosphere, causing injury.

Component Description PSI

Auto Deck Pusher Pushes each board onto thee load 
arms to be loaded onto the Infeed Rail.

110

Auto Deck Lumber Stops Provides separation between two jobs 
on Auto Deck conveyor.

Load Arms Loads the lumber from the lumber feed 
system onto the Infeed Rail.

Gripper Clamp Holds the end of the board as it is 
traveling along the Infeed Rail.

LASM Clamp Holds each board inside the saw 
chamber and delivers each cut piece to 
the outfeed clamp.

Infeed/Outfeed Air Knives Provides a curtain of air at the infeed 
and outfeed areas to contain dust.

Touch Screen Enclosure 
Cooler

Keeps the touch screen enclosure at a 
consistent temperature.

Side Clamp Holds the lumber from the sides while 
entering the saw chamber. 30 (clamp)

110 (unclamp)Top Clamp Holds the lumber from the top while 
entering the saw chamber

Outfeed Clamp Holds the lumber while exiting the saw 
chamber.

60 (clamp)

110 (unclamp)
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Removing Pressure from the Pneumatic System
Most procedures involving the pneumatic system require the removal of pressure. 
Use the following procedure to remove pressure from the system.

Figure 7-62: Pneumatic Airflow On and Off Positions

Maintaining the Filter / Regulators

Purchasing a Main Filter / Regulator

The filter/regulator can be purchased directly from MiTek. Refer to the Ordering 
Parts on page 216 for instructions on ordering parts.

Adjusting the Pressure on the Main Filter / Regulator

The pressure adjustment knob on the filter / regulator controls the operating 
pressure for the entire pneumatic system. The operating pressure for the 
pneumatic system should be set at 110 psi. Use the following procedure to adjust 
operating pressure.

1. Unlock the pressure adjustment knob on the Regulator by pulling it straight 
up.

Printer Prints identification on board for each 
cut piece using air powered print 
heads.

SETTING THIS PRESSURE HIGHER 
THAN RECOMMENDED WILL 
DAMAGE THE PRINT HEADS!

15

The system pressure should be set to 110 psi. If the system pressure drops 
below 75 psi, the machine software will display an error and the machine will 
cease operation.

Component Description PSI

Main Pneumatic Filter/Regulator
• Located on the outfeed end of saw.
• Yellow plate is shown in lockout posi-

tion. Place lock and tag through holes 
in yellow plate.

• Pneumatic lines will bleed naturally 
when yellow plate is in lockout position.

• Ensure gauge reads 0 before performing 
replacing a supply bottle for the printer 
or performing any maintenance!
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2. Turn the knob clockwise to increase pressure or counterclockwise to 
decrease pressure.

3. Once the gauge reads the desired pressure, push the knob downward to 
lock it in place

Figure 7-63: Pressure Adjustment Knob

Draining Condensation & Sludge from the Main Filter/Regulator

At the bottom of the main regulator’s filter is a condensation reservoir. In healthy 
pneumatic lines, only a few drips a day should expel from the lines. If excess 
water is gathering, investigate the reason for high condensation in the lines.

Open the valve shown in Figure 7-63 at the bottom of the reservoir every day to 
release condensation. It requires a 1/4 turn to completely open. After moisture has 
drained, close the drain and continue saw operation.

Replacing Filter Element on the Main Filter / Regulator

The main regulator uses a filter that must be replaced every 6 months. This 
filter can be purchased through MiTek. Refer to the Ordering Parts on page 
216 for instructions on ordering parts. Use the following procedure to replace a 
filter element.

1. Remove pressure from the lines by using the procedure in Removing 
Pressure from the Pneumatic System on page 152.

Some machine models may include a filter / regulator that drains automatically.

Pressure

Adjustment

Knob

Drain
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2. Remove the bowl from the regulator body by twisting counterclockwise 
while pushing up on the filter bowl. Then pull down to remove the filter 
bowl from the body.

Figure 7-64: Main Filter / Filter Regulator Bowl

3. Unscrew the filter element and remove it from the regulator. Be sure to 
keep the spring and any other parts resting in the filter element.

4. Place the spring (and any other parts removed) into the new filter element.

5. Screw the new filter element in its place.

6. Clean the bowl with mild soap and warm water.

7. Place the bowl back onto the regulator body by pushing up and turning 
clockwise. Make sure it is securely attached before returning pressure to 
the lines

8. Replace the filter element. Screw the black plastic baffle back into place. 

9. Place the bowl back onto the regulator body by pushing up and turning. 
Make sure bowl is secure and the blue tab is in the locked position before 
returning pressure to the lines.

Replacing Filter Element for Touch Screen Cooler

The touch screen enclosure cooler system uses the main regulator for system air 
pressure but it has a secondary filter. This filter can be purchased through MiTek. 

Bowl
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Refer to the Ordering Parts on page 216 for instructions on ordering parts. Use the 
following procedure to replace a filter element.

1. Lockout/tagout all saw systems 
(pneumatic and electrical).

2. Unscrew the filter element bowl.

3. Unscrew the filter element from the 
head.

4. Clean filter bowl with soapy water.

5. Clean or replace filter element:

6. Clean filter element with naphtha and 
let dry before re-installing, OR

7. Install new element.

8. Screw the filter bowl back into to place 
carefully to avoid stripping threads.

Adjusting the Main Pressure 
Sensor
The pressure sensor prevents the system from operating with inadequate air 
pressure. It sets the pressure at which the saw will no longer operate because it 
will not have enough pressure to perform its tasks. If the pressure drops below the 
minimum requirement, determine and fix the issue before attempting to cut 
boards.

The pressure sensor should not need to be adjusted under normal circumstances. 
However, knowing how to adjust this setting may assist in troubleshooting. Minor 

! CAUTION
FILTER ELEMENT BOWL MAY BE HOT! Wear gloves or 
wait at least 10 minutes after locking out power and air 
before unscrewing the filter element bowl.

Figure 7-65: 
Cooler Filter 
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adjustments can be made using an Allen wrench in the hole pointed out in 
Figure 7-66.

Figure 7-66: Pressure Sensor Adjustment on Main Filter/Regulator Assembly

Air Knives
This machine utilizes multiple air-knives to manage sawdust. For optimal 
performance, the air-knife must supply only dry air. If droplets of water are being 
ejected from the air-knife. the external pneumatic system that supplies air 
pressure to the machine may require adjustment or maintenance.

Figure 7-67: Air Knife Inside Saw Chamber

Shutoff
Valve

Bowl Holding
Filter Element

Drain

Pressure 

Switch
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Adjusting The Cabinet Cooler
The touch screen enclosure cooler maintains an appropriate temperature for all 
the machine PC. The cooler activates when a thermostat located inside the 
enclosure indicates that the interior of the enclosure is above a set point. The set 
point can be adjusted using the dial on the thermostat.

The touch screen enclosure thermostat should be set to 85-90 degrees 
Fahrenheit

Figure 7-68: Example of Cabinet Cooler and Paired Thermostat (left to right)

Clamps

Adjusting Clamp Speed

Side and Outfeed Clamps

The infeed side clamp and the outfeed clamp have a flow control valve on the 
cylinder to adjust the speed of the retract stroke.

Top Clamp

The top clamp, located on the infeed side of the saw, has a speed muffler to 
dump the air pressure. The screw at the bottom of the muffler can be adjusted 
to control how quickly the air is dumped. Move the screw out to increase the 
speed of the retract stroke or move it in to decrease the speed.

The clamp’s extend stroke uses all of the pressure passing through the 
clamp’s air regulator. There is no additional adjustment.
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Figure 7-69: Speed Muffler for Top Clamp

Aligning Outfeed Clamp

The outfeed clamp camfollowers must be parallel to the lumber exit chain at all 
times.

1. Mechanically adjust the clamp location using these steps. Steps for 
adjusting in smaller increments occur in the next step. 
• Set the lumber exit chain location EXACTLY as described in Lumber 

Exit Chain Positioning.

2. Use these steps to align the outfeed clamp assembly and sensors to 
accomplish these bullet points:
• Outfeed clamp assembly is parallel to the lumber exit chain.
• More than 2-1/2” gap between tip of chain teeth and edge of cam 

followers (with clamp fully retracted). This measurement will be refined 
with sensor location and shock absorber later.

• 1-3/8” or less gap when fully extended without board in it.
• Should have slight offset between front edge of outfeed clamp cam 

followers and front edge of powered skewed conveyor cam followers. 
This can be adjusted on the powered skewed conveyor.

3. To make adjustments, loosen the bolts circled in Figure 7-70 and adjust 
the entire clamp assembly so it is parallel with the lumber exit chain. 
Tighten the bolts securely when done.

The lumber exit chain MUST be parallel and 
1/16” forward of the LASM fixed jaw.
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Figure 7-70: Bolts Holding Outfeed Clamp Assembly

4. Adjust the outfeed clamp sensors so the clamp opens and clamps to the 
proper dimensions given previously.

Figure 7-71: Outfeed Clamp Adjustment

5. To adjust the outfeed clamp in small increments to reach the correct 
lumber channel, adjust the shock absorber as described in Figure 7-61.

Raising the Top Clamp

For ease of maintenance, the containing top clamp (infeed side) can be raised 
and locked into place when the saw is not operating. To raise and lock the 
assembly:

1. Open the saw chamber door.
• Note that opening the door will cause the air pressure to release and the 

top clamp to fall if it is unclamped position.

2. Ask another person to lift the top clamp to the unclamped (topmost) 
position.

3. With the other person holding the clamp in place, engage the lever inside 
the saw chamber on the infeed side (see Figure 7-72).

Outfeed Clamped Sensor Outfeed Unclamped Sensor

Shock
Absorber
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Figure 7-72: Top Clamp

Cylinders
The BLADE saw utilizes pneumatic cylinders for Infeed Rail load arms and 
various clamps throughout the machine. Observe the operation of pneumatic 
systems every 3 months and adjust as needed.

Adjusting Flow Control Valves

Both ends of some cylinders have flow control valves to adjust how fast the 
cylinders extend and retract. If cylinders with flow control valves move too slowly 
or quickly, adjust the flow control valves. The location of the flow control valve that 
needs adjustment depends on whether the cylinder is moving too quickly on the 
extending or retracting stroke.
Table 7-15: Adjusting the Flow Control Valves

Figure 7-73: Rod-End (Left) and Cap-End (Right) Flow Control Valves

Stroke Valve Location Increase Speed Decrease Speed

Extend Rod end of cylinder Turn the adjusting screw 
counterclockwise

Turn the adjusting 
screw clockwise

Retract Cap end of cylinder Turn the adjusting screw 
counterclockwise

Turn the adjusting 
screw clockwise
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Electrical System

Sensors Overview
A complete list of sensors is found in Table 7-16. They are arranged in 
approximate order from the infeed to outfeed side of the machine (facing the 
machine). Photos are shown on subsequent pages.
Table 7-16: List of Infeed Rail Sensors
Sensor Name Description See...

Load Arm Up Indicates when the load arms are up so lumber 
feed system will not advance.

Figure 7-74

Load Arm Down Indicates when the load arms are down so 
lumber feed system will advance.

Figure 7-74

Board Sensor 
(Load Arms)

Indicates that lumber is located at a position 
where the load arms will raise it on the next up 
movement.

Figure 7-74

Gripper Home Determines the position of the gripper during 
the homing process.

Figure 7-74

Gripper 
Unclamped

Indicates the gripper is not clamped. Figure 7-74

Board Slip Indicates if the board is tight against the gripper 
face.

Figure 7-74

Leading Edge 
Receiver

Works with the emitter sensor to determine the 
location of the leading edge of the board which 
is used in the board length measurement 
process.

Figure 7-74

Leading Edge 
Emitter

See Leading Edge Receiver description. Figure 7-74

Top Clamp Ski 
Sensor

Indicates the top clamp is clamped on a board. Figure 7-75

Top Clamp 
Clamped (EP/TC 
Bottom)

Indicates when the top clamp is fully clamped 
meaning there is no board present.

Figure 7-75

Top Clamp 
Unclamped (EP/
TC Top)

Indicates when the top clamp on the infeed side 
of saw is up.

Figure 7-75

Side Clamp 
Unclamped

Indicates when the side clamp on the infeed 
side of saw is open.

Figure 7-75

Elevation home Determines the position of the elevation during 
the homing process.

Figure 7-75

Stroke home Determines the position of the stroke during the 
homing process and that the saw is in a 
retracted position.

Figure 7-75
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Angle home Determines the position of the angle during the 
homing process.

Figure 7-75

LASM Lockout Prevents saw blade from moving when LASM is 
within sensor’s vision. Located on the 
stationary portion of the LASM assembly at the 
centerline of the saw blade. When LASM block 
is within the sensor’s vision, the saw blade will 
not move because of a collision risk, unless 
overridden by software.

Figure 7-76

LASM Home Determines the position of the LASM during the 
homing process.

Figure 7-76

Crooked Lumber 
Sensor (CLS)

Uses ultrasonic wavelengths to determine the 
location of the bottom of the board.

Figure 7-76

Bevel home Determines the position of the bevel during the 
homing process and that the bevel is close to 
square.

Figure 7-76

Outfeed Clamped Indicates when the outfeed clamp is clamped 
meaning there is no board present.

Figure 7-76

Outfeed 
Unclamped

Indicates the outfeed clamp is open. Figure 7-76

LASM Clamped Indicates that the LASM clamp is clamped, 
meaning there is no board present.

Figure 7-77

LASM Unclamped Indicates when the LASM clamp is open. Figure 7-77
Auto Deck Lumber 
Sensor (Optional 
Component)

Indicates there is a board present just behind 
the load arms by sensing the leading edge of 
the board. When the Auto Deck Lumber Sensor 
indicates a board is present, the system knows 
to index the board when the load arms clear of 
wood and are in the down position.

Figure 7-78

Auto Deck Pusher 
Extend/Retract 
(Optional 
Component)

Indicates the state of the lumber pusher on the 
Auto Deck (2 sensors). Retracted=Home, 
Extended=Pushed

Figure 7-78

Air Pressure Indicates if the system air pressure has 
dropped below the minimum requirement.

Adjusting the 
Main Pressure 
Sensor on page 
155

Sensor Name Description See...
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Figure 7-74: Infeed Rail Sensors

Gripper Home
Leading Edge 

Receiver (L) and Emmiter (R)

Gripper Unclamped

Board Sensor

Load Arm Down

Load Arm Up

Rear View Rear View

Board Slip
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Figure 7-75: Stroke/Elevation Chamber and Infeed Clamp Sensors

Top Clamp Clamped / Unclamped
(top to bottom)

Side Clamp Unclamped

Top Clamp Ski

Elevation Home

Angle Home

Stroke Home
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Figure 7-76: Saw Chamber and Outfeed Sensors

Bevel HomeBeve

Outfeed Clamped / Unclamped
(left to right)

CLS
(under LASM clamp)

LASM Home

LASM  Sensors
(see next page)

LASM Lockout
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Figure 7-77: LASM Clamp Sensors

Figure 7-78: Auto Deck Sensors (Optional)

Sensor Maintenance

Sensor Gaps for Prox Switches (Home Sensors)

The home sensors are all inductive proximity switches, also called prox switches. 
All prox switches should have an air gap between the sensor and the target of 

Clamped (Extend)
LED light is on
when sensor 
is active

Unclamped (Retract)
LED light is on
when sensor 
is active

act)

2-3/4"

3/4"

Measurements indicate correct
sensor placement

Auto Deck Pusher
Extend / Retract

Auto Deck
Lumber Sensor
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approximately 1/32".

Troubleshooting Home Sensors

See following procedures for instructions on troubleshooting home sensors.

Checking Inspection Points

1. Check for obstructions interfering with the sensor.

2. Ensure all prox switches have 1/32" air gap.

3. Ensure dust and debris is not in the way of the sensor or target.

Checking Communication Between the PLC and Sensor

Check the PLC input module to determine if the sensor is communicating with 
the PLC. The indicator light on the PLC should illuminate while the PLC is 
receiving data from the sensor.

Resetting the System

Ensure home position is correct by homing the axis or part in question. If the 
home position is not correct, the axis will hit a hard stop.

Does the Home Sensor Have Power and Functionality?

1. For inductive proximity switches (Home sensors):
a) From the touch screen on the operator interface, select Diagnostics > 

Detailed Diagnostics > any servo tab.

b) With one person watching the screen, have a second person place a 
screwdriver or anything with a steel or iron surface in front of the 
sensor.
1) If the sensor has an LED light, it should illuminate when the metal 

object is detected. If the light does not illuminate, there is either no 
power to the sensor or the sensor is broken. Check the wiring and 
points of power farther up the line to determine where power 
transmission ends.

! CAUTION

CRUSH OR CUT HAZARD!

Use extreme caution and effective communication when a 
second person is in the restricted zone.
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2) On the Detailed Diagnostics screen, the indicator next to the 
Home Sensor field should turn blue while the metal object is 
detected. If it does not, there is a communication issue.

2. For other sensors (not inductive proximity switches):
a) From the touch screen on the operator interface, select Diagnostics > 

Detailed Diagnostics > any servo tab..

b) With one person watching the screen, have a second person watch the 
sensor while the operator manipulates the saw so the sensor engages.

If the sensor has an LED light, it should illuminate when the sensor 
engages. If the light does not illuminate, there is either no power to the 
sensor or the sensor is broken. Check the wiring and points of power 
farther up the line to determine where the power transmission ends.

3. Find the source of the problem and resolve:
a) Try substituting the cable that plugs into the junction box.
b) Try substituting the sensor with a sensor from spare parts, or a 

different sensor on the saw, but only if they are identical sensors.

Adjusting & Troubleshooting the Crooked Lumber Sensor

The following instructions should be followed when:
• Parts are not accurate and the cause may be the elevation of the blade, OR
• The message Out of Range consistently displays in the CLS status menu 

(on the Home Screen Toolbar).

CLS Positioning

1. Move the LASM away from the CLS using the indicator menu on the Home 
Screen.

2. Remove top plate from CLS by removing the two bolts on top of the CLS 
housing.

! CAUTION

CRUSH OR CUT HAZARD!

Use extreme caution and effective communication when a 
second person is in the restricted zone.

A working CLS makes a constant clicking sound.

Straight 2x4x8 
or longer
Plumb bob
Round bubble 
level
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3. Calibrate the CLS.
a) Go to Tools > Calibrate from the operator interface.
b) Follow the on-screen instructions and select Make Alignment Cut.

4. Lockout/tagout.

5. Drop a plumb bob over the board and down just above the bubble level. 
Make sure the string from the plumb bob is in the newly cut slot in the 
board.

6. The sensor must be positioned so that it is centered on the blade, bubble 
level, and the board. Use the bubble level and plumb bob as devices to 
achieve positioning of the CLS. Figure 7-79 shows the adjustment bolts on 
the CLS.

Figure 7-79: CLS Adjustment Bolts

Determine if CLS is Working

1. Move the LASM away from the CLS so it doesn’t interfere with the test.

2. Place a straight 2x4x8 or longer on the Infeed Rail and slide it into the saw 
chamber.

3. Unclamp and clamp the infeed and outfeed clamp (using indicator menus 
on Home Screen) so the board is firmly clamped in both.

4. Go to Diagnostics > Detailed Diagnostics > CLS tab.

5. Note the exact reading in the Current Reading field called out in Figure 7-
80.

6. Press the Calibrate button. If the CLS is operating and adjusted correctly, 
the following should be true:
a) The field labeled Current Reading in Figure 7-80 should change by

.02 or less.
b) The field labeled Current Reading in Figure 7-80 should be near 0.

Top
Plate

Adjust 
side-to-side 
and angle

Adjust
in/out

Straight 2x4x8 
or longer
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Figure 7-80: Diagnostics > Detailed Diagnostics > CLS Screen

Testing the Elevation and CLS Communication

1. Place a 2x4x6 or longer on the Infeed Rail and slide it into the saw 
chamber while still holding onto the end sticking out of the saw chamber. 
Ensure it is covering the CLS.

2. From the saw’s operator interface, go to Diagnostics > Detailed 
Diagnostics > CLS and click the Enable button under Elevation 
Following.

3. Test the following steps and results:
a) Lift the infeed end of the lumber. It should result in the blade elevation 

rising.
b) Set the lumber down in its original position. It should result in the blade 

elevation lowering. 
c) The elevation status menu (on the Home Screen indicators) should 

display Enabled Homed.

4. If the blade elevation moved as expected:
a) Wait for the blade elevation to settle (should not take more that 15 

seconds). Once settled, monitor the blade elevation for 10 minutes. 
b) During this period there should be no movement of the blade elevation. 

If there is movement, then remove the wire connection (unscrew the 
metal ring on the end of the cable at the sensor) from the bottom of the 
sensor. Using high-quality, dry compressed air, blow out the connector 
on the wire and on the sensor. Replace the wire on the sensor and 
repeat the test. If the test continues to fail contact Automation Support.

Straight 2x4x8 
or longer
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Auto Deck Lumber Sensor Adjustment

See the Auto Deck Lumber Sensor manual for information on how to adjust this 
sensor.

Main Electrical Enclosure
The major electrical components located in the top and bottom halves of the main 
electrical enclosure are shown in Figure 7-81 and Figure 7-82.For other 
components not named here, see the Main Electrical Enclosure drawing listed in 
Drawing Set on page 217. 

Figure 7-81: Electrical Enclosure (Top Half)

https://www.mitek-us.com/wp-content/uploads/2023/12/Lumber-Sensor-for-Auto-Deck-Manual.pdf
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Figure 7-82: Electrical Enclosure (Bottom Half)

VFD (Variable Frequency Drive)

A VFD is an important part of several electrical circuits in the BLADE saw. 
Verifying the voltage in and out of the VFD is always a good first step in the 
electrical troubleshooting process. See Figure  for the location of each VFD 
located inside the main electrical enclosure.

If the VFD experiences a fault, the error code will 
display on the VFD display (Figure 7-83).  For help 
troubleshooting VFD faults, call MiTek Automation 
Support.

Safety Controller

The safety controller is located inside of the control 
enclosure. Please contact Automation Support for 
assistance with safety controller issues.

PLC (Programmable Logic Controller)

The PLC is located inside of the bottom half of the 
main electrical enclosure. Please contact Automation 
Support for assistance with clearing unknown faults.

NOTICE
Do not modify any parameters on any VFDs unless instructed by 
Automation Support

PLC

Figure 7-83: VFD Fault

Automation 
Support is 
available at 
800-523-3380

https://www.mitek-us.com/wp-content/uploads/2021/08/TASS-ACS380-VFD-Firmware-Manual-509363-364-reduced.pdf
https://www.mitek-us.com/wp-content/uploads/2021/08/TASS-ACS380-VFD-Firmware-Manual-509363-364-reduced.pdf
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Select Component Overview and Maintenance

Gripper
The gripper is the assembly that moves the lumber along the Infeed Rail.

Cleaning the Gripper

Use a pick or wire brush to clean the grooves on the gripper finger and gripper 
clamp every month (1 shift) or every 2 weeks (2 shifts).

Figure 7-84: Gripper Finger and Clamp Grooves

Manually Turning the Gripper Belt to Find Obstructions

If you need to manually move the gripper to remove an obstruction or 
troubleshoot, the gripper belt can be jogged from the saw’s operator interface.

From the Home Screen, select the Gripper indicator and choose one of the Jog 
options. Move the gripper assembly back and forth to test the belt tracking. Adjust 
if necessary.

If the gripper becomes difficult to move, refer to Troubleshooting appendix on 
page 174.

Removing Top Gripper Assembly

Occasionally, during maintenance of the gripper and belts, you may need to 
remove the top gripper assembly.

1. Position the gripper assembly so the screws labeled A in Figure 7-85 are 
accessible.

2. Lockout/tagout.

Gripper 
Clamp

Gripper 
Finger
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3. Remove the back panel.

4. Remove the stop bar by removing the 3 socket head screws on top.

5. Remove the 4 flat head screws labeled A.

6. Slide the gripper assembly, following the instructions on Linear Guide 
Bearings on page 177 to prevent the bearing balls from falling out of the 
linear guide bearing block. 

Figure 7-85: Gripper and Belt Assembly, View from Back Side

Outfeed Assembly
The outfeed assembly consists of the following:

• A pneumatically powered outfeed clamp with camfollowers at the bottom 
edge

• A lumber exit chain

If the board is long enough, the outfeed clamp holds the end of the board during 
the cut. It then opens while the LASM moves the finished part farther into the 
outfeed chamber. The outfeed clamp then closes again to push it against the 
lumber exit chain, and the lumber exit chain pulls the finished part out of the saw 
chamber and pushes it onto the outfeed table or conveyor.

Timing Belt

Stop Bar

Move gripper assembly so
Screws A are accessible.

Screws A

Back Panel
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Figure 7-86: Outfeed Assembly Overview

Pull-Cord E-Stop
A properly tensioned pull-cord will trip the E-stop switch when someone pulls it to 
approximately 1 in. from its rest position.

Resetting the Pull-Cord Switch

Once a cable is pulled, the red light on the pull-cord switch that was activated 
illuminates. Reset the E-stop circuit by pressing the pull-cord Reset button. The 
pull-cord Reset button is labeled in Figure 7-87. The reset action must occur at the 
same switch that was activated.

Adjusting the Pull-Cord Tension

To align the perimeter safety cable tension, turn the adjusting nut until the switch 
is centered in the switch alignment indicator.

Bearing
(4 places)

Shock
Absorber

Cylinder

Location of
Screws
Holding

Assembly
(4 places)

Rail
(2 places)

Camfollower
Assembly

Back Side of Outfeed Clamp

Outfeed Assembly
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Figure 7-87: Pull-Cord Switch Overview

Skewed Conveyor
The Skewed Conveyor is one of the outfeed components that can be paired with 
the BLADE saw. It is a powered conveyor that drives the lumber away from the 
outfeed side of the machine to be offloaded or directed onto other conveyors.

Aligning the Skewed Conveyor

The side skatewheel fence and lumber guide assembly must be parallel with each 
other. The gap should allow the exiting lumber to travel freely without rubbing hard 
on either side.

1. A properly aligned skewed conveyor should meet the following criteria:
• It should measure 2-1/2" skatewheel to skatewheel.
• The skatewheels on the front side of the Skewed Conveyor (closest to 

the operator) should be even with and in-line with the tips of the outfeed 
chain.

• The skatewheels on the back side of the Skewed Conveyor (the side 
farthest away from operator) must be slightly farther back than the 
outfeed clamp rollers when retracted.

• Skewed conveyor rollers should be slightly lower than exit ramp roller on 
the saw.

2. If needed, adjust the Skewed Conveyor side guide location:
• The short side of the Powered Skewed Conveyor fence is adjustable. 

The long side is fixed.
• Depending on which option you have, adjust the short side to the right 

depth and/or move the entire Powered Skewed Conveyor using the slots 
in the feet.

After resetting the pull-cord switch, the RESET button on the 
operator interface panel must also be pressed before the saw will 
operate.

Reset
Button

Illuminates
When Reset

is Needed
(if equipped)

E-Stop Pushbutton

Turn to 
Adjust

Tension

Switch
Alignment
Indicator

If saw will not operate, 
the switch may need to be re-aligned!
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Component Replacement

Linear Guide Bearings
To replace a linear guide bearing, order the appropriate kit listed in Table 7-17
Table 7-17: Parts in SB209 Kits.

1. After locking/tagout out, remove the previously used bearing block:
a) Unscrew the 4 screws from the plate. Keep the screws to use later.
b) Slide the bearing off of the rail. Be sure to keep the bearing level to 

prevent the ball bearings from falling out.

2. Discard the previously used bearing, but NOT the screws.

3. Examine the new bearing block. The grease fitting must be securely 
attached to the bearing block. If it is loose in the box, connect it using 
these steps:
a) Clean dust, metal shavings, and oil off the hole threads. Use a 

standard brake cleaner or anything that removes lubrication.
b) Screw the fitting into the bearing block as shown in Figure 7-88. 

Ensure the fitting is facing a direction that allows it to be easily 
accessed later. The direction the fitting should face depends on its 
location on the saw, so visualize its location carefully before installing 
the fitting.

Applicable Kit Grease (not 
supplied)

SB209KIT-A (size 25) for LASM, Stroke, & Elevation 0.8 cm3

SB209KIT-B (size 20) for Gripper, Infeed Top Clamp, Infeed Side 
Clamp, and Outfeed Clamp

0.5 cm3

Hex key set
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Figure 7-88: Important Parts of Each Bearing Block

4. Clean oil and debris off of the parts listed below. A standard brake cleaner 
or anything that removes lubrication will work.
a) On the new bearing, with the block insert in place to protect the ball 

bearings, carefully clean the threaded screw holes. Do not get cleaner 
in the ball bearing area.

b) Clean the screws that were removed from the old bearing block.

5. Install the new bearing block with the fitting facing out, so it will be 
accessible to grease in the future.
a) Slide the bearing block onto its rail, allowing the rail to push the block 

insert completely out of the bearing block. 
b) Slide the bearing block down until it is behind the linear guide plate and 

the holes are aligned.
c) Using the screws removed from the previously used bearing block, 

apply blue Loctite™ thread adhesive to each screw, and then screw 
the plate and bearing block together.

d) Wait 10 minutes for the Loctite thread adhesive to dry before moving 
the assembly. 

NOTICE
Use Loctite thread adhesive to prevent the bearings from 
coming loose, causing costly machine damage. The 
bearings are shipped with NO grease in them. They MUST 
be greased before operating the saw!

Holes for attaching to plate are on opposite side.

Block Insert

Size 20 Bearing

Size 25 Bearing

Block Insert

Holes for
attaching to plate.

Grease fitting 
must be accessible
after installation.

Grease fitting 
must be accessible
after installation.

Make sure the 
grease fitting is 
pointing out, so it 
is easily 
accessible.
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6. After the Loctite thread adhesive is dry, apply the correct amount of grease 
to the fitting. See Lubricating the Linear Bearings on page 129 for detailed 
instructions.

7. Remove the lockout/tagout mechanisms.

8. Run the saw for several minutes, then lockout/tagout again and look at the 
rail. Check to see if a lubricant film can be seen on the rail. If not, add more 
grease.

Outfeed Clamp Cam Follower
1. Remove all of the cam follower assemblies from the old outfeed clamp 

assembly so they can be reused:
a) Loosen and remove the nut shown in Figure 7-89.

Figure 7-89: Cam Follower Replacement

b) Catch the cam follower (with grease fitting attached) as it falls out 
when the nut is removed. Repeat for all cam followers.

2. Install cam followers into the new outfeed clamp assembly:
a) Using the same hardware, place a washer over a cam follower shaft.
b) Place the cam follower shaft through a hole in the new outfeed clamp 

assembly, place a lock washer over the top of the shaft and screw on 
the nut. Tighten the nut with a hex socket. The shaft has a flat surface 
to prevent it from spinning while tightening the nut. Repeat for all cam 
followers.

Nut
Washer

Cam
Follower
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Outfeed Clamp Assembly

Removing the Outfeed Clamp Assembly

If there is ever a need to remove or replace the entire outfeed clamp assembly, 
familiarize yourself with Figure 7-86 on page 175 to assist in following these 
steps.

1. Verify the LASM is all the way toward the infeed side of the saw chamber 
and the electrical power is locked and tagged out.

2. Remove the guards shown in Figure 7-90 with a hex key.

Figure 7-90: Remove These Guards

3. Remove the 2 sensors shown in Figure 7-91 from the outfeed clamp 
cylinder as described:
a) Mark each sensor to identify it as outfeed fully clamped and outfeed 

unclamped.
b) Document how the wires are attached to the sensor so it can be re-

attached in the same way.
c) Inspect the wires and connection to the sensors.

Figure 7-91: Label and Remove These Sensors From the Cylinder

4. Blow off the entire area to facilitate the rest of this procedure.

1

2

Outfeed

Unclamped

Outfeed

Fully Clamped
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5. Remove the 4 socket-head cap screws shown in Figure 7-92 with a hex 
key and remove the lock washers. These can be discarded.

6. Lift off the entire outfeed clamp assembly.

Figure 7-92: Screws Requiring Attention 

Installing the Existing Outfeed Clamp Assembly (2016)

1. Measure the fixed jaw of LASM to ensure it is at least 1-1/2" thick. If worn 
to less than that, replace it before making final adjustments to the Outfeed 
Clamp.

2. Align the lumber exit chain EXACTLY as described on Lumber Exit Chain 
Positioning on page 138.

3. Attach the new outfeed clamp assembly to the saw by following these 
steps:
a) Set the outfeed clamp assembly in place, making sure not to damage 

the wires, sensors, or air lines.
b) Place the four (4) 3/8-16x1-3/4" screws and lock washers provided at 

the locations show with arrows in Figure 7-92.
c) 3 of the 4 Stand-Off Set Screws are preset. Adjust the 1 Stand-Off Set 

Screw indicated in Figure 7-92 until it bottoms out on the base face 
and stop. Do not adjust the other 3 Stand-Off Set Screws.

d) Lock the jam nut in for the Stand-Off Set Screw circled in Figure 7-92.

4. Align the outfeed clamp assembly EXACTLY as described on Aligning 
Outfeed Clamp on page 158.

! CAUTION
2-man lift required to safely lift the outfeed assembly! It may 
weight as much as 120 lb.

Standoff
Set Screw 
to Adjust

Jam Nuts for 
Screws Holding 
Assembly

If the frame 
does not have 
alignment holes, 
SB220KIT that 
was sent to all 
existing saws in 
2016 has not 
been installed 
correctly. Locate 
and install 
SB220KIT. 
SB220 
instructions can 
be found on the 
MiTek web site.
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5. Make adjustments in small increments by adjusting the shock absorber as 
shown on Adjusting a Shock Absorber on page 149.

6. Place a board in the LASM and outfeed clamp, then manually clamp both. 
Ensure the board is securely clamped, verify all rollers and cam followers 
engage, and everything is aligned.

7. Once everything is aligned, pin the assembly to keep it from slipping.
a) Pick any of the three existing outfeed clamp alignment holes shown in 

Figure 7-93 and drill a through-hole through the frame directly behind 
the existing alignment hole. Use a 3/16" drill bit.

b) Repeat at the alignment holes on the other end of the outfeed clamp.
c) Place a pin in the newly drilled hole on each end to keep the outfeed 

clamp assembly from slipping on the saw frame.

Figure 7-93: Place Pin in Alignment Hole

8. If your system includes a Skewed Conveyor, it is important that it aligns 
perfectly with the outfeed assembly on the saw EXACTLY as described on 
Aligning the Skewed Conveyor on page 176.

9. Install the sensors. They are shown in Figure 7-91. Refer to the electrical 
drawing located in your Equipment Manual if necessary.

Alignment

Holes
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Saw Blade Motor Power Cable Replacement
Contact MiTek Automation Support to Order SB204KIT. See the service bulletin 
section of the MiTek website for further instructions.

Waste Conveyor Belt
The waste conveyor belt should be replaced about every 3 years, depending on 
use and maintenance. Use the following steps as a guide for replacing the main or 
optional belt.

1. Run the waste conveyor until the lacing connection is near the head roller 
at the drive end.
a) In the BLADE software, go to Diagnostics > Detailed Diagnostics > 

Machine tab
b) Turn the waste conveyor on and off with the button by Waste 

Conveyor.

2. Turn off all power to the saw, following approved lockout/tagout 
procedures.

3. Remove the old belt by following these steps:
a) Relieve the tension on the belt using the tensioning bolts. See 

Adjusting Waste Conveyor Belt Tension on page 142.
b) Remove the end washers (if present), then remove the wire that is 

threaded through the lacing. Save the wire for reassembly.
c) Remove the old belt.

4. Clean the sawdust and chips from the entire length of the metal conveyor 
bed.

5. Install a new belt by following these steps:
a) Thread the belt as shown in Figure 7-94, keeping the lacing connection 

near the head roller. 

Figure 7-94: Path for Conveyor Belt

b) Bring the belt together so the lacing intermeshes, and slide the rod or 
wire through the lacing as shown in Figure 7-95.

To pull the new 
belt through the 
machine more 
easily, thread 
the new belt to 
the old one and 
pull it through 
the machine. 
This will help 
thread the belt 
into the rollers 
on the bottom.

approx.

1-3/16”

New

Roller #1

New

Roller #2

Belt

https://www.mitek-us.com/resources/machinery/service-bulletins/
https://www.mitek-us.com/resources/machinery/service-bulletins/
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Figure 7-95: Connecting Wire on Belt

Figure 7-96: Two Different Connecting Wire Styles

6. Adjust the belt tension evenly at the head roller adjusting bolts. See 
Adjusting Waste Conveyor Belt Tension on page 142.

7. Run the conveyor for at least 5 minutes and check the belt tracking. If the 
belt does not track correctly, follow the instructions on Adjusting Waste 
Conveyor Belt Tracking on page 142.

or
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TROUBLESHOOTING

Navigating the Troubleshooting Appendix
The troubleshooting appendix is divided into tables according to system of the 
BLADE saw that is experiencing problems. See Table 8-1 for a list of systems.

Table 8-1: Troubleshooting by System

If you have reviewed the information in the Maintenance chapter and this chapter 
but have not solved your problem, please call MiTek Automation Support for 
assistance. 

System Page

Mechanical 189

Pneumatic 194

Electrical and Software 196
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Getting Started with Troubleshooting

Safety Notes for Troubleshooting
Read the safety section starting on page 1. The safety test procedures in the 
safety section MUST be performed by qualified personnel after ANY 
maintenance, adjustment, or modification. Note these safety reminders:

! WARNING
ELECTROCUTION, HIGH PRESSURE, CRUSH, CUT, AND 
CHEMICAL HAZARDS
Read this section AND the safety section in the preliminary pages 
before operating or maintaining this equipment.
Do not operate this machine until you have a thorough 
understanding of all controls, safety devices, E-stops, and 
operating procedures outlined in this manual.
Read and observe all hazard instructions. Failure to do so may 
result in economic loss, property damage, and/or personal injury. 
This manual must always be available to personnel operating and 
maintaining this equipment.

! CAUTION
Always lockout/tagout unless it is absolutely necessary to have 
an energized machine for troubleshooting.
This icon indicates that you must lockout/tagout at the 
appropriate disconnect switch using approved methods 
described in OSHA CFR 1910.147 before continuing with the 
procedure. In the absence of this icon, it is still your responsibility 
to lockout/tagout when possible.
If it is absolutely necessary to troubleshoot an energized 
machine, follow NFPA 70E for proper procedures and personal 
protective equipment.
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Tools Required
When the toolbox shown in the margin appears, you should gather the tools listed 
below it before beginning the procedure next to which it appears.

Before beginning the troubleshooting process or calling MiTek Machinery Division 
Customer Service, gather the following tools:

• Insulated slotted screwdriver
• Insulated Phillips screwdriver
• Equipment manual and drawings, including any electrical schematics
• Pen and notepad
• Multimeter

A multimeter is an electronic measuring instrument. The analog versions 
were referred to as a volt-ohm-meter (VOM). Digital models are referred to 
as digital multimeters (DMM). Your multimeter should have the following 
features:
• Voltage (volts) measurement
• Resistance (ohms) measurement
• Current (amps) measurement
• Ability to measure both AC and DC power
• Autoranging feature

• PPE as required by NFPA 70e
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First Steps

Mechanical Troubleshooting

Always clean and lubricate the equipment as a first step in most troubleshooting 
processes. Most mechanical malfunctions are caused by inadequate preventive 
maintenance.

Electrical Troubleshooting

1. Lockout/tagout at the disconnect switch located on the equipment.

2. Vacuum and dust the electrical enclosure.

3. Remove the lockout/tagout equipment and attempt to run the BLADE saw 
again. If that did not solve the problem, proceed with the next step.

4. Adhere to all regulations and guidelines given in NFPA 70e and in your 
company’s energy control program.

5. Determine where the electrical problem begins. To do this, you need a 
multimeter.
• Determine if you are working with AC (alternating current) or DC (direct 

current) before checking voltage.
• Measure incoming and outgoing voltage to and from components. 

Proceed in a logical order determined by your machine’s specific 
problem, and write down the order that you check each component and 
the amount of voltage that the multimeter registers.

NOTICE
Never use compressed air inside an electrical enclosure. It may 
force contaminants into electrical connections.
Use a vacuum to remove dust from electrical enclosures. Canned 
air is acceptable after vacuuming.

! WARNING
ELECTRICUTION HAZARD.
All electrical work must be performed by a licensed electrician.
If it is absolutely necessary to troubleshoot an energized 
machine, follow appropriate guidelines.



BLADE SAW: TROUBLESHOOTING

Should you lockout/tagout to perform this action safely?

Original Instructions: 001080 rev. B 189

Mechanical Problems and Solutions
Problem Possible cause Possible solution Page

Angle: Straight cuts come out 
the correct length, but my 
angled parts are off.

Calibration needed Run auto calibration on the 
angle and elevation.

92

Auto Deck: Auto Deck not 
advancing the board correctly 
onto the load arms

Sensor issue Adjust the location of the Auto 
Deck Board sensor.

166

Auto Deck: Auto Deck load 
arms are not moving down far 
enough to accept lumber.

Alignment issue Adjust the entire square tube 
that holds the load arms by 
loosening the hex nut.

Auto Deck:  Lumber catching 
on load arms and not feeding 
onto Infeed Rail correctly

Auto Deck chain is loose Tighten the Auto Deck chain 
tension.

139

Auto Deck: More than 1 board 
is being loaded onto the Infeed 
Rail at a time.

Too many boards, not using 
lumber stops

The Auto Deck may be 
overcrowded. Remove excess 
boards. Use the lumber stops 
to limit the number of boards 
being indexed.

85

Sensor issues Adjust the Auto Deck Board 
sensor position.

166

Axis: An axis is not moving Accumulation of dust and 
debris, machine not cleaned 
regularly

Clean equipment at intervals 
recommended in maintenance 
checklist

211

Obstruction Look for wedges, fallen tools, 
or other parts impeding 
movement of the machine

Cable / connector issue Check for secure connection of 
all related cables

Lubrication needed, machine 
not lubricated regularly

Lubricate equipment at 
intervals recommended in 
maintenance checklist

211

Axis: Stroke axis error state Calibration needed Calibrate stroke axis 92

Stroke travel bottoming out Set minimum position to 1.25 in 
Detailed Diagnostics screen.
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Board: No board was detected 
during the measuring process.

Gripper issue Check that the board is 
properly clamped in the gripper

Calibration needed Calibrate gripper, and let saw 
measure again, checking that 
board is in gripper properly

92

Correct length wasn’t entered 
in software

Enter correct length

Leading edge sensor did not 
activate

Try adjusting the Leading Edge 
Sensor (emitter or receiver) in 
Tools > Options > Saw > 
Edge Detector Beam Sensor

Board: My straight cuts come 
out the correct length, but my 
angled parts are off. The actual 
angle is not what the screen is 
telling me I should have.

Incorrect elevation value Cut a type 2 part with a 45 
degree angle from the Key In 
Parts screen. Increase the 
elevation value by amount that 
you are short or vice versa.

80

Calibration needed Check the angle calibration 
and recalibrate if necessary.

92

Board: The last part of my 
board is always short but the 
blade was making a trailing cut.

The main regulator is not set to 
the correct pressure

Set the main regulator to 110 
psi and verify the saw is 
consistently receiving 110 psi

152

LASM teeth wear Replace the LASM teeth if 
showing wear.

147

LASM inches per count issue Check the LASM inches per 
count through auto-calibration.

92

Board: The length for the last 
part on my board is wrong.

Insufficient pressure Check the last part on the 
board. There should be a mark 
from where the gripper 
clamped onto the board if the 
end of the board was cut 
square. If there is any 
indication of the board slipping 
(ex: a long scrape mark), the 
gripper clamp pressure may 
need to be increased.

151

Calibration needed The gripper home position is 
incorrect. Auto-calibrate the 
gripper.

92

Problem Possible cause Possible solution Page
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Board: I am getting random 
lengths off by 1/8" up to 1"

Calibration needed Verify the gripper and LASM 
home positions and inches per 
count by running auto-
calibration.

92

Insufficient pressure The gripper or LASM may be 
slipping. Check that the 
regulators are set correctly.

151

LASM teeth wear Replace the LASM teeth if 
showing wear.

147

Collision: Receiving frequent 
messages that saw blade will 
contact LASM in Auto Mode.

Incorrect LASM Max Position 
value

Check that the LASM Max 
Position is set to 12 inches 
(305 mm) or higher.

LASM misalignment Check that LASM is aligned 
properly: Notch in center of 
LASM should align with saw 
blade when LASM is at 0 
position.

100

E-stop: Pull cord activates 
itself or will not reset

Accumulation of dust and 
debris

Blow dust out of sensor with 
canned air and check cable 
connections. 

Pull-cord misalignment Check alignment (centering) of 
pull-cord switch.

175

Gripper: My parts are off 
roughly 3/8 of an inch 
consistently.

The belt has jumped a cog on 
the pulley. 

Calibrate the gripper. 92

The white gripper timing belt 
may be set too loose. 

Re-tension the belt. 140

Gripper: The gripper is hitting 
an obstruction when none can 
be seen.

The gripper is hitting the infeed 
side clamp rollers.

Adjust the position of the 
infeed side clamp rollers

150

Tight spots in the gripper belt. Manually move the gripper to 
find tight spots in the belt. 

173

Gripper: When the gripper 
goes back to accept the 
maximum length board the 
gripper jams. (Or the wood 
lands on top of the gripper 
assembly.)

Calibration needed Check the gripper home 
position, counts per inch, and 
maximum position by running 
auto-calibration.

92

Problem Possible cause Possible solution Page
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Gripper: Gripper won't move. Obstruction Clear obstructions

Accumulation of dust and 
debris on Infeed Rail

Clean Infeed Rail 211

Linear guide bearing 
lubrication needed

Linear guide bearings may not 
be properly working. Check 
lubrication and physical 
condition of bearing block and 
rails. Replace bearing block if 
uncertain of age.

129

Error state Check the status banner for 
error states and address

72

Gripper: Receiving home Z 
pulse errors.

Calibration needed Calibrate the gripper. 92

Gripper motor coupling is loose Check torque values for 
gripper motor

111

Gripper belt tension Check the tension of the white 
gripper timing belt

140

Miscellaneous If needed:

1. Remove the white gripper 
timing belt.

2. Check linear bearings to 
ensure the entire assembly 
is not sagging.

3. Remove the screws 
holding the gripper to the 
bearings.

4. Add thread adhesive 
(Loctite) and install the 
screws back in place.

5. Adjust gripper home 
sensor air gap to 1/32”.

6. Calibrate gripper again.

LASM: Saw blade cut through 
the LASM jaw.

Miscellaneous Contact Automation Support 
immediately

46

Lumber Feeding: Lumber 
clips the saw entrance ramp

Infeed Rail lumber surface is 
below the entrance ramp.

Level the Infeed Rail to the 
saw.

Lumber Feeding: Lumber not 
entering saw chamber straight

Gripper and LASM 
misalignment

Ensure Gripper finger is in the 
same plane (straight with) the 
LASM fixed jaw for the Infeed 
Rail’s entire length.

Problem Possible cause Possible solution Page
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Outfeed: Outfeed chain 
binding

Obstruction Look for broken bolts or plastic 
obstructing the chain.

Lumber exit chain tension Check lumber exit chain 
tension.

138

Skewed Conveyor: Skewed 
conveyor rollers slow to reach 
full speed.

Skewed conveyor belt is loose Tighten skewed conveyor belt 137

Problem Possible cause Possible solution Page
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Pneumatic Problems and Solutions
Problem Possible cause Possible solution Page

Air: My saw keeps shutting off 
saying that I don't have enough 
air pressure.

The main regulator is not set to 
the correct pressure

Set the main regulator to 110 
psi and verify the saw is 
consistently receiving 110 psi

152

The pressure sensor is not set 
the correct minimum pressure

Set the pressure sensor to 75 
psi

155

Part failure Replace pressure switch, 
regulator, or seals in filter/
regulator assembly

Customer air supply not 
sufficient or functioning 
properly

Work with Automation Support 
and vendor to troubleshoot 
issue

Clamp: Infeed side or top 
clamp is not working.

Obstruction Check for obstructions.

Insufficient pressure Check system pressure (main 
regulator) and secondary 
regulator for clamp to ensure 
correct air pressure.

151

Shock absorber issue Check the shock absorber and 
tighten or replace as needed.

148

Coil issue Determine if coils are working 
by checking LEDs on coils as 
you clamp and unclamp.

Incorrect sensor placement Fully Clamped Sensor may be 
activated too early if not 
positioned correctly. Reposition 
the sensor.

Linear guide bearing 
lubrication needed

Linear guide bearings may not 
be properly working. Check 
lubrication and physical 
condition of bearing block and 
rails. Replace bearing block if 
uncertain of age.

129

Clamp: LASM unclamp times 
out and displays error

Incorrect sensor positioning Check position of the extend 
and retract sensor on actuator. 
Tighten all bolts.

166

Printer: No printout and no 
clicking sound heard from head 
during printout.

Power issue Ensure the print controller is 
receiving power and that it is 
enabled in the software.

Cable / connector issue Ensure print head cable is 
connected.
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Printer: No printout or poor 
printout quality but clicking 
sound is heard from head 
during printout.

Tubing issue Ensure hose from ink bottle is 
connected and ink bottle is full. 
Check hose for blockage.

Software issue Dot size must be within 
acceptable range.

122

Printer hardware Clean or replace ink filter.

Air pressure setting Verify printer regulator is set to 
12 psi

151

Printer: Print head won’t print Miscellaneous Check ink supply, clean nozzle, 
purge and flush, and check 
clogs in line.

121

Cable / connector issue Check gripper encoder and 
cable.

Printer: My printing has a 
blank line through the middle of 
it. It's not printing properly

Standard maintenance needed Flush and clean the printers. 121

Problem Possible cause Possible solution Page
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Electrical and Software Problems and Solutions
Problem Possible cause Possible solution Page

Auto Deck: Auto Deck is not 
running

VFD Issue Check the Auto Deck’s variable 
frequency drive (VFD) to see if 
its in remote mode or 
displaying other errors. The 
VFD is located in the control 
panel on the Auto Deck. Check 
the wires from the motor to the 
VFD.

Auto Deck: Auto Deck VFD 
Error

Chain tension may be too tight Loose auto deck chain tension 139

Outfeed: Outfeed timeout 
failure state

Obstruction Short Wedges may be stuck 
between the two outfeed 
rollers. Remove and retry.

Miscellaneous Adjust the outfeed clamping 
roller sensor.

Align and/or tighten the lumber 
exit chain.

If the problem persists, the 
following tips will help further 
troubleshooting:

1. When a board is clamped, 
the lights on both sensors 
(extend and retract) should 
be off.

2. When the clamping rollers 
are at full extend (without 
wood), the light on the 
extend sensor should be 
on.

When the clamping rollers are 
fully retracted only the retract 
sensor light should be on.
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Sensor: Sensor faults Faulty writing, loose 
connections

Check for faulty wiring and 
make certain all connections 
are secure

Sensor not properly aligned Properly adjust sensor

Sensor covered by dust, 
machine not cleaned regularly

Clean equipment at intervals 
recommended in maintenance 
checklist

211

Inadequate dust collection 
system

Install adequate dust collector

Sensor: CLS not working Miscellaneous Check that the housing and 
bracket are in good condition 
to protect the CLS and keep it 
in place.

Check that the CLS cable is 
securely connected.

Check the CLS positioning.

Check that CLS is receiving 
power and sensor is working 
(check positioning first).

Check that the CLS and 
elevation are communicating.

168

Sensor: Loss of encoder error 
state

Encoder and coupler contact Adjust the in/out adjustment 
bolts to prevent the encoder 
from making contact with the 
coupler.

Sensor: Sensor is not working 
or component controlled by a 
sensor is not responding 
properly

Miscellaneous Refer to the systematic 
troubleshooting procedure.

166

Sensor: Component timing 
out.

Sensor issue Check location of extend and 
retract sensors.

161

Software: Software button or 
field is grayed out

Incorrect mode selected Check that the Auto/Manual 
switch is in the correct position.

Miscellaneous Carry out quick software 
troubleshooting

83
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Software: Some status 
indicators are red

Software issue Click on red indicator and 
check if bottom menu item 
says Enabled Not Homed or 
Enabled Homed. After homing 
the system, it should say 
Enabled Homed. If not, 
investigate obstructions, 
lubrication, and other 
mechanical reasons.

Software issue Select CLEAR ERRORS on 
Toolbar.

Software issue Select HOME SYSTEM on 
Toolbar.

Software: Visualize screen is 
not working.

Software issue Open Diagnostics > Visualize 
screen prior to pressing the 
START CUTTING button.

Software: Lumber is not 
feeding after pressing START 
CUTTING.

Software issue Check to see if START 
CUTTING button has yellow 
banner reading AIR CUT 
across it. If so, go to 
Diagnostics menu and 
remove the check mark next to 
Air Cut.

Sensor issue Check for Auto Deck errors, 
specifically if Autodeck Lumber 
sensor is detecting board.

166

Software: Saw is in Waiting 
for Printer Trigger state.

Software issue Select Abort Cutting 
Sequence on the Diagnostics 
ribbon. Do NOT adjust trigger 
status in Detailed 
Diagnostics—it will cause the 
printing sequence to be out of 
order.

Software: Cutting sequence is 
out of order.

Software issue May happen if the printer 
trigger state is changed in 
Detailed Diagnostics. For 
now, abort cutting sequence 
and start the job over at the 
right place. To prevent in 
future: When you receive the 
saw status Waiting for Printer 
Trigger, use the Abort Cutting 
Sequence button on 
Diagnostics ribbon. 
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Software: Software indicates 
that the stock lumber is too 
short, but I measured the 
lumber and it is the correct 
length

Gripper home position issue 1. Before the next board is 
run during a job, measure 
and record the length of 
the next board to be cut. 

2. Calibrate the Gripper home 
position and re-cut the 
board using a new piece of 
lumber. If the problem is 
not resolved, continue to 
step 3.

3. Make sure that the Actual 
Length field corresponds 
with measured length. If 
the numbers don't 
correspond, change the 
Edge Detector Photo Eye 
value in Tools > Options > 
Saw by the amount the 
board measures off.

4. If the board measures 
short, decrease the 
measurement for the 
sensor position.

92

Software Error: AutoDeck 
Error002

Board not on sensor Adjust the Auto Deck board 
sensor (for load arms) and 
check connections

Software Error: AutoDeck 
Error003

Air cylinder out of position Indicates the Auto Deck pusher 
is not working. It may be 
caused by:
• Damaged Auto Deck 

Pusher Extend/Retract 
sensor is damaged or 
location needs to be 
adjusted

• Mechanical obstruction
• Inspect for other reasons 

the pusher is not retracted 
when it should be

Problem Possible cause Possible solution Page



BLADE SAW: TROUBLESHOOTING

Should you lockout/tagout to perform this action safely?

Original Instructions: 001080 rev. B 200

Software Error: AutoDeck 
Error004 or Error005

Pusher home position (or 
pushed position) sensor not 
seen

Indicates the Auto Deck 
Pusher Retract (for 004) or 
Extend (for 005) sensor is not 
working. It may be caused by:
• Sensor is damaged or 

location needs to be 
adjusted

• Mechanical obstruction
• Inspect for other reasons 

the sensor may not be 
working

Software Error: AutoDeck 
Error006 or Erro007

Pusher failed to move from 
home position (or from pushed 
position)

Pusher is not getting off the 
Auto Deck Pusher Retract (for 
006) or Extend (for 007) sensor 
soon enough. It may be 
caused by:
• Low air supply pressure
• Air valve coil is damaged
• Mechanical obstruction

Software Error: AutoDeck 
Error008

Invalid air cylinder sensor 
condition

Pusher is not on either the 
Auto Deck Pusher Retract nor 
the Extend sensor. It may be 
caused by:
• Sensor is damaged or 

location needs to be 
adjusted

• Mechanical obstruction
• Inspect for other reasons 

the sensor may not be 
working

Software Error: AutoDeck 
Error010

No board after initialize Auto Deck Lumber sensor did 
not trip after chains ran during 
initialization. Replace sensor.

Software Error: AutoDeck 
Error011

No board after stage Check operation of Auto Deck 
Lumber sensor.

Software Error: AutoDeck 
Error013

Time out during load Check operation of Auto Deck 
Lumber sensor.

Software Error: AutoDeck 
Error014

Command other than initialize 
received

Clear errors and restart the 
cutting process.

Software Error: AutoDeck 
Error015

Command other than stage 
received

Clear errors and restart the 
cutting process.
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Software Error: CalError 
General001

No Air Pressure Check air supply to saw, air 
regulator setting, and pressure 
switch setting. Clean 
pneumatic filter.

Software Error: CalError 
General002

Saw Not Retracted Stroke Home sensor is not 
sensing that the stroke 
completely retracted. Inspect 
the Stroke Home sensor for:
• Damage or location 

needs to be adjusted
• Mechanical obstruction
• The need to reset home 

offset and calibrate the 
stroke

Software Error: 
CrookedLumberSensor 
Error002

Unsteady output Check connection to CLS 
sensor.
Check CLS alignment and 
bracket location.

Software Error: 
CrookedLumberSensor 
Error003

Out of range Calibrate CLS, and check 
temperature probe.

Software Error: DGN0001 Moving this servo axis while 
the saw stroke is extended 
may result in damage to the 
saw. Do you want to continue?

Retract the stroke.

Software Error: DGN0002 The saw blade may contact the 
LASM! Damage to the saw 
may result. Do you wish to 
continue?

Verify clearance of LASM and 
move LASM to safe position.

Software Error: DGN0003  The saw motor may contact 
the LASM because the LASM 
jaw is open! Damage to the 
saw may result. Do you wish to 
continue?

Verify clearance of LASM and 
move LASM to safe position.

Software Error: ENG0029 Maximum number of retries 
occurred while sending {0} on 
Com {1} to the printer 
controller.

Check connections at print 
controller/Moxa converter.

Software Error: 
GripperClampError002

Time out clamping When clamping on the board, 
the Gripper Unclamped sensor 
is not uncovered after 2 
seconds. Check board feeding 
and gripper mechanics.
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Software Error: 
GripperClampError003

Time out unclamping When unclamping, the Gripper 
Unclamped sensor is not 
covered after 2 seconds. 
Check board feeding and 
gripper mechanics.

Software Error: 
GripperClampError004

The board is not against the 
gripper face. Before selecting 
Retry, the board must be 
against the gripper face. 
Perform the following steps 
before executing Retry:

1. Switch to Manual mode

1. On the status bar select 
Clamps - Unclamp All

1. Push the board back 
against the gripper

1. Switch to Auto mode

1. Select Retry

Follow instructions in message. 
If problem happens frequently, 
observe the load process to 
determine where the issue is.

Software Error: InfeedRail 
Error002

The board in the machine is 
too short. Select Continue to 
continue cutting or Stop to end 
the cutting process.

Check the board is the 
required length. If so, calibrate 
the gripper.

Software Error: InfeedRail 
Error003

No board was detected during 
the measuring process.

Verify that the correct length 
board was loaded. If so, 
observe the loading process to 
determine the loading issue.
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Software Error: InfeedRail 
Error004

The end of the board 
uncovered the board beam 
sensor at a different location 
than the stored position. This 
most likely means the gripper 
servo axis is out of calibration. 
Click Ignore to ignore this 
message or Stop Cutting to 
end the cutting process at the 
end of the current board. 
Stopping the cutting process 
will reset the stored position to 
the new position. It is 
recommended that the cutting 
in process be stopped and the 
gripper Home Position 
calibration be checked by 
using: Tools > Calibration > 
Gripper.

To reset the 
EngSawConstants.GripperStor
edCalibrationCheckCount to 
an initialized value of -1, one of 
the following operations needs 
to happen:
• Click the STOP button on 

the error message.
• Calibrate Gripper Home 

Offset
• Calibrate Gripper Home 

Offset and Counts Per 
Inch calibration

• Calibrate All Home 
Position

Once the stored value is set to 
-1, the next time the end of the 
board uncovers the thru-beam 
sensor while cutting, the saw 
computer will set this position 
as the new stored value.

Software Error: LasmClamp 
Error002

Timed out clamping Check air supply to saw, air 
regulator setting, and pressure 
switch setting. Clean 
pneumatic filter.
LASM Unclamped sensor is 
damaged or location needs to 
be adjusted
Check for mechanical 
obstruction.

Software Error: LasmClamp 
Error003

Timed out unclamping When clamping on the board, 
the Gripper Unclamped sensor 
is not uncovered after 2 
seconds. Check board feeding 
and gripper mechanics.

Software Error: LasmClamp 
Error004

Unexpected full clamp The LASM clamped all the way 
closed when it was expected to 
clamp onto lumber. Determine 
why board is not feeding into 
saw chamber properly.
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Software Error: 
LoadArmError002

Timeout moving up while on 
down sensor

The load arms have been told 
to move up, but they never 
came off the Load Arm Down 
sensor. Check signal to air 
cylinders and couplings to load 
arms.

Software Error: 
LoadArmError003

Timeout moving up The load arms never saw the 
up sensor while being told to 
lift, but did come off the Load 
Arm Down sensor. Check that 
the up sensor is working and 
no jam has occurred.

Software Error: 
LoadArmError004

Timeout moving down while on 
up sensor

The load arms have been told 
to move down, but they never 
came off the Load Arm Up 
sensor. Check signal to air 
cylinders and couplings to load 
arms.

Software Error: 
LoadArmError005

Timeout moving down The load arms never saw the 
down sensor while being told 
to drop but did come off the 
Load Arm Up sensor. Check up 
sensor is working and no jam 
has occurred.

Software Error: LoadArm 
Error006

Board removed from load arms 
unexpectedly

Board sensor (load arms) 
sensor is damaged or location 
needs to be adjusted

Software Error: Machine 
Error001

No air pressure Check air supply to saw, air 
regulator setting, and pressure 
switch setting. Clean 
pneumatic filter.

Software Error: 
MachineError002

Saw stroke is not retracted (not 
on the home sensor)

Follow on-screen instructions. 
The stroke is not retracted 
when the machine requires it to 
be.

Software Error: 
MachineError008

The infeed board through 
beam sensor is blocked after 
clearing the saw

The board beam sensor 
located by the print heads is 
blocked when it should not be, 
indicating there is either an 
obstruction or an issue with the 
sensor, cabling, or PLC.
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Software Error: 
MachineError010

The bevel is not square before 
the saw stroke

The bevel is required to be 
square before the saw strokes 
unless the PC allows it not to 
be. The home sensor is used 
to know if the bevel is generally 
square.

Software Error: 
MachineError011

The saw blade not running at 
velocity

The saw blade is either not 
running or running at a velocity 
lower than it should be.

Software Error: 
MachineError014

The stroke is not on the home 
sensor after a Home System 
was performed. If the stroke 
does not currently have an 
error, it is most likely that the 
stroke home offset is incorrect.

To reset the stroke home offset 
go to Diagnostics > Detailed 
Diagnostics > Stroke and 
click the Home Offset RESET 
button. Follow the on-screen 
instructions. 

Software Error: 
MachineError015

The bevel is not on the home 
sensor after a Home System 
was performed. If the bevel 
does not currently have an 
error, it is most likely that the 
bevel home offset is incorrect.

To reset the bevel home offset 
go to Diagnostics > Detailed 
Diagnostics > Bevel and click 
the Home Offset - Reset 
button. Follow the on-screen 
instructions.
The bevel is required to be 
square after homing. The 
home sensor is used to know if 
the bevel is generally square. 
This is a basic calibration 
check.

Software Error: 
MachineError016

The LASM lockout sensor was 
unexpectedly covered during a 
saw extend

There is a sensor that is 
centered on the saw blade that 
the LASM will trip if the LASM 
position is plus or minus about 
4 inches. If this sensor is 
tripped and the software has 
not allowed it to be tripped, this 
error will show.

Software Error: Outfeed 
Error002

Time out clamping Check air supply to saw, air 
regulator setting, and pressure 
switch setting. Clean 
pneumatic filter.
Outfeed Unclamped sensor is 
damaged or location needs to 
be adjusted
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Software Error: OutfeedError 
003

Timed out unclamping When unclamping, the Outfeed 
Unclamped sensor is not 
covered after 2 second. Check 
that cylinder is not jammed and 
is receiving signal to relay.

Software Error: OutfeedError 
004

Unexpected full clamp The outfeed clamp clamped all 
the way closed when it was 
expected to clamp onto lumber. 
Determine why board is not 
exiting saw chamber properly.

Software Error: Outfeed 
Error005

Timed out running until empty Outfeed Unclamped sensor is 
damaged or location needs to 
be adjusted
Inspect outfeed chain for wear

Software Error: PMG0005 The machine is not in an 
appropriate state for cutting.

If the servos are not ready or 
the machine is not in the ready 
homed state when trying to 
start cutting.

Software Error: PMG0006 The saw stroke will not be 
executed because the blade 
will intersect with the LASM.

The software generates this 
error when calculating the data 
before sending the data to the 
PLC.

Software Error: PMG0010 The rip bevel angle specified is 
out of range.
Rip Angle = {0}
Valid range = 0 - 56. 

The software generates this 
error when calculating the data 
before sending the data to the 
PLC.

Software Error: SawBlade 
Error2310

Output current exceeds trip 
limit.

The saw motor is using more 
current than it should. The saw 
blade is binding or the power 
cable is shorting.

Software Error: SawBlade 
Error4110

Control board temperature is 
above 88°C.

The VFD control board 
temperature is too high.

Software Error: SawBlade 
Error4210

Drive IGBT temperature is 
excessive

The VFD motor drive circuitry 
temperature is too high. The 
saw motor may be 
experiencing high loads such 
as a dull saw blade.

Software Error: SawBlade 
Error4290

Converter module temperature 
is excessive.

The VFD motor drive circuitry 
temperature is too high. 

Software Error: SawBlade 
Error7112

Brake resistor overload The saw blade braking resistor 
is being overloaded. The 
deceleration parameters may 
be set incorrectly.
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Software Error: ServoError 
05B

Drive disabled, axis motion not 
possible. The servo may be 
encountering an obstruction. 
If this servo is contacting the 
stop at either end of travel, 
calibrate the Home Offset for 
this specific servo only using 
Tools>Calibrate>[this servo]> 
Home Position. 

Check for obstructions.
Calibrate axis

Software Error: ServoError 
0D1

Over current condition Check for obstructions.
Calibrate axis

Software Error: ServoError 
264

Position was no longer valid 
(Position Valid axis status bit is 
off). The servo may be 
encountering an obstruction.
If this servo is contacting the 
stop at either end of travel, 
calibrate the Home Offset for 
this specific servo only using 
Tools>Calibrate>[this servo]> 
Home Position.

Check for obstructions.
Calibrate axis

Software Error: ServoError 
300

Timeout while waiting for 
power feedback from the 
amplifier

Check safety modules.

Software Error: SideClamp 
Error002

Timed out clamping When clamping on the board 
the Side Clamp Unclamped 
sensor is not uncovered after 2 
second. Check cylinder is not 
jammed and is receiving signal 
to relay.

Software Error: SideClamp 
Error003

Timed out unclamping When unclamping the Side 
Clamp Unclamped sensor is 
not covered after 2 
seconds.Check that cylinder is 
not jammed and is receiving 
signal to relay.

Software Error: SideClamp 
Error004

Unexpected full clamp Side Clamp Fully Clamped 
sensor is damaged or location 
needs to be adjusted.
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Software Error: SRV0004 The {0} servo was requested to 
move to {1} {2} which is out of 
range.
The limits are {3} to {4} {2}. 
If the machine is processing 
parts, the saw cannot process 
this part. Reject the board with 
this part and re-start the 
machine.

Calibrate axis.
Verify minimum and maximum 
positions.

Software Error: SRV0006  The saw has detected a 
possible out of calibration 
situation on the {0} axis. It is 
recommended to calibrate the 
{0} home offset using Tools> 
Calibrate.

Calibrate axis.

Software Error: SRV0007 {0} servo has timed out during 
a move or cycle.

Home sensor for indicated axis 
is damaged or location needs 
to be adjusted.
Check for mechanical 
obstruction.

Software Error: SRV0011  {0} servo has encountered an 
obstruction. 
If this servo is contacting the 
stop at either end of travel, 
calibrate the Home Offset for 
this specific servo only using 
Tools>Calibrate>[this servo]> 
Home Position

Check for mechanical 
obstruction.
Calibrate axis.

Software Error: TopClamp 
Error002

Time out moving down When moving the clamp down 
onto the board, the operation 
didn’t complete after 4 
seconds. Check cylinder is not 
jammed and is receiving signal 
to relay.

Software Error: TopClamp 
Error003

Time out moving up The top clamp took longer than 
it should have when moving 
up.

Software Error: TopClamp 
Error004

Lumber sensor blocked when 
sent to ready

The board beam sensor 
located by the print heads is 
blocked when the ready 
command is sent. The ready 
command moves the top clamp 
down when the board beam 
sensor is broken.
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Software Error: TopClamp 
Error007

Unexpected full clamp The top clamp attempted to 
clamp a board but no board 
was present.

Software Error: OutfeedVFD 
Error0001

Output current exceeds trip 
limit.

Most likely a physical jam. 
Clear the obstruction.

Software Error: OutfeedVFD 
Error0004

Short-circuit in motor cable(s) 
or motor. 

Replace cable and/or motor.

Software Error: OutfeedVFD 
Error0012

Motor is operating in stall 
region due to e.g. excessive 
load or insufficient motor 
power.

Most likely a physical jam. 
Clear the obstruction.

Software Error: OutfeedVFD 
Error0034

One of motor phases is lost 
due to fault in motor, motor 
cable, thermal relay (if used) or 
internal fault.

Repair/replace parts listed as 
necessary.

Software Error: OutfeedVFD 
Error0044

STO (Safe torque off) 
requested and it functions 
correctly.

An E-stop has been requested 
and the dual circuit channels 
opened properly.

Software Error: OutfeedVFD 
Error0045

STO (Safe torque off) input 
channel 1 has not de-
energized, but channel 2 has. 
Opening contacts on channel 1 
might have been damaged or 
there is a short-circuit.

When an E-stop was initiated, 
only 1 of the 2 channels 
opened properly, the circuit 
that did not open may be 
shorted or a contact welded.

Software Error: OutfeedVFD 
Error0046

STO (Safe torque off) input 
channel 2 has not de-
energized, but channel 1 has. 
Opening contacts on channel 2 
might have been damaged or 
there is a short-circuit.

When an E-stop was initiated, 
only 1 of the 2 channels 
opened properly, the circuit 
that did not open may be 
shorted or a contact welded.

Software Error: WasteConv 
VFDError 0001

Output current exceeds trip 
limit.

Most likely a physical jam. 
Clear the obstruction.

Software Error: WasteConv 
VFDError 0004

Short-circuit in motor cable(s) 
or motor. 

Replace cable and/or motor.

Software Error: WasteConv 
VFDError 0012

Motor is operating in stall 
region due to e.g. excessive 
load or insufficient motor 
power.

Most likely a physical jam. 
Clear the obstruction.

Software Error: WasteConv 
VFDError 0034

One of motor phases is lost 
due to fault in motor, motor 
cable, thermal relay (if used) or 
internal fault.

Repair/replace parts listed as 
necessary.
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Software Error: WasteConv 
VFDError 0044

STO (Safe torque off) 
requested and it functions 
correctly.

An E-stop has been requested 
and the dual circuit channels 
opened properly.

Software Error: WasteConv 
VFDError 0045

STO (Safe torque off) input 
channel 1 has not de-
energized, but channel 2 has. 
Opening contacts on channel 1 
might have been damaged or 
there is a short-circuit.

When an E-stop was initiated, 
only 1 of the 2 channels 
opened properly, the circuit 
that did not open may be 
shorted or a contact welded.

Software Error: WasteConv 
VFDError 0046

STO (Safe torque off) input 
channel 2 has not de-
energized, but channel 1 has. 
Opening contacts on channel 2 
might have been damaged or 
there is a short-circuit.

When an E-stop was initiated, 
only 1 of the 2 channels 
opened properly, the circuit 
that did not open may be 
shorted or a contact welded.
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MAINTENANCE CHECKLIST

Using the Maintenance Checklists
Copy these checklists and place the copies with the BLADE saw. Leave the 
original checklists in this manual for future use.

Safety Notes for the Maintenance Checklists

Checklist

Daily Checklist on page 212

Weekly Checklist on page 213

Monthly / Annual Checklist on page 214

! WARNING

CUT AND CRASH HAZARD.
Perform the safety tests described starting on page 12 before 
operating the machine after performing maintenance or repairs.

! WARNING
 

ELECTROCUTION AND HIGH PRESSURE HAZARDS.
Always turn the power off by activating an E-stop when the 
machine is not operating.
Always verify that all power to the machine is off and followed 
approved lockout/tagout procedures (OSHA 29 CFR 1910.147) 
before performing any maintenance.
Turn off the air switch or shutoff valve if appropriate. Bleed 
pneumatic lines if appropriate.
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Daily Checklist
Month and year __________

Week of __________

Action Shift Page Initials / Date

Perform Safety Tests 1

122

3

Blow off system, including 
Infeed component, Infeed 
Rail, lumber exit chain, 
motor vents, an Outfeed 
component

1

1012

3

Vacuum stroke/elev. 
chamber

1

1012

3

Clean printer nozzles 
(every shift)

1

1222

3

1

2

3

1

2

3

1

2

3

! WARNING
Lockout/tagout before performing maintenance. 
If power is required, make sure all personnel are clear of 
the restricted zone.



BLADE SAW: MAINTENANCE CHECKLIST

Should you lockout/tagout to perform this action safely?

Original Instructions: 001080 rev. B 213

Weekly Checklist
Year __________

Action Page Initials / Date

Replace saw blade 113

Inspect linear guide bearing rails for 
grease

129

Blow out all motor vents

Vacuum the electrical enclosure

! WARNING
Lockout/tagout before performing maintenance. 
If power is required, make sure all personnel are clear of 
the restricted zone.
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Monthly / Annual 
Checklist 
Year __________

Action Months 
(one shift)

Months 
(two shifts)

Page Initials / Date

Check lumber exit chain 
tension and alignment

1 .5 137

Check Auto Deck chain 
tension

12 12 139

Lubricate Auto Deck chain 12 12 137

Lubricate Skewed 
Conveyor chain

2 2 137

Check all belts for proper 
tension and tracking

12 12 140

Lubricate elevation jack 
screw (2 grease fittings)

3 1.5 113

Check oil level in all 
gearboxes

12 6 104

Drain and change gearbox 
oil (every 20,000 hours 
minimum)

48 24 104

Lubricate skewed conveyor 
drive wheel bearings

6 3 136

Replace cooler and main 
regulator’s filter element

24 12 153

Lubricate saw blade motor 
bearings (2 grease fittings)

12 6 107

Lubricate outfeed clamp 
camfollowers

12 6 133

Lubricate waste conveyor 
drive shaft bearings

12 6 134

Lubricate Auto Deck drive 
shaft (1 grease 1 fitting per 
strand)

12 6 135

! WARNING
Lockout/tagout before performing maintenance. 
If power is required, make sure all personnel are clear of 
the restricted zone.
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Check for leaks in all 
bearings, gearboxes, and 
motors

12 12

Inspect all sprockets, 
replacing any that do not 
rotate easily.

12 12

Measure the LASM fixed 
jaw. It must be at least 
1 1/2" thick.

12 6 147

Check the entire system for 
loose hardware

12 12

Clean all metal surfaces 
with a soft cloth and mild 
detergent

12 6 102

Flush the printer lines 1 1 123

Date Notes

Action Months 
(one shift)

Months 
(two shifts)

Page Initials / Date
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Ordering Parts
Use the MiTek web site to locate parts and part numbers, then order them using 
one of these methods:

Safety Notes for Replacing Parts

By E-Mail By Phone

Send an e-mail to 
mitekparts@mii.com with all 

relevant information, 
including the part number.

Call
1-800-523-3380.

NOTICE

Use only replacement parts purchased from MiTek.
Parts from other sources may cause damage to your machine.

! WARNING
 ELECTROCUTION AND HIGH PRESSURE HAZARDS.

Always turn the power off by activating an E-stop when the 
machine is not operating. Follow approved lockout/tagout 
procedures (OSHA 29 CFR 1910.147).
All electrical work must be performed by a licensed electrician. 
Always verify that all power to the machine is off and followed 
approved lockout/tagout procedures (OSHA 29 CFR 1910.147) 
before performing any maintenance.
Turn off the air switch or shutoff valve if appropriate. Bleed 
pneumatic lines if appropriate.

ORDERING PARTS
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DRAWING SET

Drawings are inserted in the back of the manual or included in a separate binder, 
depending on the machine.

Description Drawing Number

Mechanical

Top Level Assembly 89060-501

Saw Assembly 89061-501

Guards and Covers Assembly 89100-501

LASM Assembly 89160-501

CLS Assembly 89155-501

Waste Conveyor Assembly 89195-901

Infeed Rail Assembly 89200-501

Gripper Assembly 89280-501

Saw Head Assembly 89430-501

Stroke and Elevation Assembly 89435-501

Stroke Angulation Assembly 89435-501

Lumber Exit Assembly 89465-501
Outfeed table 89490-501

Auto Deck 20 (optional) no drawing

Electrical

Saw Schematic 90615

Saw Electrical Assembly 90615-501

Saw Electrical Enclosure 90615-502

Operator Interface (PC) Enclosure 90615-507

Auto Deck Schematic (optional) 90626

Pneumatic

Top and Side Clamp Assembly 89300-501

Assembly 89346-501

Top Clamping Assembly 89360-501

Printer (multiple options) 89460-xxx

Printer schematic (multiple options) 89448-xxx

Outfeed Clamp Assembly 89640-501
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affected employee an employee whose job requires him or her to operate or 
use a machine or equipment on which servicing or 
maintenance is being performed under lockout or tagout, or 
whose job requires him or her to work in an area in which 
such servicing or maintenance is being performed

angle the axis that rotates the saw blade

amperage the strength of an electric current, expressed in amperes

authorized employee a person who locks out or tags out a machine or equipment 
in order to perform servicing or maintenance on that 
machine or equipment; an affected employee becomes an 
authorized employee when that employee’s duties include 
performing servicing or maintenance covered under this 
section

Auto Deck a staging conveyor that feeds lumber to the Infeed Rail

Auto Mode a staging conveyor that feeds lumber to the Infeed Rail

axis a main line of direction, motion, growth, or extension; 
includes angle, bevel, elevation, and stroke; plural is axes

bevel the axis that cuts on the 4" dimension of a 2x4

board a specific piece of lumber with specific dimensions required 
by the saw to cut out specific parts

bow a curve of the face of a board (3-1/2" surface on a 2x4); the 
bow points to the side on floor and wall studs

bumper a small, black rubber shock resistor used throughout the 
interior of the saw

beacon a light that displays one of several colors to represent the 
state of the machine

CLS Crooked Lumber Sensor; senses when a piece of lumber is 
crooked and adjust the cut to compensate

connector plate the nail-plate that is embedded into production material to 
hold it together

crown a curve of the edge of a board (1-1/2" edge on a 2x4); the 
crown points up for floor studs or out for wall studs

disconnect noun, the handle, often on a machine’s main electrical 
enclosure, that shuts off incoming power at that spot in the 
electrical system

elevation the axis that moves the saw blade up and down

GLOSSARY
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energized connected to an energy source or containing residual or 
stored energy

energy isolating device a mechanical device that physically prevents the 
transmission or release of energy, including but not limited 
to the following: manually operated electrical circuit breaker; 
a disconnect switch; a manually operated switch by which 
the conductors of a circuit can be disconnected from all 
ungrounded supply conductors, and in addition, no circuit 
can be operated independently; a line valve; a block; and 
any similar device used to block or isolate energy—push 
buttons, selector switches, and other control circuit type 
devices are not energy isolating devices

energy source any source of electrical, mechanical, hydraulic, pneumatic, 
chemical, thermal, or other energy

gripper the component on the Infeed Rail that holds the end of the 
board and pushes it into the saw chamber

infeed component any component that feeds lumber to the Infeed Rail; usually 
the Auto Deck staging conveyor or Ranger system

Infeed Rail the rail that lumber rests on before entering the saw 
chamber

inventory in the saw software, inventory is the lumber entered into the 
software that is available to assign parts to in a job

Job A group of parts requiring specific boards to be cut

LASM Lumber Advance Short Move; grabs the board as it enters 
the saw chamber, and moves it to the outfeed side of the 
saw chamber, if necessary

layout a scaled diagram of the location of components and the 
space that they occupy

leveling screws used to refer to any structural leg that can be adjusted up or 
down by a screwing motion

limit switch an electro-mechanical device that consists of an actuator 
mechanically linked to a set of contacts; when an object 
comes into contact with the actuator, the device operates 
the contacts to make or break an electrical connection

load arms arms that load lumber from the lumber feed system (Auto 
Deck or) to the Infeed Rail

lockout device a device that utilizes a positive means such as a lock, either 
key or combination type, to hold an energy isolating device 
in the safe position and prevent the energizing of a machine 
or equipment, including blank flanges and bolted slip blinds; 
should be standardized within the facility in at least one of 
the following criteria: color; shape; or size; and additionally, 
in the case of tagout devices, print and format shall be 
standardized
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lockout/tagout a means of isolating a piece of equipment from its energy 
source so maintenance can safely occur; guidelines 
provided in OSHA 29 CFR 1910.147

lumber A group of boards or a non-specific board; no consideration 
given to the final size or shape

lumber exit chain outfeed chain, part of the outfeed assembly

lumber pusher on Auto Deck, pushed the lumber onto the Infeed Rail

Lumber Yard The virtual lumber yard in the saw software that lists lumber 
available to use and allows the operator to assign each 
board in a job to a specific lumber in the virtual inventory.

Manual Mode the mode the saw is in when operating it from the 
Diagnostics screen

operator interface the method in which the operator controls the machine; it 
may be a touch screen, a control panel, etc.

part A piece of a board, cut to the exact size and shape required 
for the job

plate see connector plate

PLC (programmable logic controller) a solid-state control device 
that can be programmed to control process or machine 
operations. It consists of five basic components: processor, 
memory, input/output module, the power supply, and the 
programming device.

port a connection point for a peripheral device

potentiometer a control knob that is a dial; allows a range of values to be 
set by turning the dial, commonly found on the PLC

proximity switch a switch that uses an electromagnetic field to detect when 
an object is near, there is no physical contact between the 
object and the switch; inductive proximity switches detect 
only metal objects, capacitive proximity switches can sense 
both metallic and non-metallic objects

qualified person a person or persons who, by possession of a recognized 
degree or certificate of professional training, or who, by 
extensive knowledge, training, or experience, has 
successfully demonstrated the ability to solve problems 
relating to the subject matter and work—ANSI B30.2-1983; 
one who has skills and knowledge related to the 
construction and operation of the electrical equipment and 
installations and has received safety training on the hazards 
involved—NEC2002 Handbook

Ranger an automated lumber retrieval system that picks the correct 
lumber (without an operator) and delivers it, in order, to the 
Infeed Rail

regulator a component of the pneumatic system that connects to the 
main air source and regulates the air pressure allowed into 
the system



Original Instructions: 001080 rev. B 221

BLADE SAW: GLOSSARY

side clamp roller clamp on infeed side of saw that contacts the face of 
the lumber

Skewed Conveyor powered skewed conveyor that integrates with the system 
to transport and sort the lumber

solenoid an assembly used as a switch consisting of a coil and a 
metal core free to slide along the coil axis under the 
influence of the magnetic field

station a physical location on a Ranger system

stroke the axis that moves the saw blade in and out (toward or 
away from operator)

tagout device a prominent warning device, such as a tag and a means of 
attachment, which can be securely fastened to an energy 
isolating device in accordance with an established 
procedure, to indicate that the energy isolating device and 
the equipment being controlled may not be operated until 
the tagout device is removed; should be standardized within 
the facility in at least one of the following criteria: color; 
shape; or size; and additionally, in the case of tagout 
devices, print and format shall be standardized

tape liner tape liner provides friction resistance for the seal plate 
assembly that slides up and down with the elevation axis 
located inside the stroke/elevation chamber

top clamp roller clamp on infeed side of saw that contacts the top edge 
of the lumber; has been called a hold-down

torque a turning or twisting force

transmitter bar the light bar that transmits the signal to the receiver bar; 
every light bar set consists of a receiver bar and a 
transmitter bar

VFD (variable frequency drive) controls the speed of a paired 
motor

voltage equal to the difference of electric potential between two 
point on a conducting wire carrying a constant current of 
one ampere when the power between the points is one watt

wane a defect in a board where a portion of the wood is missing 
from the board edge or face

warp a curve where the face of a board (3-1/2” side on a 2x4); is 
higher or lower in one spot than on the rest of the board

waste conveyor a conveyor under the saw blade that transports waste 
lumber to a waste receptacle supplied by customer
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A
adjusting system pressure see FRL

B
bearings

linear guide 178
bevel

sensors 162

C
calibrating

crooked lumber sensor 168
chains

adjusting tension 137
lumber exit 174

checklists
daily checklist 212
maintenance 211
monthly checklist 214
weekly checklist 213

clamps
outfeed 174
sensors 162

cleaner
replacing 126

cleaning
filter element for cooler 154

CLS 168
communicating with elevation 170

component overviews 173
cooler

filter element 154
corrections iv
customer service 46
cylinders

flow control valves 160

INDEX
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D
door switches 64, 65
dust extraction 51

E
elevation

communicating with CLS 170
felt strips 147
sensors

safety
sensors 162

e-mail support see customer service
emergency stop see E-stop
errors iv

air pressure 155
E-stop 59

perimeter safety cable 175
pull-cord 61, 175

F
felt strips 147
filter

cooler 154
flow control valves see pneumatic system
FRL

adjusting pressure 152
replacing filter element 153

I
import

job to saw 86
important parts see component overviews
indicators on machine 66
ink 119

replacing 126

L
legal iii
legal notice iii
lockout/tagout

electrical procedure 7, 8
hydraulic procedure 10
pneumatic procedure 10
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pneumatic system 152
procedure 31

lubrication
linear guide bearings 178

lumber exit chain
alignment 174

M
Machinery Division Customer Service 46
maintenance

checklists 211
Manual

navigation 44
manual

introduction 43
understanding 44

marking restricted zone 57
monitor

second monitor 50
specs 51

O
operation

import to saw 86
remainders 88
stopping 59

operator interface
troubleshooting the basics 83

outfeed
overview 174

P
part overviews see component overviews
parts list 216
patents iii
perimeter safety cable 61, 175
phone support see customer service
PLC

overview 172
pneumatic filter see FRL
pneumatic system

cylinders
flow control valves 160

removing pressure 152
pneumatics



Original Instructions: 001080 rev. B 225

BLADE SAW: INDEX

minimum air pressure 155
pressure switch 155
printer

replacing ink or cleaner 126
supplies 119

programmable logic controller see PLC
pull-cord 61, 175

R
reducing waste

remainders 88
remainders 88
replacement parts see parts list
restricted zone 17, 57
return goods iv

S
safety

during troubleshooting 186
general rules 2
indicators 1
interlocked door switches 64, 65
lockout/tagout 6
marking restricted zone 17
restricted zone 17
safety test 36
signal words 1
symbols 18
troubleshooting with energy 10

safety controller
overview 172

safety regulations 24
safety signs see safety symbols
safey conformity 24
saw chamber

door switch 64, 65
second monitor

option 50
sensors

CLS 168
overview 162
sensor gap for prox switches 166
troubleshooting the basics 167

software
reject 89
reset 89

spare parts see parts list



Original Instructions: 001080 rev. B 226

BLADE SAW: INDEX

stop motion see E-stop
stroke

sensors 162
stroke/elevation chamber door switch 64, 65
support see customer service

T
troubleshooting

CLS 168

V
variable frequency drive see VFD
VFD

overview 172
powered skewed conveyor 176
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